
User Guide
Version 2019.2



2
8
8
9
9

10
11
11
12
12
13
13
13
13
14
14
14
15
16
16
16
17
17
17
18
19
20
20
20
21
21
21
21
22
23
24
25
26
26
26
27
27
28
28
30
30
31
31
31
32
32
33
33
34
34
36
36
36
36
37
37
38

Table of Contents

Table of Contents
Navigating the Application

Main Menu
Report Tree

Right-Clicking on Folders
Right-Clicking on Reports

Report Descriptions Window
Tabs
Toolbar
User Preferences

Tutorials Tab
Startup Reports Tab
User Reports

Help
Report Types

Dashboard
ExpressView
Advanced Report
CrossTab Report
Express Report
Chained Report

Building Your First Report
Name Tab
Categories Tab
Sorts Tab
Filters Tab
Layout Tab
Display Data
Subtotals and Grand Totals
Summary Functions
Data Headers

Grouping Basics
Understanding Groups
Creating Sorts
Sorting By Formula
Adding Group Sections
Group Header and Footer Content
Reprinting Group Headers

Formula Basics
Adding Mathematical Calculations
Entering a Formula
Calculating with Cell References
Calculating in the Report Footer
Concatenating Strings

Adding Visualizations to a Report
Adding the Chart
The Chart Wizard

Type Tab
Data Tab
Appearance Tab
Size and Preview Tab

Reading The Chart
Interactive Report Viewer

Scheduling Reports
Creating a Schedule
Saving Reports to a Repository
Viewing and Editing Schedules
Managing Schedules
Emailing a Report Immediately
Batch Emailing Personalized Reports

ExpressView
Making an ExpressView

Table of Contents User Guide

2 of 152



39
39
39
39
40
40
40
40
40
41
42
43
44
45
45
46
47
48
48
48
49
49
49
49
49
50
51
51
51
51
52
52
52
53
53
54
54
54
54
55
55
55
56
56
56
57
57
57
57
57
58
59
59
59
59
60
60
60
60
61
61

About the Radial Menu
Interactive Editing

ExpressView: Managing Data
Formatting and Style
General
Number
Date
Text
Sorting
Filtering

ExpressView: Formula Columns
ExpressView: Customizing Appearance

Premade Themes
Styling Data Cells
Changing data row colors
Changing group colors

ExpressView: Visualizations
Choosing Chart Data
Labels
Values
Interactive Editing of ExpressView Visualizations
Suggested Reading

ExpressView: Grouping and summarizing data
Making a group
Changing group level
Summarizing group data
Hiding data rows

ExpressView: Data Categories and Fields
ExpressView: Exporting

Export to Advanced Report
Export to File
Export Settings

Report Viewer
Report Viewer: Interacting with Reports

Drilling Into Data
Expanding Hidden Data
Visualization Features
Drillingdown on Google Maps

Report Viewer: Customizing report output
Styling Data Cells
Styling Charts
Managing Data Columns
Setting interactive sorts and filters

Report Wizard
Name • Categories • Sorts • Filters • Layout • Options

Report Wizard: Name
Report Wizard: Categories

What are data categories?
Adding Categories
SQL Categories (Advanced Users) v2018.1+

Report Wizard: Sorts
Report Wizard: Options

Converting to an Advanced Report
Advanced Reports: Report Designer

Cells
Toolbar

Advanced Reports: Categories
What are Data Categories?
Relationships Between Categories
Suppressing Duplicates

Advanced Reports: Sorts

Table of Contents User Guide

3 of 152



62
62
62
62
63
63
64
64
64
64
65
66
66
67
67
69
69
70
70
71
71
71
71
72
73
73
74
74
74
75
76
76
77
77
78
78
78
78
78
78
79
79
79
79
80
80
80
80
80
81
82
83

83
84
84
84
84
85
85
85
86
87
88

Adding Sorts
Relationship Between Sorts and Groups
Sort Formulas

Filters
Standard Filters
Adding Standard Filters
Prompting for Values
Formula Filters v2018.2+
Advanced Report Designer
ExpressView
Grouping Filters Together
Nesting Filter Groups

Group Min/Max Filters
Applying Group Min/Max Filters
Ignoring Other Groupings
Filtering the Entire Data Set

Top/Bottom Filters
Advanced Reports: Report Options

General Options
Excel Options
Page Options
Report Viewer Options
General
Filters
Sorts

Advanced Reports: Templates
Making Templates
PDF Templates
Microsoft Word Templates
Microsoft Excel Templates

Advanced Reports: Joins
Join Types
Relationship Types
Cartesian Processing
Modifying Joins
Create a New Join
Delete a Join
Modify a Join
Advanced Joins
Type
Operator
Grouping

Advanced Reports: Cell Formatting
Number Tab
General
Number
Date
Text
Border
Conditional Formatting
Using Formulas as Conditional Formatting Colors v2019.2+

Examples
Advanced Reports: Sections

Types of Sections
Manipulating Sections
Static Sections
Page Header/Footer
Report Header/Footer
Dynamic
Detail
Group Header/Footer
Repeating Group
Reprinting Group Headers

Table of Contents User Guide

4 of 152



88
89
90
90
90
90
90
91
91
91
91
92
92
92
92
92
92
92
93
93
93
93
93
93
93
94
94
94
94
94
94
94
95
95
95
95
95
95
96
96
97
97
97
98
99
99

100
100
100
100
101
101
102
102
102

103
103
103
103
104
104
105

105
106

Section Shading
Advanced Reports: Using the Toolbar

Saving Reports
Undo/Redo
Font & Alignment Options
Font
Color
Alignment
Formatting Cells
Merge/Split Cells
AutoSum
Images
Functions
Chart Wizard
Gauge Wizard
Suppress Duplicates
CrossTab Wizard
Linked Reports (aka Drilldowns)
Linked Action Event
GeoChart Wizard
Google Maps Wizard
Run Report
Execution Caching
Export

Advanced Reports: Design Grid
Sections
Page Header & Page Footer
Report Header & Report Footer
Detail
Group Header & Group Footer
Repeating Groups
Using Sections
Adding Sections
Deleting Sections
Modify Sections (Group Header/Footers and Repeating Groups only)
Section Shading
Columns and Rows
Columns
Sorting by Columns within the Report Viewer
Rows
Cells
Using Page Breaks
Creating Collapsible Rows
Properties of a Collapsible Row

Advanced Reports: Drilldowns
Dashboards as Child Reports
Linking Types
Default Linking
Manually Defining Link Fields
Conditionally Link with Formula
Adding Linked Reports
To manually define link fields:
To conditionally link with formula:
Modifying Linked Reports
Deleting Linked Reports

Dashboard Viewer (v2019.2+)
Run a Dashboard
Keyboard Shortcuts
Interacting with Dashboards
Reports and Visualizations
Filters
Parameters

Dashboard Designer (v2019.2+)
Keyboard Shortcuts

Table of Contents User Guide

5 of 152



106
106
107
107

108
109

109
109
109
110

110
111
111
111
111
111

112
112
113
115
115
117
119

120
121
121
121
122

122
122
122
122
123

123
123
123
123
123

124
124
124
124
124
125
125
126
126

126
127
127

127
127
127
127
128

128
130

130
131
131

132
132
132
132
133

Toolbar
Canvas
Tiles

Adding Tiles
Screen Fit and Scaling

Automatically Reposition Tiles Checked Automatically Reposition Tiles Unchecked
Backgrounds and Borders
Managing Tiles
Tile Menu
Tile Properties Pane

Dashboard Designer: Existing Reports (v2019.2+)
Tile Properties Pane
Content
Style

ExpressView
Other Report Types

Advanced
Dashboard Designer: Visualizations (v2019.2+)

Creating Visualizations
Tile Properties Pane
Content
Style
Advanced

Dashboard Designer: Image (v2019.2+)
Tile Properties Pane
Content
Style
Advanced

Dashboard Designer: Text (v2019.2+)
Tile Properties Pane
Content
Style
Advanced

Dashboard Designer: URL (v2019.2+)
Tile Properties Pane
Content
Style
Advanced

Dashboard Designer: Filters (v2019.2+)
Interactive Filters
Add an Interactive Filter
Modify an Interactive Filter

Docked Filters (Not In a Canvas Tile)
On the Canvas

Content
Style
Advanced

Delete an Interactive Filter
Docked Filters (Not In a Canvas Tile)
On the Canvas

Exports
Imported Filters
Add an Imported Filter
Modify an Imported Filter
Delete an Imported Filter

Dashboard Designer: Parameters (v2019.2+)
Adding/Deleting Parameters

Exporting Dashboards (v2019.2+)
Export Options
Scheduling or E-Mailing Dashboards

Charts
Chart Types
Line
Bar and Column
Pie and Other Single-Series

Table of Contents User Guide

6 of 152



133
133
133
133
133
134

135
135
136
137

137
138
138
138
139
139
139
140
140
140
141
141
142
142
143
143
144

144
144
145
145
146
147
147

148
148
149

150
150
151
151

Scatter and Bubble
Zoom Charts
Combination Charts
(v2016.3+)
Data

Data Layout
Appearance
Colors
Labels

Other Features
Size and Preview

Chart Data Layout Types
Layout One: Cell-Based Chart
How do I know this is the right Layout for me?
How would that look in the Chart Wizard?
What would the final report design look like?
How would the output look?
Layout Two: Column-Based Chart
How do I know this is the right Layout for me?
How would that look in the Chart Wizard?
What would the final report design look like?
How would the output look?
Layout Three: Row-Based Chart
How do I know this is the right Layout for me?
How would that look in the Chart Wizard?
What would the final report design look like?
How would the output look?

GeoCharts
Type
Locations
Data
Example
Report Designer
Report Viewer

Gauges
Appearance
Data

User Preferences and Context Sensitive Help
Startup Reports
Context Sensitive Help
Tutorials

Table of Contents User Guide

7 of 152



Navigating the Application
This application consists of two sections. On the left is the Main Menu and on the right are Tabs. The Main Menu displays the available
reports, folders, and buttons. Tabs can contain the New Report Wizard, report outputs, design windows, or help pages.

Main Menu
Through the Main Menu, you can:

Create new reports
Search for reports
Read report descriptions
Run Reports
Export reports to other types (Excel, PDF, RTF, and CSV)
Duplicate reports to save time setting up similar reports
Edit reports
Schedule reports to be emailed or archived
Manage folders and report storage

The main menu, depending on system configuration, has three or four mode icons on the left-side. They are:

 Create New Report

 Browse Reports

 View Data Objects

 View Scheduled Manager

The active mode is indicated with a blue icon, for example when the Browse Reports mode is selected, the icon looks like this: . Click
on the icons to change the Main Menu mode or click on the currently active icon to collapse the main menu and hide it. To show the main
menu again, click on any of the icons.

The Main Menu can be broken down into two components: the Report Tree and the Report Descriptions Window.

Navigating the Application User Guide

8 of 152



Report Tree
The Report Tree contains the individual user's view of their applicable Folders/Sub-Folders and the Reports contained within them. Folders
that are marked as Read Only  cannot be modified in any way (as designated by the administrator), with the Reports and Sub-Folders
within inheriting the same permissions (unless otherwise specified).

A user can view a list of a folder's contents by double-clicking the folder name or by left-clicking the dropdown arrow next to the
folder name. Right-clicking the folder name will bring bring up an options menu.

Note

Right-Click options are location- and item-specific.

Right-Clicking on Folders

If a user right-clicks on a non Read Only  folder within the Report Tree, a menu with the following options appears:

 Add Root Folder: Allows the user to create a new folder in which to place the existing folder.

Add Child Folder: Allows the user to create a new folder within the existing folder.
 New...: Allows a user to add a new report to the folder and specify the report type.
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 Rename: Allows the user to rename the folder.

 Delete: Allows the user to delete the folder.

Note

A folder and all of its sub-folders must be empty in order to delete the folder.

Expand All: Expand the contents of the relevant folder, including all of its sub-folders
Collapse All: Collapses the contents of the relevant folder, including all of its sub-folders.

Right-Clicking on Reports

If a user right-clicks on a report, a prompt with the following options appears:

 Edit: Opens the Report Designer screen for the selected report.
Run Report: Executes the report and displays it in HTML format.
Export As: Allows the user to execute a report in any of the following formats:

PDF
Microsoft Excel Workbook
CSV
RTF

Note

If one of these export types is unavailable, it may have been disabled by your administrator.

Schedule Report: Allows the user to schedule a report to run immediately, at a later time, or at regular intervals. For more
information on scheduling reports, please see Scheduling a Report.
Email Report: This allows a user to Email a report immediately to a specified email address. Clicking the an Export
As option allows the user to specify the export format type.
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Rename: Allows the user to rename the report.

Note

If a user renames a Report that is used within a Dashboard, Chained Report, or a Scheduled Report, an error message will appear when
attempting to Execute or otherwise modify the aforementioned Report types.

 Duplicate: This allows a user to duplicate a report and place it in a specified folder
 Delete: This allows a user to Delete a selected report.

Report Descriptions Window
This window displays the description of the selected report. If the report was never given a description, this window remains blank when the
report is selected in the Report Tree. For more info on Report Descriptions, please see Report Types.

Tabs
Tabs make up the application's main interface. This is where users build, design, and view reports as well as access dashboards and help
pages. Tabs can be closed by clicking the Close Tab  icon to the right of the tab name.
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Tabs can be rearranged by clicking and dragging them left or right. 

Right-clicking on a tab displays additional Tab options, such as closing the tab or closing all other tabs.

Toolbar
Once a report has been created and opened in the report designer, the user may interact with it using the Toolbar.

Advanced Report Designer toolbar in v2019.2+

The Toolbar enables users to:

Rename the report.
Add, modify, or remove sorts and filters.
Format cells’ font, font size, alignment, color, and borders.
Use the Formula Editor to create complex functions.
Insert charts, gauges, and images.
Link reports, allowing users to drilldown for more detail.
Save the report.
Run the report in the Report Viewer.
Export the report to Excel, CVS, RTF, or PDF.
Add or remove Data Categories from the report.
Add an Action Event. (If you do not see this option, your administrator may have disabled it.)

User Preferences

Clicking on the User Preferences  icon in the top-right corner of the window opens the User Preferences dialog. The User Preferences
dialog contains three tabs: Tutorials, Startup Reports and User Reports.
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These User Preferences are stored through cookies, server events, or an external interface per the system administrator's settings.

Note

The system administrator can disable some of these preferences, so they not all be available in your environment.

User Preferences dialog

Tutorials Tab

The ExpressView Designer contains a tutorial that walks first-time users through building their first one. It also has helpful hints that will
pop-up throughout the building process. These features can be turned on or off from this tab.

ExpressView Tutorial: check the checkbox to show the tutorial when launching the ExpressView Designer.
ExpressView Hints: check the checkbox to enable the building hints. Hints can be individually hidden from the ExpressView
Designer. When this checkbox is checked, only those hints that have not been individually hidden will be displayed.

Reset All Hints: click this link to clear the hidden preferences of the individual hints. If ExpressView Hints is checked, the
next time the ExpressView Designer is launched, all of the hints will be displayed.

Startup Reports Tab

A startup report is a report, Dashboard or ExpressView that runs automatically when the Web Application is launched. Instead of
showing the Getting Started page, the startup reports are displayed.

To add a startup report, navigate to it in the dialog's report tree and then either drag it to the box on the right, or click the  Add button at
the bottom of the report tree. The system administrator can limit the number of startup reports each user may have.

Use the Move Row Up  and Move Row Down  icons to change the order of the startup reports.

Use the Delete  icon to remove a startup report. This only stops the report from loading on startup, it does not remove the report from
the application.

User Reports

A user report is a report that has certain customization placed on it by an individual user from within the Report Viewer. For example, a
user might make certain filter value selections.

Any of your user reports will be shown in this list. User reports may be deleted by clicking on the Delete  icon on the corresponding
report row. User reports are added from within the Report Viewer.

Help

Clicking on the Contextual Help  icon in the top-right corner of the window walks the user through specific portions of the application.
This context-sensitive help menu is indexed and completely searchable, granting the user easy access to all information.
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To learn more about getting started, continue with Report Types.

Report Types
There are six different report types available in the reporting application. Four are standalone types, and two are composite types which
combine reports together. By default ExpressView, Advanced Report, and Dashboard are enabled in the interface. The system
administrator can enable and disable other types of reports.

Dashboard 
Dashboards combine one or more reports onto a canvas, providing a way to create a personalized arrangement and display of related
reports.

Dashboard Viewer

All standalone report types can be added to a Dashboard, and visualizations can be created directly on the canvas without needing to
make a separate report. Dashboards can also have text, borders, images, interactive filters, and embedded web pages.

Dashboards run in the browser, can have interactivity such as dynamic filtering and drilldowns, and can refresh on a timed interval.

Visit the Dashboards documentation.

ExpressView 
ExpressView is a tool to quickly get insight into vertically expanding data records and groups. An ExpressView can optionally include a
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visualization.

ExpressView with radial menu

Built with an intuitive drag-and-drop interface, ExpressView is intended to be a way to get started quickly  viewing data as possible.
ExpressViews can be converted to Advanced Reports in order to gain the additional capabilities of that format.

ExpressViews can be scheduled, added to Chained Reports and Dashboards, embedded into web pages, and exported to multiple
formats.

Visit the ExpressView Documentation.

Advanced Report 
Advanced Reports are the flagship report type of the application.

Advanced Report

The most powerful reporting tools are available with Advanced Reports, including geographic maps; CrossTabs; repeating groups;
complex join, filter, and sort logic; drilldowns to linked child reports, and more. Advanced Reports are made using an spreadsheet-like cell-
grid interface. The Advanced Report Designer allows users to build reports without requiring knowledge of SQL or the underlying data
model. Advanced Reports can be executed to a browser-based Report Viewer interface, which allows for interactivity, additional changes
to be made without re-running the report, and for saving user-specific customization.

Advanced Reports can be scheduled, added to Chained Reports and Dashboards, embedded into web pages, used to populate document
templates, and exported to multiple formats.

Visit the Advanced Reports documentation.
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CrossTab Report 
Crosstab Reports are a special type of Advanced Report.

CrossTab Report

Also known as pivot tables, CrossTab Reports display and summarize data in a way that expands dynamically both vertically and
horizontally.

Visit the Crosstab Reports documentation.

Express Report 
Express Reports are a simpler version of Advanced Reports.

Express Reports are built using a "Wizard" interface instead of a grid to streamline the report design process. Most of the features of
Express Reports are available in ExpressView and Advanced Reports, which have a more modern interface.

Visit the Express Reports documentation.

Chained Report 
Chained Reports combine multiple reports into a single multi-page document.

This can simplify running and distributing a group of related reports at once. They also support collating reports along a common sort field,
to create a super-grouping of common report data.

Chained Reports can be scheduled and exported to multiple formats.

Visit the Chained Reports documentation.
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Building Your First Report
This article will walk users through the New Report Wizard and demonstrate how to create a new report from start to finish.

1. In the main menu, click the Create New Report  icon.
2. There are several types of reports, the most common being an Advanced Report. 

Note

This article will focus on building an Advanced Report. For information on the other types of reports, see the article on Report Types.

The Report Wizard will open. The Report Wizard has five tabs: Name, Categories, Sorts, Filters and Layout. The Name and Categories
tabs must be completed while the other tabs are optional.

Name Tab
In the Name tab, enter a report name and click on the folder where the report will be saved.

The report name can be up to 255 characters long. The following special characters may not be used: ? : / \ * “ < >

The report’s description appears at the bottom of the Main Menu when it is selected. The description text may also be used to search for a
report.

Note

You cannot create a report inside a folder that is read-only ( ).

Categories Tab
In the Categories Tab, select the Data Categories that you would like to have access to on the report. It is important to understand two
terms: Data Category and Data Field.

Data Category – A Data Category is a data object that has several attributes. For example, Students is a category; each student has an
ID, a major, an advisor, etc.

Data Field – A Data Field is a single attribute within a category. For example, Students.ID is the numeric value that identifies a specific
student.
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To add a Data Category, either drag and drop it to the Category Name column, use the  Add button, or double-click the category.

Note

When one Data Category is added, other Data Categories that are not joined to it become unavailable by default.

To search for a specific Data Category or folder, type its name into the Search box.
To see what Data Fields are in a Data Category, click on a Data Category and then click the information  button.
Check the Suppress Duplicates box to suppress any repeated records from that category.
To remove a Data Category, click the delete  button.

For this report, we've selected Categories and Products.

Note

For each category selected, a user can Suppress Duplicates within the data by ticking the check box that appears next to the category
name. This will suppress repeated items in the given category for the final report.

Sorts Tab
In the Sorts tab, specify which Data Fields will be used to determine the order of data on the report.
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To sort by a Data Field either drag and drop it to the Sort By Column, use the  Add  button, or double-click the field.
You can sort each Data Field in Ascending (A-Z, 0-9) or Descending (Z-A, 9-0) order.
Use the Move Item Up  and Move Item Down  icons to indicate the sort priority.
To remove a sort, click the Delete  icon.

For this report we have sorted on Categories.CategoryName in descending order.

Note

Sorts are not mandatory in order to create a report. Sorts allow for more complex organization of a report but do not bar the report wizard
from continuing if left blank.

Filters Tab
In the Filters tab, create statements that will be used to filter the data when you run a report.

There is no limit to the number of filters that can be defined. Filters can be numeric (up to eight decimal places) or alphanumeric.

To filter a Data Field, either drag and drop it to the ‘Filter By’ column, use the button or double-click it.
Use the Move Item Up  and Move Item Down  icons to indicate the filter priority.
To remove a filter, click the Delete  icon.
Set the operator (equal to, less than, one of, etc...) by selecting it from the Operator dropdown.
Set the filter value by either entering it manually or selecting a value from the dropdown. If the Data Field is a date, the calendar and
function buttons can be used to select a value.
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Choose AND With Next Filter to require that the selected filter and the one below it both evaluate to true. Choose OR With Next
Filter to require that either or both be true.
Check Group With Next Filter to group the filters. Filters can be nested indefinitely by using the following keyboard shortcuts
while a filter is selected:

Ctrl + [ adds an open-parenthesis before the selected filter.
Ctrl + ] adds a close-parenthesis after the selected filter.
Ctrl + Shift + [ removes an open-parenthesis from before the selected filter.
Ctrl + Shift + ] removes a close-parenthesis from after the selected filter.

Check Prompt for Value to prompt the user for a new filter value at the time the report is executed.

For this report, an Equal To filter on Category Name has been created in order to limit the data on the final report. 

Note

Like Sorts, Filters add complexity to a report but, but their completion is not mandatory.

Important

If a filter is chosen, the above fields must be completed or the report will not execute.

Layout Tab
In the Layout tab, select the Data Fields that will appear on the report. For each Data Field chosen, the report will automatically create a
column header and place the Data Field in the detail section. Additionally, subtotals, grand totals, and a page header/footer can be
created.

Display Data
To place a Data Field on the report, either drag and drop it to the Data Field column, use the Add  button, or double-click the
field.
Use the Move Item Up  and Move Item Down  arrows to indicate the order the Data Fields should appear on the report. The
Data Field at the top will appear on the report as the left-most column.
The Summary Function column is used to make subtotals and grand totals. See Subtotals and Grand Totals for more
information.
To remove a Data Field, click the Delete  icon.

Using the Summarize By box, you can display subtotals, grand totals, or headers for the values of a Data Field.

Subtotals and Grand Totals
To display subtotals, check the box of the category you want subtotals for in the Summarize By box. Then, for each Data Field
you want totaled, select a Summary Function (see below).
To display grand totals, check the Grand Total box. Then for each Data Field you want totaled, select a Summary Function (see
below).
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Summary Functions
Sum: Totals the all of the data in the Data Field.
Count: Returns the number of rows in the Data Field.
Average: Takes the mean of the data in the Data Field.
Minimum: Displays the lowest value in the Data Field.
Maximum: Displays the highest value in the Data Field.

Data Headers
A checkbox will appear in the Summarize By box for each Data Category in the Sorts tab. To display a header for each value of a Data
Field, click on the associated Data Category in the Summarize By box. Click the Data Category name next to the checkbox, and the will
appear.

To include a Header, check the Include Header at the beginning checkbox. In order to select the text that will appear as the
header value, use the Header dropdown to select a Data Field or use the Formula Editor  icon to create a formula.
Use the Summarize by each unique dropdown to specify if the header should repeat based on a specific field or fields within a
Category.
Check the Include Total at the end checkbox to have a subtotal created for this Category.

For this report, the Data Fields Products.ProductName, Products.ProductID, Products.UnitPrice, and
Products.QuantityPerUnit have been selected.

To see the report in the Report Designer, click Finish.

The Report Designer will display the report like this.

Note

For information on the Toolbar and all its features, see the Using the Toolbar article

To add the next layer of intricacy to your articles you'll want to create grouping within the present data. To read more, continue to Grouping
Basics. 

Grouping Basics
Understanding Groups
Groups break up a data set into sections of related information, allowing for aggregation and/or the removal of repeated values from the
tabular detail. We see grouping in lots of settings, but restaurant menus provide a useful example. We never see menus like this:
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Or like this:

In the above example, the menu is stored by dish type, but there are repeated values in the "Type" column, which makes the menu difficult
to read at a glance. For this reason, menus typically group on dish type:

Grouping works a bit differently in the application, but its function is the same. In either case, the first step in creating a group is sorting on
the appropriate data field.

Creating Sorts
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Users may either build sorts from the Report Wizard or from the Report Designer.

In the Report Wizard, Sorts is the third tab. To create a sort, drag-and-drop a data object into the sorts pane. Select Ascending or

Descending from the Sort Order dropdown. A formula can be added to the sort by clicking on the Formula Editor  icon. Add as many
sorts as desired, and change sort priority by using the Move Item Up  and Move Item Down  arrows to move the sort priority up
and down the list.

In the Report Designer sorts may be added, deleted or changed by selecting Sorts from the Settings  menu.

The Report Designer Sorts menu works much the same as the Report Wizard sorts menu does.

Once you've sorted on a field, you're ready to group on that field.

Note

Nested groups should reflect the sort order. The outermost group header should be the highest priority sort, and the footer order should
be reversed. Find more information on this in Understanding Header/Footer Grouping.

Sorting By Formula
To sort and group by information that may not be contained within an individual data field, Formulas can be used. Refer to the article on
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Formulas for more information including descriptions of each formula.

Click the  Add Formula button or the Formula Editor  icon in either the Report Designer or Report Wizard to open the Formula
Editor window:

Add a data object by dragging and dropping it into the formula box, double-clicking it or entering it manually using the following
format: {DataCategory.DataField}.
Add a parameter by entering it manually using the following format: @ParameterName@.
Add a function by dragging and dropping it into the formula box, double-clicking it or entering it manually.

For example, consider a data field containing a full date and time, {Orders.OrderDate}. To sort by sales of each month of the year
over a multi-year period, the formula Month({Orders.OrderDate}) will return only the month component of each date. Refer to the article on
Formulas for more information including descriptions of each formula.

Adding Group Sections
In order to add group sections, click anywhere in the sections column of the Report Designer. From here, select Add Section and then
Group Header.

In the Group Header menu, use the dropdown to select the proper sort field. For this example report, Categories.CategoryName has
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been selected.

Note

Groups can be sorted by formula instead of a Category or Field by adding a formula to the report Sorts, then selecting it in the group
dropdown menu.

After adding the Group Header, repeat the same steps above to create a group footer by selecting Group Footer from the Add Section
menu.

Group Header and Footer Content
Headers and Footers are designed to display content that will appear once per unique value in the group. Group Headers appear above the
group detail, and Group Footers appear below the group detail.

(pre-v2019.1.4) Group Footers may be used to perform aggregate functions on the group detail.
(v2019.1.4+) Group Headers and Footers may be used to perform aggregate functions on the group detail.

In this example, there is a group header on Categories.CategoryName, and there are two rows in that header. Row #3 contains the
Categories.CategoryName field, which will repeat once for each unique Category Name in the Categories object. Row #4 contains
column titles for the details section. They will appear once for each unique Category Name in the Categories object.

In the footer section, the average of the products unit price in each category is calculated with a formula. Like the values in the Group
Header, this average will appear once for each Category Name in the Categories data object.

Note

Because headers are not designed for content that will produce many different results for each group, it is best to select content that will
only change with each group. For example, if {OrderDetails.Quantity} is placed in a group header, it will only display the first
record for each group break. Additionally, placing this field in a group footer will display only the last record in the group.

Upon execution, the report now shows each food category name and displays aggregate information for the unit prices in each category.
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Reprinting Group Headers
Beginning in v2018.2 of the application, the reprint Group Header rows can be reprinted at the top of the page if the detail section spans
multiple pages. This option is only available on Group and Repeating Group Header sections. To reprint a Group Header row across
multiple pages, click the row number in the Report Designer and select Repeat Row. If the Header has been set to repeat, two blue lines
will display next to the row number.

Formula Basics
Formulas allow users to create complex calculations, parse strings, and insert images within the application. Formulas can be comprised
of functions, parameters, strings, data fields, and cell references. All formulas begin with an equals sign (=).

In the Report Designer, users can either key their desired formulas directly into a cell or enter them with the assistance of the built-in
Formula Editor.

Note

This application comes with a standard set of functions, but the number of available functions may differ based on the environment as set
by the system administrator.

Adding Mathematical Calculations
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Totals for each data field are not automatically calculated in an Advanced Report, so we must add calculations to the report in order to
display totals. A great way to do this is through the use of footers, which are designed to aggregate the data contained in the section
above them. Group Footers allow the totaling or counting of data contained in the group, and Report Footers allow the totaling of the full
contents of a report.

In the example below, there is a group footer on Products.ProductName, and the Detail section of the report has been suppressed.
Suppressed rows do not display on the report output. The end goal is to have this report display one row for each confection product, each
row containing the product name, total order quantity, unit price, and revenue generated by each product, with a grand revenue total at the
end.

Looking more closely at the footer, we can expect the cells to display as follows:

Cell A5 will display the product name for each unique product in the group.
Cell B5 will display just the last order quantity value for each product in the group because there is a one-to-many relationship
between products and order quantities.
Cell C5 will display the unit price for each unique product in the group.

If our goal is to calculate the revenue generated by each confection product, the first step would be to calculate the total quantity of orders
for each product in cell B5.

Entering a Formula
To enter a formula into B5, we click on the cell and either enter =aggsum({Order Details.Quantity}) or select AggSum and the
data field from the Formula Editor. To access the Formula Editor, select the cell and click the Formula Editor  icon on the toolbar.

Now we can add a column to the right-hand edge of the table and calculate the product revenue in D5.

Calculating with Cell References
Revenue is the product of all order quantities (B5) and unit prices (C5). Instead of completely rewriting the AggSum formula we just created
in B5, we can use a cell reference to quickly and easily allow this inclusion.

Cell references are formulas, so they will have to start with an equals sign (=). To reference a cell, enclose the coordinates in square
brackets ([ ]). We'll enter =[B5]*[C5] in cell D5 to calculate the revenue for each product.
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Calculating in the Report Footer
To calculate a grand total of the Revenue column, we will add a new group to the report, this time a Report Footer. The Report Footer
aggregates values contained in the whole report, as opposed to a particular group within it. Again, we will use cell references for simplicity.

Upon execution, the above report displays the following:

Tip

Instead of using the Formula Editor it is possible to aggregate using the AutoSum  icon on the toolbar. Select the target cell, enter
an equal sign followed by the value(s) you wish to aggregate, and click the AutoSum button. (In the above example, the grand total
formula would read =[D5] with the AutoSum button depressed.)

Concatenating Strings
Concatenation combines multiple fields or strings into a single string. For more on concatenation see the full list of formulas and
descriptions.

In this report, we can use concatenation to create a label for our revenue grand total and specify what category it pertains to.
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Concatenation can be done by using an ampersand (&) between each string or by using the Concatenate function in the Formula Editor.

In the figure below, the Concatenate function has been entered into the cell manually. Note the ampersands.

Tip

To add space between elements in your concatenation, insert spaces at the beginnings and/or ends of your strings.

For example: {Categories.ID} & " " & {Categories.Name}

With a little added formatting, the executed report now looks like this. The Confections has replaced Categories.CategoryName in
our concatenation formula.

Formula Basics User Guide

29 of 152



Now that the report has become more intricate, it may help to have a better way to see the data presented. This can best be done through
visualizations. Continue on to the Adding Visualizations to a Report article.

Adding Visualizations to a Report
This guide is designed to walk users through adding a visualization to the example report. For this example, we'll create a chart
visualization, keeping in mind that GeoCharts, Google Maps and gauges are other possible visualization types. More info on GeoCharts,
Google Maps, and gauges can be found in their respective articles.

Tip

To learn in depth about visualizations and charting, review the Visualizations section of the documentation.

Adding the Chart

First, select a cell in in the Report Footer and click the Visualization  icon in the toolbar.

Or, right-click a cell in the Report Footer, hover over Insert and click Chart.
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Note

Charts rely on aggregating data and are therefore best placed in a group or report footer.

The Chart Wizard
The chart wizard will step you through building the visualization.

Type Tab

The Chart Wizard opens on the Type tab, where you may select the type of chart to create. The charts are broken up into five groups:
Line; Bar and Column; Pie and Other Single-Series; Scatter and Bubble; and Combination.

Line charts show trends in one or multiple data sets over time. These can be single- or multi-series.
Bar and Column charts compare values, aggregate values, and percentages to each other. They can be either single-series or
multi-series.
Pie and Other Single-Series display the parts of a whole in percentage point terms and only display one series at a time.
Scatter and Bubble Scatter and Bubble charts show the relationship between distinct data points in one or more series.
Combination charts are just that — a combination of more than one type of chart. For example, a line and bar chart.

For this report, the desire is to show a chart that allows direct visual comparison of total revenue generated by each product. This is best
accomplished with a Bar or Column chart. Select

Data Tab

The Data Tab is where data is refined for the selected chart and where the interaction of the data is determined. A data value and a data
label for the chart must be set before proceeding.

Using the dropdown menus set the X-Axis Labels to Products.ProductName and set the Series Values to the formula for product
revenue, =[B5]*[C5]. For the Other Options, set the Sort data by dropdown boxes to Data Values and Ascending to sort in ascending
order for quick comparison.
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Appearance Tab

In this tab, we can customize the chart's appearance by applying a theme, labels, number formatting, benchmark lines, and other
features. 

Note

The values in the Appearance Tab are optional.

Size and Preview Tab

After the chart has been formatted, either click the Finish button to dismiss the chart wizard or move on to the Size and Preview Tab.
The preview displays dummy data formatted according to the user's specifications and gives users the option to resize the chart.
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Reading The Chart
Click Finish and execute the report to HTML. Below is the visualization we've just constructed:

After execution, it is clear that Tarte au Sucre has generated the most revenue and that Chocolade has generated the least.

Interactive Report Viewer
In the Report Viewer users are able to make adjustments to the chart without having to re-execute the report. Right clicking on the chart
will bring up a series of menus.
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These menus include:

Type — This allows users to change the chart type within the HTML viewer
Theme — This allows users to change the theme of the chart within the HTML viewer
Legend Location — This allows users to add, remove, or change the location of a chart legend.
Sort By — This allows users to adjust chart sorts within the HTML viewer.

Now that the report is near complete, it is possible that users may need to schedule this report for use. For information on this process,
continue to Scheduling a Report.

Scheduling Reports
The Scheduler Service allows you to run reports, ExpressViews and Dashboards regularly at specified times. This can be useful for
reports based on periods of time, such as weekly sales reports or quarterly earnings reports.

Note

The Scheduler Service is an optional feature. Check with your system administrator for more information.

Creating a Schedule
Schedules are created and edited with the Schedule Report Wizard.
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To schedule a report:

1. Select the report you'd like to schedule in the  Report Tree, then either right-click on it or click the Menu  icon and

click  Schedule Report.

2. Enter a Name for the schedule.
3. Choose which file type to save the report as.
4. Optional: For PDF or Excel, enter a Password to secure the output file.
5. Select a date and time for the schedule, and choose how often it should run:

1. In the Schedule Time field, enter a time for when the schedule should run.
2. Optional: To run the schedule as soon as it is created, select the Execute Immediately check box. This schedule

cannot be given a recurrence pattern. Go to step 6.
3. Optional: To run the schedule multiple times per day, select the Repeat Every check box and enter a time for how

often it should repeat.
4. Optional: To run the schedule on more than one day, choose a Recurrence Pattern from the available options:

1. Daily: The schedule will repeat every day, every weekday, or every number of days. Enter a number of days for
how often the schedule should repeat, or select Every weekday to run it every Mon, Tues, Wed, Thurs, and
Fri.

2. Weekly: The schedule will repeat every week, or every number of weeks, on one or more days. Enter a
number of weeks for how often the schedule should repeat, and select one or more days when it should run.

3. Monthly: The schedule will repeat every month, or every number of months, on a certain day. Enter a day for
when the schedule should run, and a number of months for how often it should repeat.

4. Yearly: The schedule will repeat every year on a certain day. Enter a day for when the schedule should run.
5. Optional: If you have entered a recurrence pattern, enter a date for when the schedule should Start.

6. Optional: To add filters to the report click the Filters tab. If the report already has filters you can set their values here. See
Filters for instructions.
Note

In versions prior to v2018.2, Chained Reports do not support scheduled filters.

7. Optional: To email this schedule to addresses from a database, see Emailing personalized reports.
8. Click the Recipients tab. To send the report to a list of email addresses, select the Email Reports check box and fill out

the following fields:
1. Enter the recipients' email addresses in the To, Cc, and Bcc fields.
2. Optional: Enter an email subject in the Subject field.
3. Optional: Enter an email message in the large text field.
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If you do not want to email the report, uncheck the Email Reports checkbox. The report will be saved to disk instead. You
may have to ask your system administrator for the file location.

Note

To save the report to a repository instead of e-mailing it, review the Saving Reports to a Repository section below.

1. Optional: If this is a batch schedule, an Attach Report Output to Email check box is available. Clear this check box if you want to
use this report to send alerts, and you do not want to email the report itself.

2. Click Finish to save the schedule.

Schedules can be edited after they are created. See Viewing and Editing Schedules below for more information.

Saving Reports to a Repository
In addition to being emailed, Scheduled Reports can be set to run and automatically saved to a specific location. This can be useful for
users who wish to automate certain report executions but do not wish to add extra clutter to an email inbox.

To send Scheduled Reports to a repository instead of a recipient via email, simply uncheck the 'Email Reports' option in the Recipients tab
when creating a new Scheduled Report. For more information on creating a Schedule Job, please see the Scheduling Reports guide.

Note

The availability of the Email Results checkbox is determined by the system administrator, so it may not be available in your
environment.

Viewing and Editing Schedules

Click the Schedule Manager  icon in the main menu to open the Schedule Manager. Depending on system configuration, you may be
able to see reports scheduled by other users. Ask your system administrator for more information.

Each schedule is on a row with its most recent and forthcoming run times and a status indicating its condition.

Ready: The schedule will run at its next scheduled execution time.
Running: The schedule is currently running.
Transmitting: The scheduled event has finished running, and the report is being sent to the users.
Completed: The schedule has completed its final event, and will not run again. It will be removed from the list when the cache is
flushed.
Deleted: The schedule has been deleted, and will be removed from the list when the cache is flushed.
Abended: The last run failed due to an error. The schedule will not run again.
User Aborted: The schedule is running, but it was requested to be canceled. It will be marked as Deleted.

Scheduled events which have passed are copied to an archive row, so that there is a log of previous run times. Such events are labeled
(archive). Deleting these rows will not affect the main schedule.

Schedules which are associated with a cached report are labeled (cache). See Execution Caching for more information.

Managing Schedules

To edit an existing schedule click the Edit icon at the end of the row. Changes to the recurrence pattern will affect all forthcoming run
times. You can reuse or reset deleted or completed schedules by editing them. This will set their status to Ready.

To delete a schedule click the Delete  icon at the end of the tow. This sets its status to Deleted. If the schedule is already marked as
Deleted, this removes the schedule from the list.

Completed and canceled schedules and archives may be periodically removed from the list. Click Flush  to clear the Scheduler cache
and remove them immediately.

Emailing a Report Immediately

Note
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This feature can be disabled by the system administrator, it may not be available in your environment.

In addition to creating a recurring schedule, the application provides the option to email a report execution immediately. To do this, simply
select the desired report to email and select the Email Report option from the dropdown menu. Users are then prompted to fill out the
email address and select the output format for the report.

Batch Emailing Personalized Reports
Batch scheduling allows you to send personalized versions of reports to a list of email addresses. The addresses must be defined in a
data category, the unique key of which is used as a blanket filter for the report. Each recipient receives a customized version, filtered by
their unique key.

For example, if you wanted to send out a customized sales review, or a pre-filled tax form, or even a set of customized forms for each
employee, batch scheduling allows you use one report for every person. This also has the benefit of only needing to run the report once.

Warning

Batch emailing should only be used as instructed by your administrator. If you are unsure about how to proceed, do not create a batch
schedule. Ask your system administrator for assistance.

In order for batch scheduling to work properly, it requires access to a data category with a column of email addresses that must be either
located within or joinable to the underlying table. This data category can be added in the Categories menu of the report. If this column
does not exist, the report will abend with the following error:

System.Exception: Batch email column has no join logic to attach to report. 

Note

The category containing the email addresses for batch scheduling does not need to be added to the report itself.

To make a batch schedule:

1. In the Schedule Report Wizard, click the Batch tab.
2. Select the Run as Batch Report check box.
3. Optional: In the To and Cc fields, enter addresses to send a summary email for each completed execution.
4. From the Batch Email Field list, select the data field containing the email addresses for this schedule. Fields can contain a list of

email addresses, separated by semicolons (;), as of v2017.3.8+.
5. Optional: Click the Recipients tab to enter a subject and message for the batch email.

You can reference data values from the email address data row in the message body. Type the parameter @batch_column@, where
column is the name of a data field in the address category (in lowercase text). The value of the field replaces the parameter text in the
message output.

Tip

The To, Cc, and Bcc fields are unavailable when using Batch. Dashboards can not be scheduled as a Batch report.

ExpressView
The ExpressView Designer is a data discovery and reporting tool that simplifies grouping, sorting, filtering, and aggregating data with a
drag-and-drop interface. A chart can be added with a single click, and ExpressViews can be styled and saved as PDF, RTF, CSV, or
Excel files.
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The ExpressView Designer

Making an ExpressView
ExpressViews allow you to quickly see data and make reports without concern for the minutiae of old-fashioned report building.

To make an ExpressView:

1. Click the Create New Report  icon and select  ExpressView.

The ExpressView designer is divided into the Data pane on the left, and the Design pane in the middle. The Data pane comprises all

of your accessible data categories, containing groups of related data fields. Click the Choose Data  icon to expand or collapse
the Data pane.

2. Expand a category by clicking the arrow  icon. This shows the fields in that category.

3. Drag a field onto the Design pane to add it to the ExpressView. This expands the field into a data column. It will only show
placeholder data initially.

Dragging a field onto the Design pane

4. Continue to add fields as desired. Fields can be added or removed at any time.

Note: As you add fields, unrelated fields will become unavailable. To learn about how fields relate to each other, see Joins.

5. When you are satisfied with your data selection, click  Live Data to populate the ExpressView with data. You can now page
through your data using the navigation icons     in the toolbar.

 Truncated results displayed
This icon and message indicates that the report has only returned a partial data set. There are fewer detail rows than the full set,
and aggregate formulas and visualizations apply only to the data that was returned to the report.
To get more data, click the icon and select either:

Generate +number to get the next number of data rows and add them to the existing report.

Generate All to get the full data set.
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6. Click the Save  icon to save the ExpressView. In the Settings window, enter a Name and select a folder where it should be
stored. Then click Save Report Info.

These steps illustrate how quick it is to make a tabular report from scratch using ExpressView. But ExpressViews can be more than just
basic reports. You can make groups, charts, calculations, and customize the look of the report. And it is all designed to be easy to use.
The articles in this section will describe how to use these powerful features.

About the Radial Menu
Throughout this article you will see references to a menu called the Radial Menu. The Radial Menu is a menu of options for each data
column and group, which is accessed by clicking the colored Radial  icon on the top left of the column or group.

Using the radial menu

Each radial menu has four options, arranged in a circle around the center. When you are prompted to select a radial menu option, you will
be asked to "use  radial>direction". Direction is one of the four cardinal directions corresponding with one of the four options: left, right,
up, down.

For example, "use  radial>left" means to open the radial menu and select the left option. To do this, you have two options:

Click the radial icon, move your cursor left, then click again.
Click-and-hold the radial icon, drag your cursor left, then release.

To close the radial menu without selecting an option, click in the center.

Interactive Editing
With the introduction of interactive editing to ExpressView in v2018.2, you can customize your report by simply right-clicking on the
desired section while in design or live mode.

Right-click options include all of the capabilities of the radial menu, conditional filters, and formatting options such as text alignment, font
type, and font color.

ExpressView: Managing Data
You can exercise some fine grained control over the actual data that appears in the ExpressView. You can choose styling options, you
can filter down the rows to appear, and you can change the order of rows in their respective sections.

Formatting and Style
Formatting allows you to specify a data type (e.g. number, date, text) for specific data fields, and choose how that data displays.

To change the data type for a field:

1. Click the Formatting and Style  icon in the pane on the right to open the Formatting page.
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2. Click the data rows to format. They will highlight in blue.

Selecting data to format

3. In the pane on the right side of the screen, click the Data Formatheading to open it.
4. From the Format Type list, select a data type from the following options:

General
Format the data using the default settings for your environment. The application will assume the data type.

Number
Format the data as a number.

1. In the Decimal Places field, enter a number for how many decimal places to display. In the field to the right, enter a symbol
to use as the decimal mark.

2. To show a delimiter every three digits, select Use 1000 Separator. Then, in the field to the right, enter a symbol to use as
the delimiter.

3. To show a symbol before the number, indicating that this is currency, select Use Currency Symbol. Then, in the field to the
right, enter the symbol to show.

4. To show a percent sign after the number, indicating that this is a percentage, select Append Percent Sign.
5. To show no value if the number is 0, select Blank When Zero.
6. To show the negative symbol in front of negative numbers, select Show Negative Symbol.
7. To show parentheses around negative numbers, select Show Parenthesis.
8. To show negative numbers in a different color, select Color, then enter a hex value or use the color picker to choose a color.

Date
Format the data as a date, time, or date and time. You can choose which date and time components to display, and how to show
them.

Choosing a date/time format

Text
Do not apply any formatting to the data, and show it exactly as it appears in the database

If the data field cannot be formatted as a number or date, then selecting one of those options will have no effect on the appearance of the
data.

Sorting

Sorting allows you to set the order that the data rows appear in each section. Click the Sorts  icon to open the list of sorts. Every
data column in the ExpressView that is not a group column is automatically sorted.

You can choose which columns take precedence for sorting. The order of fields on the Sorts page is their order of precedence, from
highest to lowest. Their order is also indicated by a number on the right of the column headers: The lower the number, the higher the
precedence.

To set the sort precedence of data fields, either:

On the Sorts page, drag fields up or down.
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Use  radial >down  to give a field the highest precedence.

Dragging a sort to change its precedence

You can choose which direction to sort the data for each data field: ascending or descending. A field's sort direction is indicated by an
arrow on the right of the column header: Up  for ascending, down  for descending.

To change a field's sort direction, either:

On the Sorts page, select asc for ascending, or desc for descending.
Click the column header to swap to the opposite direction.

Filtering
Filtering allows you to narrow the scope of your ExpressView by restricting the amount of data shown.

Standard Filters allow only rows whose values satisfy certain conditions to appear in the report.
Top N filters allow only the rows with the top or bottom values, for either data fields or data summaries, per group iteration to appear
in the report.

Click the Filters  icon in the pane on the right side of the screen to open the list of filters. The filters page has two tabs: Standard and
Top/Bottom.

To show only the data that satisfies several conditions:

1. On the Filters page, click the Standard tab.
2. To add a data field to filter, either:

Use  radial >right on a data column or group.
Drag a data field from the Data Pane on the left side of the screen to the Meet all of the following conditions pane.
Note: This allows you to filter any accessible data field, not just those on the ExpressView.

3. Choose a filter operator from the list. See Filters for details.

4. Enter a filter value or values, or select them from the list.
5. Repeat steps 2-4 for every filter condition that the data must satisfy in order to show.
6. If you are viewing live data, click Apply Changes to apply the filters.

To show only the data that satisfies at least one of several conditions:

1. On the Filters page, click the Standard tab.
2. To add a data field to filter, either:

Use  radial>right on a data column or group. Then drag the filter to the meet any of the following conditions pane.
Drag a data field from the Data pane to the meet any of the following conditions pane.
Note: This allows you to filter any accessible data field, not just those on the ExpressView.

3. Choose a filter operator from the list. See Filters for details.
4. Enter a filter value or values, or select them from the list.
5. Repeat steps 2-4 for every filter condition, of which the data must satisfy at least one in order to show.
6. If you are viewing live data, click Apply Changes to apply the filters.
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Adding a field as a Standard filter

To show only the top or bottom values, for either data fields or data summaries:

1. On the Filters page, click the Top/Bottom tab.
2. Select the Limit the report to the top/bottom values check box.
3. Select either Top or Bottom, for whether you want to show the top or bottom values.
4. Enter a number for how many values you want to show.
5. Choose how you want to limit your data:

If you want to show the rows with the top or bottom data values for a field or group, select Values from the list.
If you want to show the groups with the top or bottom summary values for a parent group or the ExpressView, select one of
the summary calculations, Sum, Avg, Min, Max, Count, or Distinct Count, from the list. See the article on aggregation for
more information.
Note: Only numeric data fields support Sum and Avg calculations.

6. Select the data field or group field to filter from the Of list.
7. Optional: To show the top or bottom values for each iteration of a group:

1. Click  Add Group.
2. Select a group field from the For Each list.

Adding a Top/Bottom filter

ExpressView: Formula Columns
Note: Formula columns are available beginning with v2018.1+ of the application.

Formulas can be used to create custom data columns in ExpressView. Formulas are calculated once per each row, based on the other
data values in that row. For each row calculation, a formula value is returned for that row, which populate a new column of data. You can
use these columns just like any others - format the data, add to a visualization, or group based on formula columns. They are treated the
same as data columns.

To add a formula column to an ExpressView, open the  Data Pane  then click + Add Formula at the top of the pane. A blank column
will be added to the ExpressView, and the Formula Builder will open.
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In the right pane, the Formula section of the Selected Cell  page shows the available built-in functions and parameters. Hover over a
function to see its description and an example of how to use it. To add a function or parameter to the formula, drag it from the Formula
page to the Formula Builder window, type its name into the Formula Builder, or double-click the name of the function while the formula
editor dialog is open. You can use the Search field in the to filter the functions by name.

Formula editor dialog

To add a data field to the formula, either:

drag it from the Data Pane to the Formula Builder window
type its name into the Formula Builder
double-click the field name while the Formula Builder is open

Note: Double-clicking the field names will place the fields wherever the cursor is in the formula editor at that time. Double-clicking
enabled in v2018.2 and later.

Tip: To use a data field, function, or parameter as a function argument, drag it to the argument placeholder until the placeholder turns
blue. Or click the placeholder and type the name of the desired argument.

Dragging a field to a function argument

Typing in the Formula Builder shows a list of functions, parameters, and data fields that match the text. Click on an item, or use the up
and down arrow keys, to highlight an item and see its description. To add the selected item to the formula, press the Enter key.

When you are finished, click the Apply Changes  icon at the top of the of the Formula Builder to save the formula.

To edit an existing formula column, click Selected Cell , open the Formula tab, then click the column to reopen the Formula Builder.

See Formulas for more details on building formulas.

ExpressView: Customizing Appearance
ExpressViews can be styled in a variety of ways:

Click the Formatting and Style  icon in the right pane to make universal report styling changes such as Theme.
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Click the Selected Section icon and choose a section of the report to make formatting changes.

Right-click a section of the report for interactive editing that includes formatting options and data structuring options such as sorting,
grouping, and filtering. Learn more about interactive editing in ExpressView here.

 

Premade Themes
If there are any available, you can select a premade theme to use for the ExpressView, or to use as a baseline for further customization.
On the Formatting page, click the Theme tab. Then select a theme from the Theme Selector list:

Legacy

This is the default theme.

Custom

This option indicates that you are not currently using a premade theme.

Selecting a premade theme overrides any custom styling you have.
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Selecting a premade theme

Styling Data Cells
Cells, columns, group headers, and group footers can be styled using the Report Formatting and Style pane, the Selected Section
pane, or by right-clicking sections of the report. Each of the three options is used for different purposes:

Universal report styling changes such as theme, row shading, and group colors are made using the Report Formatting and
Style  pane. See the following two sections for more details on row and group colors.

The Selected Section  pane is used to make data format changes such as Date or Number format or to create formulas in a
column. It can also be used to style multiple cells or sections at one time when used with the CTRL key. To use the multi-

select feature, click the Selected Section icon, hold the CTRL key while clicking all of the desired sections, and then make
changes in the right pane.

To make styling changes to independent sections, you can right-click specific areas and use interactive editing or you can click

the Selected Section icon, click the appropriate section, and make changes in the right pane.

Changing data row colors
The background colors for the data rows can be customized, and you can set the pattern by which the colors alternate. This affects every
data section in the ExpressView.

To set the background colors:

1. On the Formatting page, click the Row Shading tab. By default there are two colors which alternate every other row.
2. Choose the number of colors that you want to alternate between:

To make all rows the same color, click  to delete all the colors except one.
To make rows alternate between more than two colors, click  to add more colors.

3. Enter a hex value or use the color picker to set each color.
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Choosing data row colors

Changing group colors
The headers and footers for group columns are prefixed by a different color depending on the level of grouping. These colors can be
customized, and you can set the pattern by which the colors alternate. This affects every group header and footer in the ExpressView.

To set the group level colors:

1. On the Formatting page, click the Group Colors tab. By default, nested groups alternate between four colors.
2. Choose the number of colors that you want to alternate between:

To make all group levels the same color, click  to delete all the colors except one.
To make group levels alternate between more than four colors, click  to add more colors.

3. Enter a hex value or use the color picker to set each color.
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Choosing radial menu colors

ExpressView: Visualizations
Visualizations allow data to be showcased in a visual format. They allow data to be scanned quickly for patterns and trends. Charts can
be easily made and customized in ExpressViews, in as little as one click.

An ExpressView Visualization

To add a chart to an ExpressView:

1. Click the Show Visualization  icon in the top toolbar. A bar chart is added and populated with the data from the ExpressView.
2. In the Visualizations pane, select the type of chart you want to use. The chart immediately swaps to that type. Choose from Bar

and Column, Pie and Other Single-Series, Line and Area or Miscellaneous.

When  Live Data Mode is on, click on a chart series to drill down into the data for that series. This filters the data columns to only
the series you select.

You can add many more personal touches, small or large, to the visualizations you create. See the following sections for details on how to
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customize your visualizations.

Choosing Chart Data
When a visualization is first added, the application presets the chart fields to try to match the ExpressView data as closely as possible.
This may not always match the data that you want the chart to use.

To see the chart data fields, click the Visualizations  icon in the pane on the right side of the screen, then click the Data tab. There are
two sections: Labels and Values.

Labels
The Labels field is a group of data values, each iteration of the group represented as a series on the chart. For example, using an
Employees group field as the label field represents each employee as a series.

Several charts allow an additional labels field. This is useful if you have a nested group, which represents common series to be measured
across several groupings. For example, to compare the number of sales per product per employee, you could add a nested Product field
as a second label to the aforementioned employees chart.

To add a chart label, either:

Drag a data field onto the chart and release on the Add Label area.
In the Visualizations pane, click the Data tab. Either:

Drag a data field to the Labels area.
Click  Add Label, then select a field from the Field list.

 
Drag a field onto the visualization or onto the Data tab to add it as a label

Values
The Values field is the data values to plot on the chart for each iteration of each labels group. For example, the number of sales per
employee.

Several charts allow for multiple values fields. This is useful if you have common series to be measured across several groupings, and the
values fields are in the same data row. For example, the number of sales and number of lost sales per employee.

To add a chart value, either:

Drag a data field onto the chart and release on the Add Value area.
In the Visualizations pane, click the Data tab. Either:

Drag a data field to the Values area.
Click  Add Value, then select a field from the Field list.

 
Drag a field onto the visualization or onto the Data tab to add it as a value
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Interactive Editing of ExpressView Visualizations
You can invert the data, change the Type, Theme, Legend Location, or Sort of ExpressView visualizations by simply right-clicking with the
introduction of interactive HTML to ExpressViews in v2018.2.

Suggested Reading
Charts
Report Viewer: Interacting with Reports

ExpressView: Grouping and summarizing data
Grouping a column of data breaks up the rows into sections which share a common trait. Each iteration of a group is a unique row in a
data column. Grouping data allows you to easily identify rows with common factors. You can perform calculations on groups, such as
counting the rows, or adding up the data in each iteration.

Grouping data in an ExpressView

Making a group
To create a group from a column, use  radial>up or right-click the column and select Group in the dropdown menu. This turns the data
column into a group column, and organizes the other columns by each unique row in the group. Each row in the data column becomes a
group section, or iteration, and the rows in other columns are grouped by the section which they are related. The group is also given a new
color to distinguish it from the data rows. Remember to turn Live Data on to see your actual data and verify that this is the grouping you
want.

To ungroup a column, use  radial>left or right-click and select Ungroup from the dropdown menu. This turns the group column back into
a data column.

Groups can be created inside other groups. These are called nested groups. To make a nested group, simply add another group to an
ExpressView which already has one. This creates another grouping inside the existing group. Additional levels of nesting can be made as
needed.

Note: Right-click interactions added in v2018.2.

Changing group level
If you have two or more levels of grouping, you may decide that they are nested improperly. For example, if you had Products grouped by
Orders, then you add another grouping on Employees, you may end up with Products grouped by Employees grouped by Orders.

Improper grouping of data fields

However, it makes more sense to have Orders grouped by Employees instead, since Employees have multiple Orders, but Orders does
not have multiple Employees. To move the Employees group up one level, use  radial>up on the group column or right-click the group
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header and select Move Group Up One Level.

Proper grouping of data fields

Dropdown menu 

Summarizing group data
Each iteration has a footer, which contains summary calculations, also known as aggregates, for each column. The ExpressView also has
a report footer, which calculates the aggregate across all the groups. You can choose between several options for which calculation you
want to appear in the footer for each column.

To change the calculation for a column, click a footer and select one of the following options:

Sum

Totals the data values in the iteration. Only available for numeric fields.

Min

Shows the smallest data value, or first value alphabetically, or earliest date in the iteration.

Max

Shows the largest data value, or last value alphabetically, or latest date in the iteration.

Count

Counts the number of values in the iteration.

Distinct Count

Counts the number of distinct values in the iteration.

Avg

Takes the average, or arithmetic mean, of the values in the iteration. Only available for numeric fields.

None (v2017.3+) 

Show no summary calculation.

Choosing an aggregate
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For more information on aggregation, see this article.

Hiding data rows
If you only want to see the summary calculations, you can hide the data rows, either per-iteration, or for every group in the ExpressView.
This does not remove the data or alter the summaries. It only hides the rows from view.

To hide the rows for one iteration or several iterations, click the group header for each iteration to toggle whether its rows are shown or
hidden.

To hide or show all the rows in the ExpressView:

1. Click the Expand/Collapse  icon.
2. Click  Hide All Group Content to hide all the rows, or  Show All Group Content to show all the rows.

If you have nested groups, this hides all but the top level groups.

(v2017.3+) To remove all data rows from the report and only show summary data, deselect Include Detail Rows. This may improve the
performance for reports that do not depend on the detail values.

ExpressView: Data Categories and Fields

The data pane is organized into data categories, which you can expand to see their fields. Click the  Choose Data icon to expand or
collapse the data pane.

Viewing the available data fields

To locate a specific data field, type the name of the field into the  Search Fields... field and press Enter. To see all the data fields, click
 to clear the search field.

You can show only data fields of a certain type by clicking one of the type icons under the Search field:

 text
 numeric
 date/time
 other

All available data categories are usable on an ExpressView. You do not have to worry about adding categories manually or thinking about
join structure. Adding a data field is as simple as dragging it onto the Design pane. This turns it into a data column. Use  radial>left to
remove a data column.

ExpressView: Exporting
An ExpressView can be exported either as a file or an Advanced Report. A copy of the ExpressView is used to export to an Advanced
Report. This means that the original ExpressView remains available and the new Advanced Report can be edited independently of it.

Export to Advanced Report
ExpressView is a great starting point to quickly add fields to a report, before delving into some of the more advanced reporting capabilities.
The ExpressView format is not compatible with the Report Designer, but you can export it to an Advanced Report and edit the copy.

To export an ExpressView to an Advanced Report:

1. Click the Settings  icon at the top of pane on the right side of the screen.
2. Click the Create Advanced Report header to open it.
3. Enter a name for the report and select a folder where it will be stored.
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4. Click Create Advanced Report button.

Note: Beginning in v2018.2, Advanced Reports converted from ExpressViews will retain reprinting of group headers by default if detail
section spills to the next page.

Export to File
If you choose to save an ExpressView as a file, it be exported as PDF, RTF, CSV, or Excel. Each format has some advantages and
disadvantages.

PDF is closest to the look of the ExpressView, and is suitable for printing and emailing. But if there is a large amount of data, you
may have too many pages, or too large a file size.
RTF retains the basic look of the ExpressView, and can be opened in a word processor for any additional editing. But it may look
different depending on the program it is viewed with, and it is not suitable for viewing large amounts of data.
CSV retains only the data, and none of the look of the ExpressView. It is best used if you need to process a large amount of data in
an accounting or analysis program.
Excel retains the data, visualization, and optionally, some styling. It is a good hybrid format if you have a lot of data, but you still
need it in a visually presentable form.

Export Settings
You can make some customizations to the appearance that the exported files will take. With the Settings page open, click the Export
Settings tab to see the available options:

Page Options affect the size which PDF, RTF and Excel exports will show on a screen and on print.
General Options allow you to restrict available export types, and choose a default type.
Other Options:

Include Setup Info: Choose whether to include some information about the fields, sorts, and filters in the body of the file.
Use Group Color Styling: Choose whether to include the group header colorings in the output file.
'No Data Qualified' Mode: If the ExpressView returns no data, choose whether to render an empty file, or show a user
message instead.
Flatten Groups in Excel and CSV: For Excel or CSV files, choose whether to automatically ungroup, or "flatten" all group
columns into data columns. This may make the output more suitable for data analysis.
Keep Cell Styling in Excel: For Excel files, choose whether to show styling, such as font and row shading, or to show only
the bare data.

Report Viewer
When you run an Advanced Report, Express Report, or CrossTab Report, the output is shown in a paged, interactive format called the
Report Viewer. The viewer shows you the report populated by all of its data. You can page through the data and search for specific items.
You can also make some additional adjustments to the report, such as styling cells or changing column sorts.
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The interactive Report Viewer

To run a report in the Report Viewer:

If you are in the Report Designer, click Run on the toolbar.
Tip

Depending on system configuration, the Run button also saves the report.

If you are in the folder tree, click the Run  icon, or click the Menu  icon and select  Run Report.

The Report Viewer opens in a new tab, indicated by the viewer  icon. This tab represents an instance of the report output as you have
just run it. If you go back and edit the report, you need to run it again to see the changes. This will open another viewer tab, and you can
go back and close the old one.

Page through the report by using the navigation icons    . Search through the report output by typing into the Find field.

If you want to save the output, you can export from the Report Viewer to a PDF, RTF, CSV, or Excel file.

 Truncated results displayed

This icon and message indicates that the report has only returned a partial data set. There are fewer detail rows than the full set, and
aggregate formulas and visualizations apply only to the data that was returned to the report.

To get more data, click the icon and select either:

Generate +number to get the next number of data rows and add them to the existing report.
Generate All to get the full data set.

Report Viewer: Interacting with Reports
There are a number of ways to interact with reports in the Report Viewer. Available options depend on how the report was designed and
the type of content in it.

Tip

If the environment has Action Events, there may be more interactive features than are listed in this article.

Drilling Into Data
Some reports allow you to drilldown into cells or charts to see additional data related to the field selected. If a cell or chart has a
drilldown, you can click on one of the values to drill down into the related data.

Drilldowns are actually other reports that you can interact with or even export to a file. Drilldowns may even have drilldowns of their own!
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Drilling down from a column chart (top) and from a cell (bottom)

Expanding Hidden Data
Some reports have hidden data that can be seen by expanding certain rows. Expandable rows are indicated by an arrow icon . Click on
the icon to expand the row. Click the icon again to collapse it. Right-click the icon to open a menu to do the following:

Expand / Collapse — expand or collapse the outer group
Expand / Collapse Group — expand or collapse the group and any inner groups
Expand / Collapse All — expand or collapse all outer and inner groups on the report

 
Expanding a data row

Visualization Features
Visualizations have a number of interactive features depending on the type of chart. For example, line charts and bar charts allow you to
hide series, multi-axis charts allow you to turn axes on or off, and pie charts allow you to rotate the chart and pull out slices. Charts can
also show some additional information if you hover over a point or series.

Toggling a chart series on or off

Drillingdown on Google Maps
On a Google Map, use the mouse wheel or click the Zoom in  and Zoom out  icons to change your view level. Drag the map to move
the view in that direction. Double-click on a highlighted region to drill down into the location data.

On a GeoChart, click on a highlighted region to drill down into the region. Click [Back] to return to the previous view.

Report Viewer: Customizing report output
In the Report Viewer you can make changes to the style, formatting, and data of the report. These changes can be saved to the original
report, to a new copy of the report, or as a user report, by clicking the Save changes icon.

Caution

If you make any changes, you must save them before closing the Report Viewer or you will lose them.
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What is a user report?

A user report is a customized version of a report that is specific to you. User report changes are saved separately from the report design,
and will only show when you run the report yourself. These can be useful if you want to make changes to a locked report.

Note about cookies

User reports may be stored as browser cookies. Ask your administrator whether this is the case. If so, then user report changes will only
apply to your current computer and web browser. Clearing your browser cookies will remove any user report customizations that you
have made.

Styling Data Cells
Right-click a cell to open the style menu. Using this menu you can set custom styling for the following: Font, Size, Color, Background
color, Text decoration, Alignment, Word wrap. Styling applies to all cells of the same type in the group; affected cells are outlined by a
yellow band.

Right-clicking a cell to change its styling

For group cells with dynamic data from fields or formulas, use the Conditional Filter list to apply styling to only the cells that meet a certain
condition. For each of the following options, styling applies to the cells of the same type in the group that meet the specified condition:

Tip

Select a condition before selecting the styling.

Apply to all — All cells
Apply to equal values — All cells with the same value as the selected cell
Apply to unequal values — All cells with different values than the selected cell
Apply to greater values — All cells with values greater than the selected cell (larger number, later date, or alphabetically
subsequent)
Apply to greater than or equal values — All cells with values greater than or equal to the selected cell
Apply to lesser values — All cells with values less than the selected cell (smaller number, earlier date, or alphabetically
preceding)
Apply to less than or equal values — All cells with values less than or equal to the selected cell

Styling Charts
Right-click a chart to open the chart menu. Using this menu you can swap to a different Type of chart, change the color Theme, change
the location of the Legend, and change the Sort order of the data series.

Right-clicking a chart to change its type

Managing Data Columns
Each column on the report has a light gray control box at the top of the page. Change the width of the columns by dragging the control left
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or right. Sort by a column by clicking the control. To hide a column, right-click the control and select  Hide Column from the list.

 

Resizing a column and right clicking a column to hide it

Setting interactive sorts and filters

Reports can have some additional filters and sorts saved on top of the base report. Click the splitter  icon to open the sidebar to manage
interactive sorts and filters.

Filterable fields can be narrowed down to select values or to a range of values. If a data field is not available to filter, click the Add Item 
icon to add a filter for that field. To remove a filter, click the Delete Item  icon.

The order of sorted fields can be swapped between ascending  and descending .

You can also add conditional filters to hide rows where the cells do not meet a certain condition. To do so, right-click a cell to open the
style menu, select a condition from the list, then click the Edit Filter  icon. Conditional filters are shown in the sidebar.

Adding a conditional filter

Report Wizard
The New Report Wizard opens at the start of each new Express Report, Advanced Report, or Crosstab Report. The wizard lets you add
and configure data, and lets you quickly set a layout for your report before you dive into the full designer.

The Express Report Wizard Layout page

What are Express Reports?

This report type is made entirely using the Report Wizard. If you do not need the additional capabilities of the advanced Report Designer,
Express Reports are an easy way to design tabular reports. To open an Express Report in the Advanced Designer, you need to convert it
to an Advanced Report.

Using the Report Wizard

The Report Wizard has several pages, which you should progress through from left to right. The following articles detail how to use each
page in the wizard.

Name • Categories • Sorts • Filters • Layout • Options
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Tip: Only Express Reports have an Options page. Crosstab Reports do not have a Sorts page. The Layout page differs slightly for each
report type. The Name and Categories pages are mandatory. If a page is not available, your administrator may have disabled it.

Report Wizard: Name
Enter a name for the report and select a folder where it will be stored. Choose a unique, descriptive name that is easy to remember. If you
are in a shared environment, you may want to put your name in the name of the report.

Caution

You cannot save a report in a read-only  folder. A report name cannot contain the following characters: \ / : * ? " < > |

This page must be completed before moving on, but you can always go back later and rename or relocate the report.

Description

This is an optional field, which allows you to give some additional information about the report.

Filter description

You may see an additional field for entering a description for the report filters. If you intend to add user prompting filters to this report, then
you can enter some information in this field that a user will be able to see when entering filter values.

Report Wizard: Categories
Select which data to use on the report. The left pane shows the data categories you can access. To see the fields in a category, select it,
then click the View Category Fields  icon.

What are data categories?
Data categories are tables of data, which are organized by rows and columns. Columns are also known as data fields. A row of data has
entries for one or more columns in the category. When you add a data field onto a report you are seeing the information in one column of
data for every row in the category.

For example, a data category for Employees could have columns for the first and last names of each employee, an identification number,
and a home phone number. Each row represents a person, and each column contains a specific type of information such as Last Name or
Phone Number.

Example of a data category for employee records

You add entire categories at a time to a report, but in the report view you select only the columns you want to see. When you add a data
field to the report design, even though you only see one column, the rest of the table is still present behind the scenes. You will never lose
the connections between items in each row, and you can always add more fields.

Adding Categories
On the Categories page, add data categories to the report. Later on, you can select which fields you actually want to see in the report
layout.

Dragging a category to the Category Name pane

Tip

As you add categories, unrelated categories will become unavailable.

SQL Categories (Advanced Users) v2018.1+
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You may have the ability to define a custom data model for the report without needing to use the predefined data categories. For
databases which support unique or unusual behaviors that are not supported in the main interface, you can use custom SQL to
supplement or bypass the standard Categories, Sorts, Filters, and Joins. Only new reports, created with the Report Wizard, can have a
custom SQL category. You cannot add a custom SQL category to an existing report.

Caution

Writing custom SQL requires knowledge of the underlying databases and their relevant SQL query language. It is only recommended for
advanced users.

To add a custom SQL data category, click  Add SQL. From the Custom SQL Object window, add the following:

1. Object Name - Unique name for the custom category. It cannot be the same as an existing category. It cannot contain white
space or the following characters:[ ] { } . , @

2. Data Source - Select the data source to retrieve the data from.
Not every data source you can access may support custom SQL categories.

3. Enter the full SQL statement in the code window. Note that this will be inserted into a subquery when it is sent to the database for
processing.

Optional: Parameters are system variables that contain different values depending on factors such as the person running the
report. To include parameters in the SQL statement, select them from the Parameters list then click Add. Or enter the parameter
name surrounded by At Signs (@).

Tip

A custom SQL category can only be the sole category on a report. A report cannot contain multiple custom SQL categories, or a
mix of custom SQL and standard categories. Therefore, to include multiple tables on a report with custom SQL, you must retrieve
multiple tables and join them in the SQL statement. If field names conflict, you can alias them in the SQL statement, or else the
application will append a number to the end to preserve uniqueness.

Click the Test  icon to check if the SQL is valid.

4. When you have finished writing the SQL, click the Unique Key Fields list and select the unique keys for the category.
5. Click Okay when done. If you have already sorted and filtered in the SQL statement, you can skip these menus.

Once added, you can edit the SQL category by clicking the SQL icon  next to its name in the Categories window.

Report Wizard: Sorts
Sorting is the process of ordering your data rows by a certain sequence. For each available data category, you can choose which data field
should be used to sort the rows. Fields can be sorted in ascending or descending direction. The way in which rows are sorted depends on
the type of value in the field:

Numeric

 Asc  Lower values     Higher values  Desc 

Date

 Asc  Past     Future Desc 

Text

 Asc  A     Z Desc 

 

Sorting Employees by the Department field, ascending

A report can have multiple sorts. This can be useful when you want your highest precedence sort to affect a data field where the values for
multiple rows may be the same.

For example, imagine a large company with many employees. There could be multiple people with the last name Buchanan. With only a
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sort on LastName, you do not know how all the people with the last name Buchanan will be ordered amongst themselves. If this matters,
then you can add a second sort on, say, the FirstName field, so that people with the same last names will be ordered by their first names.

Adding sorts

On the Sorts page, add data fields to sort. The precedence of the sorts starts with the highest row and moves down the list. Drag the rows
up or down to change the precedence.

Dragging a field to the Sort By pane

Tip: Sorts are not applicable for Crosstab Reports.

Report Wizard: Options
The Options page is available for Express Reports. For information about the available options, see General Options.

Converting to an Advanced Report
Express Reports can be used as a starting point to quickly design a report, before delving into some of the more Advanced Reporting
capabilities. To edit an Express Report in the Report Designer you need to convert it to an Advanced Report. The data and design of the
report are preserved and it gains some additional capabilities, but it can no longer be edited in the Report Wizard.

To convert an Express Report to an Advanced Report:

1. In the Options page, click the Advanced tab.
2. Click Convert Express Report to an Advanced Report.

Advanced Reports: Report Designer
The Report Designer is the main editor for Advanced and CrossTab Reports. At your fingertips is a full suite of reporting and design
tools with an interface that is familiar and easy to understand.

The Advanced Report Designer

Cells
The Report Designer interface is based on cells, like a spreadsheet. Cells can contain text, images, charts, widgets, and formulas. More
importantly, cells can contain multiple rows of data. A cell in a Detail section will expand into as many rows as are needed to show all the
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data. A cell in a Group section will repeat for every group. And a cell in a Page section will repeat for every page on the report.

 
A Detail cell repeats for every row in the "Employees" data category

All of this is dynamic, meaning that the report will adapt its look based on the data that is returned form the source. For more information
on the different types of report cells, see Sections.

Toolbar
You can add a variety of content and styling to your report. Most of the features can be accessed by clicking the relevant icon in the
toolbar. See the Toolbar article for all of the available features.

Advanced Reports: Categories
Use the Categories window to select which data to use on the report. The left pane shows the data categories you can access. To see
the fields in a category, select it and click the View Category Fields  icon.

If the report has a custom SQL category then it cannot have any other categories. You can click the SQL  icon to edit the SQL
statement. See SQL Categories for more information.

What are Data Categories?
Data Categories are tables of data, which are organized by rows and columns. Columns are also known as data fields. A row of data
has entries for one or more columns in the category. When you add a data field onto a report you are seeing the information in one column
of data for every row in the category.

For example, a data category for Employees could have columns for the first and last names of each employee, an identification number,
and a home phone number. Each row represents a person, and each column contains a specific type of information such as last name or
phone number.

Example of a data category for employee records

You add entire categories at a time to a report, but in the report view you select only the columns you want to see. When you add a data
field to the report design, even though you only see one column, the rest of the table is still present behind the scenes. You will never lose
the connections between items in each row, and you can always add more fields.

Dragging a category to the Category Name pane

Relationships Between Categories

Note

This information is intended for advanced users.

In the data source, data categories are joined to other categories by associating uniquely identifying data fields from one category to
matching data fields in another. This means that if a row's identifying field matches one or more rows in a joined category, then those rows
connect to an entire row or group of rows, which have their own separate data fields.

Only joined data categories, which are described as having a relation, can be added to the same report. This is why some categories
may become unavailable as you add others. But data categories, even if they are not related to each other, may both be related to another
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category. If you add that category, then you can add both those categories, because there is now a join path between them.

For more information on how categories are related to each other, see Joins.

Suppressing Duplicates

Note

This information is intended for advanced users.

Be judicious when adding data categories. If you find that your report has unexpected duplicate values or empty rows, the cause is most
likely that you have a one-to-many join to a category that you are not using.

For example, this report has Employees and Orders categories. There is a one-to-many join from Employees to Orders, indicating that
each Employee row is joined to one or more Order rows. Even though we are not using Orders on the report design, there are duplicate
Employees because our join setup causes us to have a row for each Order, instead of each Employee.

 
Unexpected duplicate Employee values

There are several ways to eliminate these duplicates. You can suppress duplicates for the Employees category, which will show blank
rows for consecutive duplicates. In the Categories window, select the Suppress Duplicates check box for the Employees category.

Duplicate-suppressed category

You can also suppress duplicates for the cell, which will hide unnecessary duplicate rows. Select the cell and click the Suppress
Duplicates  icon. If a field from Orders is on the report, the behavior will be the same as suppressing duplicates for the category.

Duplicate-suppressed cell

Or, if you do not think you will need the Orders category, remove it from the report. In the Categories window, click the Delete Category 
  icon next to Orders to remove the category. You can always add it again later if needed.

Advanced Reports: Sorts
Sorting is the process of ordering data rows by a certain sequence. For each available data category, you can choose which data field
should be used to sort the rows. Fields can be sorted in ascending or descending order. The way in which rows are sorted depends on the
type of value in the field:

Numeric
Ascending  Lower values     Higher values   Descending

Date
Ascending  Past     Future  Descending

Text
Ascending  A     Z  Descending
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Sorting a category by Department

A report can have multiple sorts. This can be useful when you want your highest precedence sort to affect a data field where the values for
multiple rows may be the same.

For example, imagine a large company with many employees. There could be multiple people with the last name Buchanan. With only a
sort on LastName, you do not know how all the people with the last name Buchanan will be ordered amongst themselves. If this matters,
then you can add a second sort on, say, the FirstName field, so that people with the same last names will be ordered by their first names.

Adding Sorts
In the Sorts window, add data fields to sort. The precedence of the sorts starts with the highest row and moves down the list. Drag the
rows up or down to change the precedence.

Dragging a field to the Sort By pane

Relationship Between Sorts and Groups
Sorts are a prerequisite for making Groups. Sorting puts data in order so that data rows which share common values for the sort field are
next to each other. This is essentially what grouping does as well. Grouping simply takes those common values, pulls them out of the
rows, and makes Sections for each group of rows which share that value. Sorts tell the report how you want to your data to be grouped.

 
Grouping a category by the Department sort

Tip: Set the sort precedence so that nested groups are in order of their grouping level. The outermost group should have the highest
precedence, with the next levels following in order. If the precedence is set incorrectly, it could result in inconsistent data groups.

Sort Formulas

Note: This information is intended for advanced users.

You can sort by a formula instead of a data field. This allows you to have finer and more specific control over your groups.

If you do not have a single data field as a unique key, you can use a sort formula to sort on a concatenation of two fields instead. For
example, EmployeeId plus TerritoryId fields:

={EmployeeTerritories.EmployeeId} & {EmployeeTerritories.TerritoryId}

Or if your sort field would generate too many groups, you can sort on a piece of the field instead. For example, you could group on only the
month and year component of a date field.

=Date(Year({Employees.HireDate}),Month({Employees.HireDate}),1)

To add a sort formula, click  Add Formula, then use the Formula Editor to make a composite field to sort on.

Filters
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Sometimes you may only want to see a portion of the rows in a data category, rather than its entirety. Filters allow you to narrow the
scope of your reports by restricting the amount of data by specified criteria.

For example, imagine a category containing a row for every single sale your company has ever made. You can use a filter to limit the
report to only sales from the past month. This also has the benefit of speeding up your reports.

There are three types of filters available in the Filters window:

Standard
Group Min/Max
Top/Bottom

This article covers Standard Filters, refer to the respective articles for Group Min/Max and Top/Bottom filters.

Standard Filters
Standard filters limit data by only showing rows where the values for a field meet a certain condition.

Adding Standard Filters
In the Filters window, add Data Fields to filter.

Dragging a field to the Filter By pane

For each data field, select a condition. When the report is run, the field value for each row is checked against the condition for that field.
Only the rows where the field satisfies the condition will show on the report.

To create a filter condition:

1. Select an operator from one of the following options. This is the condition used to match the data values to your specified filter
value or values. Some operators are only available for some data types.

The following table describes the filter operators and their applicable data types:

Condition Type Filter Values Matching Values Not-Matching Values

Equal To (=) Any July 4, 2016 July 4, 2016
July 4, 2016 12:00 AM

July 4
July 4, 2016 2:00 PM

Not Equal To (!=) Any July 4, 2015 July 4
July 4, 2016 2:00 PM

July 4, 2016
July 4, 2016 12:00 AM

Less Than (<) Number, Date/Time July 4, 2016 July 3, 2016 July 5, 2016

Less Than or Equal To (<=) Number, Date/Time July 4, 2016 July 3, 2016
July 4, 2016 July 5, 2016

Greater Than (>) Number, Date/Time July 4, 2016 July 5, 2016
July 4, 2016 5:00 PM July 3, 2016

Greater Than or Equal To (>=) Number, Date/Time July 4, 2016
July 4, 2016
July 5, 2016
July 4, 2016 5:00 PM

July 3, 2016

Starts With Text, Number 203 2035550224 8458081120

Not Starts With Text, Number 203 8458081120 2035550224

Ends With Text, Number 224 2035550224 7188044606

Does Not End With Text, Number 224 7188044606 2035550224

Contains Text, Number 555 2035550224 2038081120

Does Not Contain Text, Number 555 2038081120 2035550224

Is Between Any 1, 4 1, 1.5, 3, 4 0.999, 5

Is Not Between Any 1, 4 0.999, 5 1, 1.5, 3, 4

Is One Of Any 1, 2, 3, 4 1, 2, 3, 4 1.1, 9

Is Not One Of Any 1, 2, 3, 4 1.1, 9 1, 2, 3, 4

Note

The Is Between operator is inclusive. Values should be in least to greatest order.

2. Enter a filter value or values, or select them from the list of existing values. Type into the filter field to search for data values to filter.

Click the Settings icon to select whether to search for values that either Start With or Contain the typed text (v2017.3+).
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Choosing a filter value

3. Optional: If you have multiple filters, you can choose how they should be grouped. See Grouping Filters Together for more
information.

4. Optional: If you want the report to prompt the user to enter a filter value when the report is run, check the Prompt For Value
checkbox.

Prompting for Values
If you want to let users select their own filter values when they run the report, you can set filters to Prompt For Value. In the Report
Options, you can choose whether to let users change the operators and delete filters.

You do not need to enter a value for prompting filters. But if you do, it is entered as the default value for the filter in the prompt dialog.

Formula Filters v2018.2+
Formulas may be used in the filter data field, allowing for much more powerful filter statements.

Previously filter statements would be limited to statements containing one Data Object. Consider the following example using data
categories from the sample Northwind data set, which compares the OrderDate against a single date.

{Orders.OrderDate} > 01/01/2015

Now, Data Objects may be used in a formula when doing a filter operation. For example, calculating the revenue of an order line item by
multiplying {OrderDetails.Quanity} by {OrderDetails.UnitPrice} and then applying a filter to select only those line items
whose revenue is greater than $300.

{OrderDetails.Quantity}*{OrderDetails.UnitPrice} > 300

Advanced Report Designer
In the Advanced Report Designer, formula filters are available in the Filters tab. Clicking the  Add Formula button in the lower left will
open a Formula Editor window, which will allow for the creation of a formula to use within the filter.

Tip

Refer to Formulas section for details about creating and editing formulas and using the Formula Editor.

Report Filters window in Advanced Report Designer with the Add Formula button

ExpressView
In the ExpressView Designer, adding a formula filter requires that the formula exist as a column on the ExpressView.
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Important

Any objects needed for a formula in an ExpressView must also exist as their own column on the report as well.

Add Formula button in the ExpressView Designer

Once the formula is created as a column, select the Filters pane and drag the formula column over to the Filters pane to begin creating a
filter on the formula. For more information about building formulas in an ExpressView, see the article on Formulas in ExpressViews.

Note

Certain functions are available in the Formula Editor that are not compatible with the context of formula filters, such as CellValue(),
FilterValue(), Hyperlink, LoadImage() and PageNumber().

Grouping Filters Together
When a data row is checked against the report filters, the values for each of its data fields are checked against all of the filters for the data
fields. By default, it must satisfy every filter condition to show on the report. The combined statement used to filter the data rows is shown
in the Summary field.

Example of a combined filter statement

You can specify that a data row needs only to satisfy one filter, or a selection of filters, to show on the report.

To specify that a data row needs to satisfy any one of several filters:

1. On the Filters page, drag the filter rows next to each other.
2. Select the first filter.
3. Select OR With Next Filter.

You should notice that in the Summary field, the And between this filter and the next has changed to Or.
4. Repeat steps 2-3 for every filter except the last.

You can group filters together, to specify that a data row can match either one group of filters, or another group of filters, to show on the
report.

To specify that a data row needs to satisfy any one of several groups of filters:

1. On the Filters page, drag the filter rows such that the filters are nearest to their group mates.

2. Select the first filter in the first group.

3. Select Group With Next Filter.
You should notice that in the Summary field, there are now parentheses around this filter and the next.

4. Repeat steps 2-3 for every filter except the last in the first group.
5. Select the last filter in the first group.
6. Select OR With Next Filter.

You should notice that in the Summary field, the And between this filter and the next has changed to Or.

7. Repeat steps 2-6 for every group of filters. Skip step 6 for the last filter in the last group.
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Nesting Filter Groups
Filter groups can be nested arbitrarily. This allows for more detailed control over grouping. The Summary field shows the actual statement
used to filter the data. You can make arbitrary groupings by inserting parentheses manually at locations in the statement. Use the
following keyboard shortcuts:

Ctrl + [ to add an opening parenthesis before the selected filter
Ctrl + ] to add a closing parenthesis after the selected filter
Ctrl + Shift + [ to remove an opening parenthesis from before the selected filter
Ctrl + Shift + ] to remove a closing parenthesis from after the selected filter

Group Min/Max Filters
When assigning filters to an Advanced Report from the Report Designer, users have the option of assigning Group Min/Max filters to
the report. Group Min/Max filters will cause the report output to display detail containing either the highest or lowest values in a field for
either one group, multiple groups, or an entire data set.

Note: These operate differently from the Min() and Max() functions, which are used to manipulate specific data fields as part of formulas.

This tool is especially useful if you are only interested in viewing the highest or lowest values, such as the most recent hire date or highest
revenue figure, in a given set. Group Min/Max filters are compatible with standard filters, and there is no limit to the number of group filters
you may define.

To access Group Min/Max filters, navigate to the Filters menu from the Report Designer Settings menu and click the Group Min/Max
tab in the upper right-hand corner of the menu.

 

To filter a Data Field’s minimum or maximum value, either drag and drop the field to the Filter By panel, use the Add button, or
double-click the field.
Specify Minimum or Maximum from the operator dropdown.
Use the Move Item Up  and Move Item Down  icons to change the filter priority.
To remove a filter, click the Delete  icon.
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Applying Group Min/Max Filters
We will explore the several ways of applying this type of filter using the below sample report.

With no Group Min/Max filtering, this report executes to the following:

Note: The following features are available only in v2016.2+.

Ignoring Other Groupings
To apply the filter to one group only, select a group from the dropdown menu and check the Ignore other groupings on report checkbox.

To best utilize this option, it is important to understand the difference between an inner group and an outer group. In the report designer,
the topmost group (in this case, Orders.EmployeeID) is the outermost group and has first priority. The second group (in this case,
Orders.CustomerID) is within the first and has second priority. Each subsequent group is nested into the previous one and grouped after
the others.

If applying a Group Min/Max filter to an outer group, then checking the Ignore other groupings checkbox has no effect on the report output
because the outermost group takes precedence anyway. If applying a Group Min/Max filter to an inner group, however, the button takes
effect.
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In our example, both Buchanan and King have sold to customer BONAP. If we apply a maximum filter on order quantity for each Customer
ID and leave the Ignore other groupings checkbox unchecked, the output shows the detail containing each customer's max quantity sale
per employee.

Checking the Ignore other groupings checkbox, however, returns the customer's max quantity sale for the whole report, ignoring the
grouping on Employee.

Due to the fact that BONAP's order of Spegesild from King is greater than its order of Pavolova from Buchanan, BONAP appears only once
on the report. If BONAP had ordered the same quantity from both Buchanan and King, it would appear under both names, even with the
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Ignore other groupings checkbox checked.

Filtering the Entire Data Set
Selecting Entire Data Set from the group dropdown menu will disable the Ignore other groupings option and return the records
containing the single maximum value for the selected field in the entire report.

In our example, selecting this option displays only BLONP's order from Buchanan because its quantity is the highest in the set.

Top/Bottom Filters
As of v2017.1+, you can add Top/Bottom filters, also known as Top N filters, to a report. Top N filters allow you to filter data to only the
rows with the top or bottom values, for either data fields or data summaries, per group iteration.

Top/Bottom tab of the Filters page

To show only the top or bottom values, for either data fields or data summaries:

1. On the Filters page, click the Top/Bottom tab.
2. Check the Limit the report to the top/bottom values checkbox.
3. Select either Top or Bottom, for whether you want to show the top or bottom values.

4. Enter a number for how many values you want to show.

5. Choose how you want to limit your data:
If you want to show the rows with the top or bottom data values for a field or group, select Values from the list.
If you want to show the groups with the top or bottom summary values for a parent group or the report, select one of the
summary calculations, Sum, Avg, Min, Max, Count, or Distinct Count, from the list.

Note: Only numeric data fields support Sum and Avg calculations.
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6. Select the data field or group field to filter from the Value list.

Advanced Reports: Report Options
The following options are available in the General Options dialog:

Report Options dialog

General Options
Allow Execution in Viewer: Allow or prevent the report from being run in the Report Viewer. If set to False, this report must be
exported to be viewed.
Include Setup Info: Select Top or Bottom to display the data categories, sorts, and filters at either the beginning (Top) or end
(Bottom) of the report. Select None to not show this information on the report.
Allowed Export Types: Enable or disable output types for the report.
Default Export Type: Specify the default output type for the report. If Default the export type is determined by the system's
configuration. This setting is used when exporting a report directly from the Report Tree, for example.

Report Tree Shortcut: Specify whether the Run  icon for the report in the report tree runs the report in the Report Viewer or
exports it in the default export type.
Filter Execution Window: Select which type of Filter menu displays when running the report with prompting filters:

Default: The type of filter window is determined by the system's configuration.
Standard: Display the standard filter window.

Simple with Operator: Display a simplified filter window that only allows the filter operator and value to be changed.
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Simple without Operator: Display a simplified filter window that only allows the filter value to be changed.

Always Show Filters in Report Viewer: Show the Filter menu and allow changes to be made to the filters every time the report is
run, even if there are no Prompting Filters on the report.
No Data Qualify Display Mode: Select what to display if no data qualifies for the report.

Show Message: Display the standard no data qualified message in a dialog box.
Show Report: Display the Page Header, Page Footer, Report Header, and Report Footer sections of the report. Any cells
containing Data Fields will not be displayed.

Excel Options
Suppress Formatting: Check the checkbox to only include the data in an Excel export, without the formatting.
Show Grid: Check the checkbox to show grid lines between cells in an Excel export.
Freeze Rows: Freeze the top number of rows when exporting to Excel, so that the rows stay anchored to the screen when
scrolling through the report.
Freeze Columns: Freeze the left number of columns when exporting to Excel, so that the columns stay anchored to the screen
when scrolling through the report.

Page Options
Page Size: Select the page size of the report output.
Page Orientation: Specify whether the report runs in Portrait or Landscape orientation.
Fit to Page Width: Check the checkbox to force the report to fit to the width of the page.

Report Viewer Options
The following options are available in the Report Viewer Options window:

General

Show Grid: Check the checkbox to show grid-lines between cells in the Report Viewer.
Simulate PDF: Check the checkbox to have the report appear as if it were on a PDF page when viewed. When unchecked, the
report still is paginated but does not have the formatting of a PDF exported report.
Allow Hide/Show Columns in Report Viewer: Check the checkbox if the ability to show or hide individual columns is available in
the Report Viewer. If checked, headers will appear at the top of the page. When right-clicked, users will have the ability to hide or
un-hide columns. If unchecked, the headers are not present and the columns may not be changed.
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Note

Setting the Enable Paging in Report Viewer setting in the Admin Console to False restricts the interactive HTML hide/show
column option.

Show Toolbar in Report Viewer: Select whether to show or hide the interactive toolbar in the Report Viewer.

Default: the toolbar will be displayed based on the system's configuration
Auto: the toolbar will be hidden if the Report Footer appears on the first page. Otherwise, the toolbar will be shown.
Show: always show the toolbar
Hide: always hide the toolbar

Report Row Step Limit: Override the default step size for incremental loading (with a smaller value). This option is only available if
Incremental Loading is enabled in your environment.

Filters

Filters tab of the Report Viewer options dialog

To allow users to select additional interactive filters in the Report Viewer, add data fields as filters. These filters are accessed by clicking

on the Open Interactive Features  icon on the left hand side of the screen in the Report Viewer.

Interactive Features pane opened in the Report Viewer showing a Product Name filter, adding a Category filter and Sorts

For each filter you can select the following options:

Title: Enter text to appear in place of the data field name.
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Type: Specify the type of ability the user has to choose filter values:
Single Choice: A dropdown menu with all possible filter values. Users can choose one value.
Multiple Choice: A check list with all possible filter values. Users can choose multiple values.
Single Slider: Users can choose one value by sliding a point along a scale.
Range Slider: Users can choose multiple values between two points on a scale.

Value Sort Direction: Whether the filter values should display in ascending or descending order.
Filter Value Format: Select how the filter values should display. The controls here work similar to the Cell Formatting controls.
Initially Display Filter on Panel: Check the checkbox if the filter should appear automatically when the report is run. If
unchecked, the user will need to add the filter each time the report is run.

Sorts

Sorts tab of Report Viewer options dialog showing two Category sorts

To allow users to change existing sorts from ascending or descending in the Report Viewer. These sorts are accessed by clicking on

the Open Interactive Features  icon on the left hand side of the screen in the Report Viewer.

Display Sorts in Report Viewer: Select whether the user can see and modify sorts in the Report Viewer.
Title: Enter a user-friendly name for the sorting category which will be displayed in the Report Viewer.

Advanced Reports: Templates
You can use an Advanced Report to dynamically fill out fields in Templates and forms.

  
Template report with repeating data fills a set of form templates

To use a report to fill out a template:
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Editing of fields in exported PDF templates

1. Enter field data in cells on the report. For repeating data:
Repeating cells mapped to static template fields make a new instance of the template for each repeat.
Repeating cells mapped to limited-repeating template fields make a new instance of the template each time the number of
values exceeds the limit.
Note: This is often undesirable. Ensure that there are appropriate constraints on your data and enough fields to fit it all.
Repeating cells mapped to unlimited-repeating template fields never make a new instance of the template. Overflowing data
is cut off.

2. On the toolbar Settings menu, select  Template to open the Report Templates dialog. Select an existing template or click
the Upload button to upload a new one.

3. For each template field:
Select a report cell containing text or data. Images, visualizations, and other widgets are not supported.
Leave it blank. Any bookmarked text shows as-is in the output.
Select whether or not to allow editing of that field in the exported PDF file using the Allow Edit checkbox.

4. Click OK.

To remove a template from a report:

1. From the Template dialog, select the blank option from the template list.
2. Click OK.

Tip: Template reports must be exported in the same file type as the template. Review the General Section of the Report Options article
for details on how to control report export types.

Making Templates
The process for making templates differs between the three supported types: PDF, Word, and Excel; as do the available features.

Caution: Close the template file before running or saving a report that uses it.

PDF Templates
PDF templates support static fields and limited-repeating fields. PDFs are convenient for preexisting and standardized forms, such as for
government or businesses.

To make a PDF template:

1. Open a PDF in a PDF editor program, such as Adobe Acrobat or PDFescape.
2. Add form fields where you will insert report data. For fields where text may span multiple lines, select the multi-line property.
3. Give each form field a unique name, as follows:

For static fields, which appear only once per template instance, use any name, with the exception of the format reserved for
repeating fields.
For repeating fields, which are mapped to consecutive values in a repeating cell, use the following naming format: Name.0,
Name.1,...
Where Name is shared by the repeating fields, and 0 maps to the first value, 1 maps to the next value, and so on.

4. Save the PDF. Then upload it to the report.

Microsoft Word Templates
Word templates support static fields, limited and unlimited-repeating fields, and conditional suppression.

Tip: Supported file types are .doc, .docx, and .rtf. Report templates exported as "RTF" will save to the original file type.

To make a Word template:
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1. Open a document in Microsoft Word or a compatible document editor.
2. Add text where you want to insert report data.
3. Select the text, or in the case of repeating fields, a region of text, and insert a bookmark.

Employee Information example showing that Bookmarks in Word display as grey brackets surrounding text

4. Give each bookmark a unique name, as follows:
For static fields, which appear only once per template instance, use any name, with the exception of the formats reserved for
repeating and conditional fields.
For limited-repeating fields, which are mapped to consecutive values in a repeating cell, use the following naming format:
FieldName_0, FieldName_1, ... Where Name is shared by the repeating fields, and 0 maps to the first value, 1
maps to the next value, and so on.
For unlimited-repeating fields, which are mapped to all the values in a repeating cell, use the following naming format:
RepeatForEach_FieldName Where FieldName is a unique name. A RepeatForEach section in templating follows
similar structure and purpose to grouping within reports. It is used to organize information under repeating groups within
templates, arranging related information on the same page and separating groups with page breaks.

Important: Bookmark formatting for unlimited-repeating fields must follow specific spacing requirements. The opening bookmark
bracket should be placed one line before the repeating field section begins, and the closing bookmark bracket should be placed
one line after the repeating field sections ends. Please refer to the Employee Information example above for a visual reference. If
this formatting is not followed, an "itemStart and itemEnd must be contained in one text body" error may be thrown.

5. Optional: To conditionally show or hide text:
1. Select the text and add a bookmark with the following naming format: KeepIF_FieldName Where FieldName is a unique

name.
2. In the report, map this field to a cell with a formula that returns 1 if the text should be shown, and 0 if the text should be

hidden. Example:

=If({Products.ProductName} = "Chai", 1, 0)

6. Save and close the file. Then upload it to the report.

Microsoft Excel Templates
Excel templates work differently than other types. Templates are used to fill Excel columns with report data. This is useful for passing data
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to Excel charts, pivot tables, and macros.

To make an Excel template:

1. Open an Excel file in Microsoft Excel or a compatible spreadsheet editor.
2. The first worksheet is used for dynamic report data. Repeating cells are mapped to columns in the worksheet. For each column

where you will add report data, enter a unique name to the topmost cell in the column. All following cells must be empty.

Formatting an Excel file to be used as a template

3. Save the file. Then upload it to the report.

Advanced Reports: Joins
Caution

The Joins dialog is recommended for advanced users only.

Joins describe how the Categories on a report are related to each other. When two categories are joined, a field in the first category is
associated with a field in the second category. Wherever a value in the first category's field matches a value in the second category's field,
that value's rows from each category come together to form a composite row. The table produced by all the composite rows is the resulting
data that appears on the report.

For example, take the following categories, Orders and Products. The Orders.ProductId field corresponds with the Products.Id field. When
the categories are joined from Orders.ProductId to Products.Id, the rows are connected wherever those two fields have matching values.

Categories joined on Orders.ProductId >> Products.Id

The result of this join is the following composite rows. These categories have a one-to-one relationship, because each row in the "left"
category joins at most one row in the "right" category.

Joined categories. Products.Id is omitted.

Tip

Categories could be joined along more than one set of fields; composite rows are formed only when all sets have matching values.

For two categories to be co-present on a report, there must be a join path between them. They are either directly joined, or there is a path
through one or more intermediate categories. You do not have to configure joins manually as they already exist in the environment.
However, if you want to learn how to add or adjust joins on a per-report basis, the following sections explain the options that are available.

Join Types
The join that was previously described is the most common type of join, an inner join. When an inner join is applied, rows in either
category that have no matching row in the other are excluded from the resulting table. However, you may not want to exclude these rows.
To do so, you can change the type of join to an outer join.

For example, the row in the Products category with Products.Id = 12 has no matching row in the Orders category. With an inner join, this
row is excluded from the output. If you want to see the Products rows that have no matching Orders row, you can change the join type.

On the toolbar  Settings menu, select Advanced and then  Joins to open the Joins dialog. select the Products data that does not
have Orders data checkbox.
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This changes the join between these categories to a left outer join, because all rows from the left category are included. The following rows
result:

Joined categories with all Products rows. Products.Id is omitted.

Similarly, selecting the Orders data that does not have Products data checkbox changes the join to a right outer join, which includes all
rows from the right category. Selecting both checkboxes includes all rows from both categories; this is a full outer join.

Relationship Types
There are two types of join relationships: one-to-one and one-to-many.

In the previous example, the relationship between the categories is one-to-one, because each row in the left category joins at most one
row in the right category. Some categories have a one-to-many relationship, where each row in the left category joins zero or more rows in
the right category.

A one-to-many relationship from categories X to Y is represented in the following diagram:

Each X is joined to one or more Y

Reports with a single one-to-many join are well suited to grouping by the left category. The data in these reports is generally well-formed
and understandable.

However, when a report has multiple categories with one-to-many joins, data can appear more disorganized and confusing. For example,
the following diagram represents data from three categories, X, Y, and Z, where the relationships between X to Y and X to Z are both one-
to-many:

Each X has 1 or more Y, and 1 or more Z

Because Y and Z are not directly related to each other, there are many rows with only Y or only Z. This can cause the report to be
significantly larger, and to be difficult to read and interpret. This occurs even with inner joins, the most restrictive type, because by default
there is no logic that deals with the relationship between Y and Z.

Read on for different ways of improving the structure of a report with multiple one-to-many joins.

Cartesian Processing
You could fill the blank spaces with supplementary data by disabling Special Cartesian Processing from the Joins dialog. Blank cells

Advanced Reports: Joins User Guide

77 of 152



are filled in with data that is repeated directly from the previous row. The following diagram demonstrates how this works:

Disabling Special Cartesian Processing

The shaded cells represent data that has been repeated from the previous row. This can make the report more readable. However, this
approach poses a problem: Blank cells indicate a lack of a relationship between two fields, so filling in these spaces with artificial data can
obfuscate any relationship between Y and Z. This can decrease the accuracy of the report.

There are better ways to improve the readability of such a report without sacrificing accuracy:

Use repeating groups to show the X to Y and X to Z relationships in entirely separate sections. This is suitable if any relationship
between Y and Z is irrelevant or nonexistent. See Sections for more information.
Hide some or all of the rows which do not have data for both Y and Z. This is suitable if you want to highlight an implicit or indirect
relationship between Y and Z.

Modifying Joins
The Joins dialog shows all direct and implicit joins on the report. Direct joins can be added, modified, or removed from the report.

Create a New Join
1. Select From and To categories.
2. Click  Add.

1. Click  Add Condition then select From (left column) and To (right column) fields.
Tip

If there are multiple conditions, only the rows that satisfy all the conditions are joined.

2. Click Okay
3. Click Okay

To restore the default joins, click the Recreate button, then click Okay.

Delete a Join
To remove conditions, click the Delete  icon next to the condition to delete.

Modify a Join
1. Click the Edit  icon next to the join to edit.
2. Add, remove, or modify conditions.
3. Click Okay.

To remove a join, click the Delete  icon next to the join to delete, then click Okay.

Advanced Joins
You may be able to specify join conditions that are more complex than column equality.

Note: Advanced Joins cannot be applied across different data sources.

Type
Instead of joining between two columns, one or both sides of the join may instead be an arbitrary expression, constant, or SQL sub-query
that you specify.

To change the expression type for one side of a join condition, select one of the following from the Type list:
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Value: One or more constant values separated by commas
Expression: Formula or calculation
SubQuery: SQL query

Then enter the value in the Value field.

Operator
As opposed to the default equality (=) operator, which joins fields from the left expression to matching fields from the right expression, a
join condition can use one of several alternative operators instead. For example, the inequality (!=) operator joins fields on the left to non-
matching fields on the right. To do so, select one of the alternative operators ;from the Operator list:

!= not equal to
> greater than
>= greater than or equal to
< less than
<= less than or equal to equal
IN: match one or more values, either specified or calculated from a subquery

Grouping
When a join has two or more conditions, you can specify how the conditions should be met as a group in order for the join to take effect.

To specify that either one of two conditions will satisfy part of the clause, select OR from the Conjunction list for the first condition of the
two.

To add parentheses around two conditions, select the Group checkbox for the first condition of the two.

You can preview the full join clause in the Summary field.

Advanced Reports: Cell Formatting
The Cell Format Window allows you to customize how data values will display, add custom borders, and add formatting that will only
show if a condition is met. It is broken down into three tabs: Number, Border and Conditional.

Number Tab
If a cell has a numeric, date, or time value, then you can use Number formatting to choose how the value should appear on the report. For
example, you could add a dollar sign ($) to monetary values and separate each three digits to make values easier to read.
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Numeric values with currency styled formatting

The following options for Number formatting are available:

General
Format the data using the default settings for your environment. This is the default option. The application will assume the data type based
on the value. Formatting may be automatically applied based on system configuration.

Number
Format the data as a number, currency, or percentage.

Optional: Choose how the number displays:

In the Decimal Places field, enter a number for how many decimal places to display. Then, in the field to the right, enter a symbol
to use as the decimal mark.
To show a delimiter every three digits, check the Use 1000 Separator checkbox. Then, in the field to the right, enter a symbol to
use as the delimiter.
To show a currency symbol before the number, check the Use Currency Symbol. Then, in the field to the right, enter the symbol
to show.
To show a percent sign (%) after the number, check the Append Percent Sign (%) checkbox.
To show no value if the number is 0, check the Blank When Zero checkbox.
To show a minus sign (-) in front of negative numbers, check the Show Negative Symbol checkbox.
To show parentheses ( ) around negative numbers, check the Show Parenthesis checkbox.
To show negative numbers in a different color, enter a hexadecimal color code in the Color field or use the color picker to choose a
color.

Date
Format the data as a date, time, or date and time.

Optional: Choose which date and time components to display, and how to show them. Either select one of the patterns from the
Date/Time Format list, or enter a custom pattern using the following variables:

Variable Description Result for sample date of
"Sept-2-1907 5:08:04 PM"

d day of the month, from 1 to 31 2

dd day of the month, from 01 to 31 02

ddd day of the week, abbreviated name Mon

dddd day of the week, full name Monday

M month, from 1 to 12 9

MM month, from 01 to 12 09

MMM month, abbreviated name Sept

MMMM month, full name September

y year of the century, from 0 to 99 7

yy year of the century, from 00 to 99 07

yyyy year, from 0001 to 9999 1907

h hour using a 12 hour clock, from 1 to 12 5

hh hour using a 12 hour clock, from 01 to 12 05

H hour using a 24 hour clock, from 0 to 23 17

HH hour using a 24 hour clock, from 00 to 23 17

m minute, from 0 to 59 8

mm minute, from 00 to 59 08

s second, from 0 to 59 4

ss second, from 00 to 59 04

t A/P P

tt AM/PM PM

Text
Does not apply any formatting to the data, and show it exactly as it appears in the database.

Border

Advanced Reports: Cell Formatting User Guide

80 of 152



Alter the width and color of the cell borders. To set a color for a cell border, enter a color code or select a color from the picker. To set the
width of the border, enter a pixel value, or use the arrows to make the border thicker or thinner.

To set all the cell borders to the same color and width, check the Make Borders Fixed checkbox.

Tip

If gridlines are enabled for the Report Viewer, then cell borders will show in addition to the gridlines.

Choosing border colors and widths

Conditional Formatting
A conditional format allows you to format a cell according to its output data. The cell and text styles can depend on its data value, and you
can even conditionally hide rows or entire sections. This can be useful for highlighting certain values in a data set, such as outliers from a
trend.

Conditional Formatting uses a formula to set the condition. The formula must evaluate to True or False. If True, the formatting will be
applied otherwise it will not. Conditional formulas are often based on data in the cell, but they can also be based on other cells, data fields,
or other information about the report.

Example of a formula that evaluates to True or False

To set or modify the format of a cell based on a conditional formula:

Conditional format tab of Format Cells dialog

1. Click Add to create a new condition.
2. From the Action list, select an action to occur if the condition is met. If applicable, select an attribute for the action from the

Attribute list.
Action Attribute

Foreground Color Enter a formula, hexadecimal color code or select a color using the color picker which will
change the foreground (text) color of the chosen cell.

Background Color Enter a formula, hexadecimal color code or select a color using the color picker which will
change the background color of the chosen cell.
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Font Family Select a font to change the text to.

Font Size Enter a font size, in ems, to change the font size to.

Bold no attribute

Italic no attribute

Underline no attribute

Horizontal Alignment Choose from Left, Right, Center or Justify to which the text in the cell will change to.

Vertical Alignment Choose from Top, Middle or Bottom to which the text in the cell will change.

Suppress Row no attribute

Suppress Section no attribute

Page Break no attribute

Tip

Hexadecimal color values may be upper or lowercase and may contain the # prefix character, but it is not required.

3. Click the Formula Editor  icon to enter a formula for the condition. The formula must evaluate to True or False. The Action will
be applied to the report when the formula evaluates to True.

To use the value of the current cell in the formula, use the function CellValue(). Click  Cell Value to insert CellValue()
into the formula.

A cell can have multiple conditional formats, each of which is a separate row in the Conditional tab. If two or more overlap, the lower
condition takes precedence. Click the Move Row Up  and Move Row Down  icons to reorder the precedence of the conditions.

A cell with multiple conditional formats

Using Formulas as Conditional Formatting Colors v2019.2+
As of v2019.2, in addition to selecting a static color with the color selector, a formula may be used to change the colors of a cell when
conditional formatting.

A formula which returns a value convertible to a hexadecimal color code can be entered as the Attribute when the Action is Foreground
Color or Background Color. When using this option, conditional formatting color properties can be determined at runtime instead of report
design time.

One application of this feature is to read color values from a data source and use that color data to apply formatting to a cell.
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Color Selector with Set by Formula button

Clicking on the Color Selector's  Set by Formula button will open the standard Formula Editor. All formula elements available in
conditional formulas are available, including CellValue(), references to other cells, application parameters and Data Objects.
Aggregate functions are not available in attribute formulas.

Tip

Hexadecimal color values may be upper or lowercase and may contain the # prefix character, but it is not required.

If the formula returns null or an empty string, the conditional formatting will not be applied. If the formula returns a value that is not
convertible to a hexadecimal color code, an error message will be displayed in the cell.

Examples

This example uses conditional and logical functions to combine multiple conditions into one clause.

If(And(CellValue()>=1000, CellValue()<10000), "#FFFFFF", If(CellValue()>=10000, "#ECECEC", "#00000"))
  

This example uses an application parameter named ConditionalColor to select a color to apply:

=@ConditionalColor@

This example simply refers to a Data Field that contains a hexadecimal color value to apply:

{Products.ProductColor}

A few examples of valid hexadecimal color codes:

#FFF

#c0c0c0

ff4c00

F90

Advanced Reports: Sections
The sections of an Advanced Report define the appearance and pattern of the report. Specifically, sections determine how frequently
their cell contents are repeated.
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The appearance of a report is based on data that is not necessarily known at the time it is made. The data, and the relationships it
describes, are dynamic. As such, tabular reports are usually not fixed designs. Instead, you are essentially describing how the report
structures itself around a set of unpredictable data. Knowing which sections are suitable for different types of content is crucial for
designing the best possible report.

Types of Sections
There are two general types of sections: Static and Dynamic. The difference is in the repetition of their cells.

The cells in a dynamic section repeat according to the data that is returned to the report. Dynamic sections are suitable for showing
content related to that data. For example, cells in a Detail section repeat for every composite data row in the report. Therefore, it is most
suitable for data fields, of which you will want to see each entry per row.

The cells in a static section do not repeat according to the report data. Static sections are best used for information that is not related to
data rows. For example, you could use a Page Header to define column headers that describe the type of data in each field.

See the following topics, Static and Dynamic, for more information.

Manipulating Sections
A report can contain any variety of sections. To add, remove, or change sections, click a section title, to the left of the row numbers in the
report grid.

The Section menu

To add a section, hover over  Add Section, then choose the section to add. If you add a group section, choose which data category or
field to group by.

To change the category or field for an existing group section, click  Modify Section.

To change the order of sections, click  Move Section Up or  Move Section Down.

To delete a section, click  Delete Section. This will delete every row in the section.

To add alternating background colors for each row in a section, click  Section Shading. See Section Shading below for more
information.

Static Sections
Sections categorized as static do not repeat according to the data in the report; although they may repeat by other means. These
sections are best used for information about the report and about the data in the report. They can also be useful for boilerplate elements,
such as logos, copyright notices or disclaimers.

A typical report may have a report header with the title of the report, a page header with labels for each column, a page footer that
uses the PageNumber() function or @pageNumber@ parameter to number the pages, and a report footer with summary information.

Page Header/Footer
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Position of page sections

Page sections repeat for each page. Page breaks are usually caused when the data in dynamic sections overflows the length of a page.
The length of pages is determined by the Page Size and Orientation lists in the Report General Options window. The data on each
page is consistent between the paged output types.

You can add page breaks manually by clicking the row number to add a break, then selecting Page Break from the menu. Page breaks
added for a row in a dynamic section will make a new page every time the data changes.

Page breaks are indicated by a dashed line on the row number

Tip: Excel and CSV output types have no pages. Page sections function the same as Report sections for these output types.

Use these sections for information to repeat on every page, such as the title of the report, column headers, and company logos. You can
also use the PageNumber() function to number each page of the report.

Even though page sections repeat, they are not considered dynamic sections because their repetition does not directly depend on the
data. Thus they are not suitable for displaying data fields. Since there is no way of knowing ahead of time which data will appear on which
page, these sections are not suitable for summarizing data with aggregates or visualizations.

Report Header/Footer

 
Position of Report Header and Footer sections

Report header and footer sections appear once each. Use these sections for introductory and concluding information.

The report footer is where you would summarize all of the report data with aggregate formulas and visualizations.

Dynamic
Sections categorized as dynamic repeat according to the data in the report. These sections are best used for displaying and grouping data
from data fields. Dynamic sections comprise the bulk of most tabular reports. Charts, maps, and gauges must reference data fields
in dynamic sections.

The key for knowing how to use dynamic sections is knowing how the data will repeat in relation to the rest of the report.

Detail

Position of Detail section
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The rows in the Detail section repeat for each data row retrieved from the database. By default, there are exactly enough Detail rows to
show all the data fields in all the categories on the report.

Detail sections are typically used for showing the actual data values. This is the main area of display for the bare report data. Aggregate
formulas usually reference cells in the Detail section.

You can use duplicate suppression to limit the number of rows to only visible data fields. You can also use report filters to limit the
rows by certain criteria.

Users with advanced knowledge of the data relationships can also use advanced join logic to limit the Detail rows to only the relevant
relationships.

Group Header/Footer

 
Position of Group sections

Group sections are the primary way in which data is grouped into "buckets" that each share a unique attribute. Detail rows are arranged
into the groups they belong to. The common attribute is defined by a preexisting sort. In order to make a group, first add a sort in the Sort
window.

For example, if you wanted to group a set of rows by each Product, first add a sort on the Products.ProductName field.

A sort is required for a group

The main difference between the header and footer is that the data comes after the header, but before the footer.

When you add a group section, you are asked which sort to base the group on. For each sort, you can choose to group on either the
sort field or the sort category.

If you group on a field, the group breaks at each new value of the field.

If you group on a category, the group breaks at each new instance of the category's unique identifier.

The group window appears when adding a group section

For example, instead of grouping by each Product, you may want to instead group by product quantity, so that products that are low or out
of stock are grouped together. First, add a sort on the Products.Quantity field, then group by that field.

You can have multiple group sections, if you wanted to add additional levels of stratification to the report. Each group requires a
corresponding sort.
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Tip: The order of the sorts has an effect on the way the data is arranged. Data is sorted by the first field, then any ambiguities are sorted
by the second field, then any remaining ambiguities are sorted by the third, and so on. In general, you should order group headers by
their associated sorts, and group footers in inverse order.

Repeating Group

 
Position of Repeating Group sections

Repeating groups are a way to organize and display data that contain multiple one-to-many relationships. Each repeating group has
data from "many" category, grouped by the "one" category. The following diagrams demonstrate how this works.

Two categories, X and Y, with a one-to-many relationship from X to Y, will display like so in a Detail section.

Tip: Category X has duplicates suppressed - this is similar to grouping on X.

Each X has 1 or more Y

If there is a third category, Z, with a one-to-many relationship from X to Z, there is not necessarily a relationship between Y and Z. So there
may be blank rows with only Y or only Z.

Each X has 1 or more Y, and 1 or more Z

There are two potential solutions. If there is a relationship between Y and Z, then you can use Advanced Joins to impose additional
constraints so that only the rows with both Y and Z are shown. For more information, see Joins.

On the other hand, there may be no relationship between Y and Z, only between X and Y, X and Z. Or there may be a relationship, but it
does not matter for this data set. You can use repeating groups to ignore that relationship and simply organize the data by X instead.

To do so, create two repeating groups for X, and put Y in the first, and Z in the second:

Organizing Y and Z into repeating groups for X
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Each X repeats twice: once for Y, once for Z

Each repeating group section has its own group header, detail, and group footer. These follow the same principles as their general
purpose equivalents, but within the repeating groups. For example, to calculate aggregate data for Y for each X, use an aggregate formula
in the footer for the repeating group with the Y data.

Reprinting Group Headers
As of v2018.2+, you have the option to reprint Group Header rows at the top of the page if the detail section of any given group spans
multiple pages. This option is only available on Group and Repeating Group Header sections. To reprint a Group Header row when its
detail section continues onto another page, click the row number in the Report Designer and select Repeat Row. If the Header has
been set to repeat, two blue lines will display next to the row number.

Section Shading
Section shading allows you to specify alternating background colors for repeating elements in a section. Alternating colors applies to
Detail and Group sections; for other sections, only one color can be used.

To add section shading:

1. Click a section title to open a menu for that section. Select  Section Shading.
2. Click  New to add a new shading color.
3. For each shading color, select a color with the color picker, or enter a hexadecimal color code.
4. Use the up Move Item Up  and Movie Item Down  icons to rearrange the order of the colors.
5. Click the Delete  icon to remove a shading color.
6. Click Okay.
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Adding two alternating background colors to a Detail section

Tip: Section shading is overridden by the cell background color and by conditional formatting.

Advanced Reports: Using the Toolbar
The toolbar contains the buttons and menus used to modify the report. Modifications can include aesthetic formatting, inserting formulas
and images, linking reports, and much more.

Your system administrator has the ability to hide or show specific menu options and toolbar items. Some items may not be available to
you.

Advanced Report Designer toolbar in v2019.2+

The toolbar begins with the Settings dropdown menu sometimes referred to as the Cog Wheel menu. This menu controls changes, such
as renaming and filtering, that affect the entire report. All other buttons on the toolbar require that a cell (or cells) in the design grid be
selected.

Settings menu

 Rename: Allows you to change the name and folder where the report will be saved.Enter a new name for the report, or choose a
different folder. The name must be unique.

 Description: Allows you to enter or change the description of the report.
 Categories: Allows you to change the Categories which are included on the report. The article on Categories has more

information.

 Sorts: Allows you to change the Sorts on the report. The article on Sorts has more information.
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 Filters: Allows you to change the Filters on the report. The article on Filters has more information.
 Template: Allows you to setup document templates and forms. The article on Templates has more information.

Options: Allows you to change behavior of the report. The article on Options has detailed information about each option.
 General: Allows you to change things such as report export types, filter execution windows and page formatting. Review

the General Options article for full details.
 Report Viewer: Allows you to change things such showing the report grid, the toolbar and interactive filters and sorts in

the report viewer. Review the Report Options article for full details.
 Execution Caching: Allows you to setup Execution Caching options for this report. This is an advanced feature, contact

your system administrator for assistance with it.
 Custom: Allows you to set any Custom Options on the report. This is an advanced feature, contact your system

administrator for assistance with it.
Advanced: Allows you to change advanced properties of the report.

 Joins: Allows you to define how categories on a report are related to one another. The article on Joins has more
information.

 Parameters: Allows you to define reusable system variables, called Parameters, on the report. The article on Report
Level Parameters has more information.

 Show Generated SQL: Allows you to view the generated SQL query which retrieves the data used on the report. The
article on Show Generated SQL has more information.

Saving Reports
The report can be saved by clicking the Save  icon. The report will also be saved anytime it is executed.

Undo/Redo

Any action on a report can be undone by clicking  or pressing CTRL + Z. Undone actions can be redone by clicking  or pressing
CTRL + Y.

Font & Alignment Options
The text of each cell can be formatted using dropdown menus and buttons in the toolbar. A cell or multiple cells must be selected for these
tools to be used.

Font
To change the font, use the searchable dropdown menu. The font names appear in the style that they represent.
Text size can be controlled using the up and down arrows on font size spinner.

The Bold , Italics  and Underline  icons make the selected font bold, italicized, and underlined, respectively. Clicking
the icon will turn it slightly gray to indicate the function is turned on.

Color

To change the text color, click the Foreground Color  icon to show the foreground color selector. Select a color or enter an
RGB value. Hexadecimal HTML color codes may be added in the Hex textbox, or decimal values may be entered into each of the

R, G and B textboxes ranging from 0-255. Click the Reset  button to revert to the default color. A preview of the active foreground
color appears below the Foreground Color icon.

To change the cell background color, click the Background Color  icon to show the background color selector. Select a color
or enter an RGB value. Hexadecimal HTML color codes may be added in the Hex textbox, or decimal values may be entered into

each of the R, G and B textboxes ranging from 0-255. Click the Reset  button to revert to the default color. A preview of the
active background color appears below the Background Color icon.
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Color picker

Note

The colors on the bottom row of the new color picker can be set via extensibility by a system administrator on a system-wide basis or
they may be available for user preference.

Alignment
Text can be aligned to the left, center, right or justified in the cell using the respective horizontal alignment icons. First, click the

Horizontal Alignment Selector   icon, and then choose from Left , Right , Center  or Justified 
alignment. The horizontal alignment selector icon will change to show the currently selected alignment mode.
Text can be aligned to the top, center, or bottom in the cell using the respective vertical alignment icons. First, click the Vertical

Alignment Selector  icon, and then choose from Top , Middle  or Bottom  alignment. The vertical alignment
selector icon will change to show the currently selected alignment mode.

Clicking on the Wrap Text  icon will cause text longer than the width of a cell to wrap to new lines instead of being cut off by
the cell's boundary.

Formatting Cells

Cells can be formatted in the Cell Format Window. To open the window, first click on a cell and then click the Format Cell  icon.
The window has three tabs: Number, Border, and Conditional.

Comprehensive cell formatting information including how to use each of the three tabs can be found in our Cell Formatting article.

Cell formatting can be copied using the Format Paintbrush tool. Select the cell you want to copy, click the Format Paintbrush 

Merge/Split Cells
Multiple cells can be merged together by first selecting the cells and then clicking the Merge Cells  icon. This is helpful when adding a
chart to a report or when creating a heading, for example.

Conversely, merged cells may be split back up by selecting the cell to be split and the clicking the Split Cells  icon. Only cells which
have been merged can be split.

AutoSum

To quickly get a total on a Data Field, place the field in a Report or Group Footer and click the AutoSum  icon. Alternatively, a sum
can be created with the aggSum or Sum functions. See Formulas for more information.

Note

Do not use AutoSum on a cell with an aggregate formula such as aggSum.
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Images

An image from your computer can be added to a cell using the Insert Image  icon.

Functions
Complex calculations can be done using Formulas. A formula can be added to a cell by keying it in manually or using the Formula

Editor. To open the Formula Editor click the Formula Editor  icon.

Detailed information about formulas and how to use them can be found in the Formulas Section of the product documentation.

Chart Wizard

A chart visualization may be added to the report by first clicking on a cell and then clicking on the Chart Wizard  icon to launch the
chart wizard. Full details about chart types and how to use the chart wizard can be found in the article on Charts.

Gauge Wizard

A gauge visualization may eb added to the report by clicking on a cell and then clicking on the Gauge Wizard  icon to launch the
gauge wizard. Full details about gauges and how to use the gauge wizard can be found in the article on Gauges.

Suppress Duplicates

You can suppress duplicate values of a Data Object from being displayed. Select the cell and click the Suppress Duplicates  icon.

For example, the two reports below are identical, except the second image has suppressed duplicates for the customer column.

Duplicates are not suppressed

Duplicates are suppressed

CrossTab Wizard

A CrossTab Report can be added to the report by clicking on the CrossTab Wizard  icon.

Linked Reports (aka Drilldowns)
A "subreport" can be linked to data on the current report by creating a link or drilldown to another report. Click on a cell and then click the

Link Reports  icon to link a report to that cell. Review the Drilldowns article for full details on how to create a report link (drilldown).
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Linked Action Event
Action Events are custom programs which can be activated by certain actions on a report. This is an advanced feature. Consult with your
system administrator about which action events are available in your system. To add an Action Event to a cell, first click the cell and then

click the Linked Action Event  icon.

GeoChart Wizard
GeoCharts are a way to visualize geographical report data. To insert a GeoChart into a cell, first select the cell and the click on the

GeoChart Wizard icon.

GeoCharts are a legacy feature, and have been replaced with the Google Maps feature. More information about the GeoCharts feature
can be found in the GeoCharts article.

Google Maps Wizard
Google Maps are a way to insert interactive maps in a report to visualize geoghraphical report data. To insert a Google Maps visualization
into a cell, first select the cell and then click on the Google Maps Wizard  icon.

More information about using this feature can be found in the Google Maps article.

Run Report

Run Report button

Clicking on the Run Report button will execute the report and display the result in the Report Viewer.

Execution Caching
If Execution Caching is enabled for a report, the Cache Status icons will appear in the toolbar next to the Run Report and Export
buttons. A report can only be run when the cache is valid.

 Cache Invalid: the cache is invalid or out of date. Click this icon to update the cache.

 Cache Valid: the cache is valid.

Export

Export PDF button

Export file types button

To export the report as a downloadable file, click on the Export PDF button. You can also click on the More  icon to select from the
additional exportable file types.

The system administrator can make only certain file types available, so the menu may look differently depending on how your installation
is configured.

Advanced Reports: Design Grid
In the design grid, you can:

Add and delete rows, columns, and sections.
Enter data fields, text, and formulas.
Drag and drop fields into different sections, rows, or columns.
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Sections
Sections dictate how the data appears in a report. There are five types of sections: page, report, details, group, and repeating group.

 Page Header &  Page Footer
The rows in the Page Header section appear at the top of every page of a report, and the rows in the Page Footer section appears at the
bottom of every page of a report. Typically, the Page Header section is used to designate column headers for a report, and the Page
Footer section is used to display the page number and/or confidentiality notices for a report. 

Page Headers and Page Footers are not intended to perform calculations or display data fields. For this reason, a Page Header populated
with a data field will only return the first line of data in that field; a Page Footer will return only the last line of data.

Note: If you are printing a report, remember that Excel outputs do not have pages. Page Headers will appear only once at the beginning
of the report. Reports run via the Report Viewer will display Page Headers similarly unless ‘Simulate PDF’ is checked in the Options
menu.

 Report Header &  Report Footer
The rows in the Report Header appear at the beginning of a report. Typically, these rows display the title of a report. The rows in the Report
Footer appear at the end of a report. Typically, the Report Footer displays grand totals and summary information for the report.

 Detail
The Detail section is the main section of most reports. When the report is executed, the Details Section creates a row for each element in
the Data Categories. For example, if the Detail section contains the Data Field Orders.OrderId, the report will display each Order Id on a
separate row.

 Group Header &  Group Footer
Group Header/Footer sections require a sort on a Data Field. The rows in a Group Header section will appear above the Detail section for
each unique value of the sorted Data Field. Typically, Group Header sections are used to display data as labels. For example, a report
may contain a Group Header on Orders.OrderDate and display Orders.OrderId in the Detail section. The output would display each date
with orders that occurred on that date below them.

The rows in a Group Footer section will appear below the Detail section for each unique value of the sorted Data Field. Typically, Group
Footer sections are used to calculate subtotals. For example, a report may contain a Group Footer on Orders.OrderDate which displays
the number of orders made on each date.

Note: Group Header/Footer sections can also be set to display rows for each value of a formula instead of a Data Field. (Ex. The report
may be sorted on the Data Field Orders.OrderDate, but the report should show subtotals for each month. A Group Footer on the
formula =Month({Orders.OrderDate}) will display rows containing subtotals for each month.)

 Repeating Groups
Repeating Groups require a sort on a Data Field. Repeating Groups have their own header, detail, and footer subsections. Repeating
Groups should only be used when the data has multiple one-to-many relationships and each should be rendered completely before the
other.

For example, each Professor can teach multiple classes and advise multiple students. For each professor you want to see all the classes
they teach and then all the students they advise.

Using Sections
Sections can be added, deleted, modified, moved, and assigned shading.
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Adding Sections
1. Click anywhere in the Section Column.
2. Hover your mouse over Add Section, then select the type of section you would like to add.

Deleting Sections
1. In the Section Column, click on the section you want to delete.
2. Click ‘Delete Section’.

Modify Sections (Group Header/Footers and Repeating Groups only)
1. In the Section Column, click on the section you want to modify.
2. Click Modify Section. This will bring up a Modify Group Section Menu.
3. Select from the dropdown the desired Data Field for the group to use.
4. Click OK.

Section Shading
1. In the Section Column, click on the section that you want to Shade.
2. Click Section Shading. This will bring up a menu.
3. Click New to add a color to the shading.
4. Click the color box to select a color or enter a hex value.
5. Click OK.

Columns and Rows
Columns and rows of cells can be added, modified, or removed as described below.

Columns
To select a group of columns, hold the SHIFT key and then click the beginning and ending column.
Non-contiguous columns can be selected by holding the CTRL key and clicking the desired columns.
A column can be resized by dragging its right edge horizontally.
Clicking on a column (or selected group) will display a menu where you can:

Insert a new column.
Delete the selected column.
Set its width to be identical with the other selected columns.
Hide the selected column.
Set Column Info to make the label the column and/or make it sortable within the Report Viewer.
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Sorting by Columns within the Report Viewer
While viewing reports in the Report Viewer, a user can click the bar at the top of the report to sort by a column. For Express Reports, this
is handled automatically but must be enabled for Advanced and CrossTab Reports.

Note: Column Sorts are applied after any sorts defined in the Sorts menu.

To make a column sortable:

1. Click on the column and select Column Info... from the menu.
2. Provide the column with a label that will appear in the Interactive Report Viewer Dock.
3. From the Sort dropdown select the Data Field to be used for sorting, or provide a formula by clicking the Formula Editor  icon.

4. Click on the column again to set a default sort direction.

Rows
To select a group of rows, hold the SHIFT key, then click the top and bottom rows of the area you wish to select.
Non-contiguous rows can be selected by holding the CTRL key and clicking the desired rows.
A row can be resized by dragging its bottom edge vertically.
Clicking on a row (or selected group) will display a menu where you can:

Insert a new row.
Delete the selected row.
Set the row's height to be automatically controlled.
Suppress the row from appearing on the report.
Insert a page break.
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Cells
Cells are the containers for all the information in a report. Cells may contain data fields, formulas, text, images, charts, or links to other
reports.

In application v2019.2+ cells containing data fields will have a small color-coded triangle appear in the top-left corner of the cell. Cells
containing data fields from the same category will have the same color. In the figure below, the cells with fields from the Products
category have a maroon triangle and the cells with data fields from the OrderDetails category have a dark green triangle.

Color coding of data fields in cells

To enter text into a cell, double-click the cell, and a text field will appear.
To select cells, either click or use the arrow keys.
Groups of cells can be selected by holding the SHIFT key and clicking on another cell. All the cells in-between the two will be
selected.
Non-contiguous cells can be selected by holding the CTRL key and clicking the desired cells.
A cell can be copied by holding the CTRL key, then dragging and dropping it into a new cell.

Adjacent cells can be merged and unmerged using the Merge Cells  and Split Cell  icons in the Toolbar.

Using Page Breaks
For a Page Break to occur at the beginning of each element of a Data Field, place a page break on the top row of Group Header Section
for that Data Field. See Sections for more detail on Group Header Sections.

Creating Collapsible Rows
A Group Section can be set to display as collapsed by default on HTML export. This causes the contents of the section to be suppressed
and individually expandable for each change in Header. Collapsible rows are supported in the standard or Interactive HTML viewer. Non-
HTML export formats will ignore Collapsible Rows.
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Left-click on an arrow next to a Collapsible Row to expand or collapse the group. 

 

Right-click on an arrow next to a Collapsible Row to see additional display options:

Expand will expand the selected top-level group. This elicits the same behavior as left-clicking an arrow.
Collapse will collapse the selected top-level group. The state of the sub-groups is preserved.
Expand Group will expand the selected top-level group and all sub-groups within that group.
Collapse Group will collapse the selected top-level group and all sub-groups within that group.
Expand All will expand every group and sub-group on the page.
Collapse All will collapse every group and sub-group on the page.

To create a collapsible row, click on the desired row number in a Group Header Section and select Collapse Rows in the dropdown menu.

Properties of a Collapsible Row
Collapsible Rows have the following properties when exported to HTML:

Collapsible Rows display as collapsed whenever the Report is exported or altered using Interactive HTML.

Note: Collapsed or expanded states cannot be saved to the Interactive HTML User Report preferences.

Page Breaks below a collapsed row are ignored. Expanding a collapsed group will not alter the Report pagination.
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The contents of a collapsed group are searchable by the HTML search tool.

See Interacting with the Report Viewer for more information on the Interactive Report Viewer.

Advanced Reports: Drilldowns
Drilldowns are reports linked from cells or charts as a means of exploring data points by "drilling down" into their background data. Use
the Advanced Report Designer to add them.

The terms Linked Reports and Drilldowns are used interchangeably throughout the application and this document, but they refer to the
same concept.

Note

Drilldowns work in the Report Viewer and Dashboard Viewer, but the linked data is not included in exported reports or dashboards.

 

Drilling down from a column chart (top) and from a cell (bottom)

Drilldowns require a child report, which can be an Dashboard, Advanced, CrossTab or Express Report that contains the background
data for the parent report. Drilldowns can be created on a Dynamic Cell or a chart by linking to the child report from the parent report.
Clicking each cell value or chart series will filter the child report by its respective value before opening it. Depending on system
configuration, the child report will open at the mouse cursor location, in the center of the screen or in a new report tab.

Dashboards as Child Reports
Beginning in v2019.2+, Dashboards can be drilled down to as child reports. Dashboard Drilldowns open in the standard Dashboard
Viewer in a new tab. There are a few special considerations when drilling down to a Dashboard:

When drilling down to a Dashboard, filters on the parent report will affect the Dashboard tiles differently.

Linking filters are filters created during the linking process. Interactive filters are filters created on a Dashboard, or from Report Viewer
Options in the Report Designer.

Report Filters are filters created in the parent report using either the Report Wizard or the Filters menu of the Report Designer.

Tile Type Linking Filter Behavior Report Filter Behavior

Existing Advanced, Express or
CrossTab Report

if the Filter Field is already on the report in the
tile, or if it can be directly joined to the other Data
Objects on the report, the filter is applied to the
tile.

if the Filter Field is already on the report in the
tile, the filter is applied to the tile. If not, the filter
is not applied. 

Existing ExpressView
if the Filter Field is already on the report in the
tile, or if it can be directly or indirectly joined to
the other Data Objects on the report, the filter is
applied to the tile.

Visualization
if the Filter Field is already in the visualization in
the tile, or if it can be directly or indirectly joined
to the other Data Objects in the visualization, the
filter is applied to the tile.

In the Dashboard Viewer's Filters Pane, all filters that are a result of the linking process except for non-prompting filters from the parent
report are visible.
These filters are:

1. Filters from the Fields tab of the Linked Report Wizard
2. Filters that are a result of the formula in the Formula Tab of the Linked Report Wizard
3. If the parent report is on a Dashboard, interactive filters from parent and parent-of-parent (aka grandparent) reports
4. Prompting filters from parent report

Note
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Currently, the prompt window will not appear when drilling down into a child report that contains prompting parameters. However, this can
be partially bypassed by adding the prompting parameter in a hidden cell on the parent report so that the user will be prompted at
runtime for the parameter value.

Caution

Adding a drilldown to a cell may override or interfere with any linked Action Event on the cell. Adding a linked report to a chart may
override some aspects of the chart's basic interactivity.

Since Drilldowns are themselves reports, they can have interactive sorts and filters, visualizations, be exported, and even have their own
drilldowns.

Linking Types

Default Linking
By default, the Data Field in the parent report's linking cell filters the closest joined Data Field on the child report. The article on Joins
has more information on data field joining. If there is no direct join path, then fields may be linked manually in the Fields tab of the Linked
Report Wizard.

For example, a parent report links an Employees data field to a child report with an Orders category. The two categories are joined on
Orders.EmployeeId >> Employees.Id. For each Employees row, its Employee.Id value filters the linked report down to the
Order rows with matching Orders.EmployeeId values. Therefore, clicking on an Employee name in the parent report will drilldown to a
list of orders that the employee made.

   

Orders linked report filtered by Employee Id

Tip

Linking filters do not cascade down to grand-children, or child reports of the linked report.

Manually Defining Link Fields
To link on different fields or categories than the default link, use the Fields tab of the Linked Report Wizard. The From fields from the
parent report filter the To fields on the child report. The Fields tab is suitable for the following situations:

Tip

The From fields from the parent report filter the To fields on the child report.

The default join is not the desired link to use
Example: Linking on related fields other than the Id field, such as "Region"
Employees.Region >> Orders.ShipRegion
No join exists between the From and To categories
Example: Categories have related fields but are not joined, such as Orders and Suppliers
Orders.ShipCity >> Suppliers.City
The From and To categories are the same
Example: Fields are related to other fields in the category, such as Employee X supervises Employees Y and Z
Employees.Id >> Employees.ReportsTo

Conditionally Link with Formula

Note

This feature is disabled in system configuration by default. Contact your system administrator for assistance.

Use the Formula tab of the Linked Report Wizard to conditionally enable drilldowns on specific values. By default, once a drilldown is
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setup, all records on the report can drilldown to the child. By adding a Formula, only values meeting the condition will permit drilling.

The formula must return True or False. The formula is evaluated for each row in the parent report, and if the condition is not met, drilling
down to the child report is not enabled.

For example, the following formula could be used to create a drilldown to a report showing a suppliers list if and only if there are items on
order or the quantity in stock is less than the product's reorder level. Those products that do not meet that criteria cannot be drilled down.

Or({Products.UnitsOnOrder} > 1, {Products.UnitsInStock} <= {Products.ReorderLevel})

Therefore, only Queso Cabrales, Gorgonzola Telino, and Marscarpine Fabioli meet the criteria. Clicking on the other products will have no
effect.

See the Formulas article for assistance with conditional formulas.

Adding Linked Reports
1. Add a new Dashboard, Advanced, CrossTab or Express Report that contains the drilldown data. This will become the linked

child report.

Linked reports typically open in a small window, so the child report should be simple and concise. Avoid large fonts, a lot of static
content, or making it too large in size. The child report's General Option for No Data Qualify Display Mode should be set to
Show Report in order to show an empty drilldown instead of an error message.

2. In the parent report, select the cell to link then click the Link Reports  icon in the toolbar. This will open the Linked Report
Wizard.

The Linked Report Wizard

3. Select the desired child report. This will use default linking to drilldown to the child report.

To manually define link fields:
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The Fields tab of the Linked Report Wizard

1. Select the From Category and To Category from their respective dropdowns.
2. Click the  Add button for each set of linked fields to add. Use multiple linked fields to show only the drilldown rows that

satisfy all of the link conditions.
3. For each set of linked fields, select the From Field and To Field.

To conditionally link with formula:

The Formula tab of the Linked Report Wizard

1. Add a data field by dragging and dropping it into the Formula pane or double-clicking it. Or enter it manually using the
following format: {DataCategory.DataField}
Caution: Linked report conditional formulas support only one data field. If multiple data fields are used, all but the first will be
ignored.

2. Add a Parameter by entering it manually using the following format: @ParameterName@.
3. Add a function by dragging and dropping it into the Formula box or double-clicking it, or enter it manually.

4. Click Okay to close the Linked Report Wizard.

Caution

Because the child is a separate report from the parent, if the child report is moved to another folder, or the linked field is removed from the
report, the link will be broken.

Modifying Linked Reports

1. Click the Link  icon in the corner of the linking cell, or click the cell and then click the Link Reports  icon in the toolbar.
2. Interact with the Linked Report Wizard just as if the link is being added (continue at step 2).

Deleting Linked Reports
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1. Click the Link  icon in the corner of the linking cell, or click the cell and then click the Link Reports  icon in the toolbar.
2. Click the Remove Link  icon.
3. Click Okay.

Dashboard Viewer (v2019.2+)
When a Dashboard is run, it is displayed in a new tab called the Dashboard Viewer. Reports, Visualizations and other Dashboard
content appear in rectangular Tiles on the Canvas. Reports, Visualizations and Filter tiles are interactive, as are any embedded web
pages. The tiles can be set to refresh periodically, or can be refreshed manually. Filters placed on the canvas or in the Filters Pane can
filter the displayed data. Reports containing Parameters can have them adjusted in the Parameters pane.

Running a Dashboard in the Dashboard Viewer

Run a Dashboard

From the Dashboard Designer, click the  Run button on the top toolbar. Depending on system configuration, this will also
save the Dashboard.

From the  Report Tree, select the Dashboard in the tree, then click the Run  icon, or click the Menu  icon and click 
Run Report.

The Dashboard Viewer opens in a new tab, indicated by the Viewer  icon. If a Dashboard refreshes automatically but is not currently
the selected tab, the Dashboard's name will flash. If the Dashboard is edited in the Designer it will need to be run again to see the changes
in the Viewer, which will launch in another new tab.

Two Dashboard Viewer tabs, "Orange Dash" is the selected tab

If any of the reports on the Dashboard contain filters or parameters which have their Prompt for value setting enabled, a prompt will
appear before the Dashboard loads.

Keyboard Shortcuts
There are several useful keyboard shortcuts available in the Dashboard Viewer. They are listed in the Keyboard Shortcuts article.

Interacting with Dashboards
There are a number of ways to interact with tiles on the canvas. The available options depend on how the Dashboard was designed and the
type of content on it.
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Every Dashboard Viewer will have a floating Refresh  icon in the top-left corner of the canvas. Clicking on this icon at any time will
refresh the data in the tiles.

If the Dashboard also includes interactive filters, a floating Filter  icon will appear below the Refresh icon. Clicking on the Filter 

icon or pressing the F key on the keyboard will open the Filters Pane on the right side of the screen where filters can be viewed.
Filters narrow down the data presented in a tile. More information is included in the Filters section below. Clicking the icon or pressing F
again will hide the pane.

If any of the reports on the canvas include system or report level Parameters, a floating Parameters  icon will appear along with the
Refresh icon. Clicking on the icon or pressing the P key on the keyboard will open the Parameters Pane on the right side of the screen
where these parameters can be changed. Clicking the icon or pressing P again will hide the pane.

This Dashboard has both Interactive Filters and Parameters on it

The floating icons may be relocated anywhere along the left edge of the canvas by clicking and dragging any of the icons along the edge.
The icons disappear if the mouse is not moved over the canvas for a few seconds, and will reappear on the next mouse movement.

Reports and Visualizations
Report tiles are reports already created in the application and then loaded into a tile on the canvas. A Visualization tile is a graphical
representation of data that can be designed directly on the canvas without first creating a report. Both report and visualization tiles can
display tabular or graphical data.

Hover the mouse over a tile to show a navigation bar at the bottom of the tile. Depending on the particular tile's content and its Advanced
Properties, some options may not be available:

Page through the report by using the navigation icons    . The Page Up  and Page Down  icons move one page at
a time, and the Page Home  and Page End  icons will move to the first and last page of the report, respectively.
Enter text into the Find field, then click the up  or down  icons to search for text in the report

Click the Show Chart and  Show Table  icons to swap between chart or tabular view

Click the Tile Menu  icon to access some additional options for interacting with tiles:

Expand Tile will cause the tile to fill the entire canvas
Collapse Tile will return the tile to its original size
Refresh Report will refresh the data in the tile
Save as Advanced Report will save the tile as an Advanced Report. The corresponding Report Designer will be launched.
Export will export the tile's content in one of the available export file formats. Depending on the system configuration and the
report's settings, choose from Excel, RTF, PDF, or CSV.

Filters
Use Filters to narrow down the data for multiple reports at once.

Interactive Filter tiles can appear as scales, menus, or checkboxes on the Dashboard. Hover the mouse over the filter tile to see which
tiles on the canvas are affected by this filter. Affected tiles will be highlighted with a blue outline.

Select one or more data values, or a range of data, to apply the filter to all its affected tiles. This will automatically refresh the reports.
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A vertical scale Interactive Filter tile which selects a range of shipping dates

Clicking on the floating Filter icon will open the Filters Pane on the right side of the screen where filters can be viewed and modified.
Filters in the pane are called Docked Filters. An example is provided below.

Dashboard Viewer with the Filters pane open on right side of screen

The sample Filters Pane on the left is for a Dashboard with three docked filters.

Hovering the mouse over the filter item in the pane will highlight the affected tiles
with a blue dashed outline.

1. The first filter is an interactive filter on the data object Suppliers.Country.
The operator Equal To means that only data where the Suppliers.Country
is equal to the value USA will be included. The Country value can be modified

by using the dropdown to change it. Clicking on the Settings  icon changes
how the operator compares the value with the filter field (choose from Starts With
or Contains).

2. The second two filters on Customers.CompanyName and Orders.OrderID
are linked from a parent report which has linked (or drilled-down) to this

Dashboard. This linking behavior is indicated by the Linked Report  icon.
Both the linking filter and any other filters on the parent report will be imported to
the Dashboard. Linked filters cannot be changed in the Dashboard Viewer. Hover

over the Linked Report  icon to see the folder and name of the parent
report.

For more information about how Filters interact with reports, review the article on Filters.

Parameters
Parameters are system-wide or report-level variables that can be included in reports. There are several built-in parameters, and the
system administrator can configure additional ones. Consult with them to find out what parameters are available. Individual reports can
have their own parameters. The article on Report Level Parameters explains how to setup and use parameters in more detail.

The sample Parameters Pane to the left is for a Dashboard with reports that
contain two parameters, the first named MyParameter and the second named
DateParam whose values are Report Master and 11/27/2019 respectively.

Both parameters can be modified by editing their respective values using the
controls available in each parameter item.

Dashboard Designer (v2019.2+)
Dashboards are a way to combine several related reports into one unified viewing
space. Existing reports can be added to a Dashboard, and new Visualizations
can be created directly on the Dashboard itself. Images, text, other web sites, and

interactive filters can also be added. Dashboards can be exported as a Chained Report from the Dashboard Designer.
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The Dashboard Designer

The Dashboard Designer is comprised of three sections: the Toolbar, the Canvas and the Tile Properties Pane.

Each element on a Dashboard is a contained within a rectangular tile that can be resized and dragged to the desired location. Tiles are
arranged onto a grid, and can snap into place next to each other.

Keyboard Shortcuts
There are several useful keyboard shortcuts available in the Dashboard Designer. They are listed in the Keyboard Shortcuts article.

Toolbar
The top of the Dashboard Designer contains a Toolbar  for creating and interacting with the canvas and the tiles.

The Dashboard Designer toolbar

 New Tile: creates a new content tile on the canvas
 Refresh: refreshes the data in all tiles on the canvas

 Filters: allows filters to be added to the Dashboard and shows prompting filters imported from the Dashboard's component
reports. Full details on how this menu works can be found in the Dashboard Designer: Filters article

 Parameters: if report tiles on the Dashboard contain Parameters, this menu will be enabled and allow the parameters to be
changed. More information can be found in the Dashboard Designer: Parameters article

 Canvas Format: controls how the tiles fit onto the canvas and sets default styling options

Save: saves the Dashboard

 Save Dropdown: changes the name and description text of the Dashboard when saving

 Export: exports the contents of existing reports and visualizations on the Dashboard as a Chained Report

 Run: launches the Dashboard Viewer and optionally saves the Dashboard (depending on system configuration)

Canvas
Every element on a Dashboard is a contained on the canvas within a rectangular tile that can be dragged to the desired location, resized
and styled. Tiles are arranged onto a grid, and can snap into place next to each other.
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The Dashboard Designer Canvas

Tiles
Each element on a Dashboard is a contained within a rectangular tile that can be resized and dragged to the desired location. Tiles are
arranged onto a grid, and can snap into place next to each other.

Tiles contain four elements:

1. Move handle: click and drag the move handle to move the tile around on the canvas. Hold the Shift key while dragging the move
handle to stretch the tile to fit the available space

2. Tile Menu: contains additional options for tiles. Refer to the Managing Tiles section of this article for more information.
3. Tile Header: an optional header can be displayed in the tile
4. Content: the content of the tile is displayed in this area

Anatomy of a tile in the Dashboard Designer

Adding Tiles

Several different types of tiles can be added to the canvas:

Visualizations
URL
Image
Text
Existing Reports
Filters

New tiles can be added to the canvas either one of two ways:
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Click the  New Tile icon to open the new tile menu, then
drag the desired type of tile onto the Dashboard canvas.

Drag the  New Tile icon onto the Dashboard canvas,
and a new tile placeholder will be added onto the canvas.

Then choose the desired tile type by clicking on it in the
placeholder.

Tiles can be dragged to an empty location to fill the space, to the side of an empty location to take up a portion of the space, or over
another tile to place it adjacent and resize the other tile to fit. Tiles can then be resized by dragging the handles to alter the tile size.

Dragging a new tile over an existing tile on the left

Screen Fit and Scaling

Dashboards can scale to fit different screen sizes. Click the Canvas Format icon on the Toolbar to open the Canvas Format menu.
The following Fit options are available:

Scale to Screen causes tiles to resize to fit the height and width of the displayed canvas.
Tiles must be larger than 3-grid units tall and/or 4-grid units wide or less to automatically resize.
Specify Height specifies a static height for the canvas. Enter the desired Height of the Dashboard into the textbox. Tiles must be
larger than 20 pixels tall or 4-grid units wide to automatically resize.

Check the Automatically Reposition Tiles checkbox to make the tiles reposition each time the width of the canvas is
changed. Leave unchecked if the tiles should maintain position when the canvas width is changed. See the examples below,
which shows the same Dashboard with a set height and differing widths with the Automatically Reposition Tiles checkbox
checked and unchecked:

Automatically Reposition Tiles Checked
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Automatically Reposition Tiles Unchecked

Specify Height and Width prevents tiles from automatically resizing, and the canvas will have a static height and width. Enter the
desired Height and Width into the corresponding textboxes.

Check the Snap Tiles to Grid checkbox if tiles should snap to the grid. Leave unchecked to allow free movement of the tile
borders.

Backgrounds and Borders
Default options for the canvas background color, tile and tile header background colors, and tile border colors and widths can also be

customized from the Canvas Format  menu under Style. These settings can be overridden for individual tiles through the respective
tile's Tile Properties Pane.

Canvas Color sets the background color of the entire canvas

The following Tile Defaults are applied whenever a new tile is added to the canvas.

Check the Background checkbox to set colors for the tile and the tile header
Tile sets the default tile background color
Heading sets the default tile header background color

Check the Shadow checkbox to enable a subtle shadow effect to be applied to the tiles
Check the Border checkbox to set defaults for the tile borders. By default, the settings are applied to all four of the tile borders. To
set individual color, width and roundness settings to each border check the Customize Border checkbox.

Click the color selector icon to choose a border color
Enter a width in pixels for the border
Choose a round value to set the roundness of the corners

Managing Tiles
Tiles have a menu with some additional options.

Tile Menu

Click a tile on the canvas to select it, then click the Tile Menu  icon to access some additional options. Not all tile types have the
same options available. For example, interactive filter tiles do not have expand tile or refresh report options.

Delete Tile will remove the tile from canvas.
Duplicate Tile will create a duplicate of the tile on the canvas.
Dock Filter to Toolbar will relocate an interactive filter from the canvas to the Filters menu. When the Dashboard is run, the
filter appears in a Filters pane instead of on the canvas. Applies to interactive filter tiles only.
Expand Tile will fill the entire canvas with this tile. Once expanded, this option becomes Collapse Tile and will restore the tile
back to its original size and location
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Refresh Report will refresh the data in report and visualization tiles
Open in Designer will load an existing report tile into its respective designer for editing
Save as Advanced Report will save tiles containing visualizations built directly on the canvas as an Advanced Report and then
launch the Advanced Report Designer
Edit will allow settings to be changed for visualization tiles. Different visualization types will have different options available:

Type: changes the visualization type displayed in the tile. Click on the different categories (pie, line, column, bar, tabular) to
choose one of the available types. See the Dashboard Designer: Visualizations article for more information. Enable or disable
a three-dimensional effect on the visualization with the Use 3D Style checkbox.
Theme: changes a visualization's visual color theme
Legend Location: changes the location of a visualization's legend location from none, right or bottom. Applies only to
those bar, column, pie, line and scatter visualizations
Sort By: change how the visualization is sorted

Report Order presents the data in the order in which the data source sends it to the application
Data Labels sorts the data based on the labels in the visualization
Ascending sorting order is from lowest to highest or from A to Z
Descending sorting order is from highest to lowest or from Z to A

Invert Data: for multiple category visualizations (e.g. stack column and stack bar charts), swaps the order of the categories

Tile Properties Pane

The Tile Properties Pane in the Dashboard Designer

The Tile Properties Pane on the right side of the Dashboard Designer is where the look, feel and behavior of individual tiles on the canvas
can be changed. It contains three tabs: Content, Style and Advanced.

The very top of the Tile Properties Pane contains the Tile Header section, including a text entry field for providing a title that can optionally

displayed on the canvas. Clicking on the Show Header  icon next to the text entry field will show the header in the tile on the canvas.

Clicking Hide Header   icon will hide it. Clicking on the Title Header Format  icon will show formatting settings for the tile header
allowing the font type, size, alignment and styling to be applied. Clicking the Title Header Format  icon again will hide these settings.

Tile Header portion of the Tile Properties Pane, with formatting settings shown

Depending on the type of tile selected on the canvas, the availability of the tabs in the Tile Properties Pane will change. Tabs which are not
available for a particular tile type will be grayed out. Each tile type has its own article with details of the respective tile properties. A list of
tile types with links to more information is at the beginning of this article.

Dashboard Designer: Existing Reports (v2019.2+)
Existing ExpressViews, Advanced Reports, CrossTab Reports or Express Reports can be added to a Dashboard. Existing filters and
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parameters can be accessed and modified from the Dashboard Designer. Reports on Dashboards have most of the same interactivity
as in the Report Viewer, with the exception of the interactive sidebar.

More information about creating reports can be found in the sections on Reporting.

To add an existing report to a Dashboard, review the Dashboard Designer article. Tiles can be added from the  New Tile menu, or

by dragging the report directly to the canvas from the Report Tree.

If the report has prompting filters or parameters on it, these items can be modified in the corresponding Filters and Parameters 

 menus in the top toolbar. Review the Dashboard Designer: Filters and Dashboard Designer: Parameters articles for additional
information.

Tile Properties Pane
Controls for building and interacting with the Existing Report tile are contained in the Tile Properties Pane on the right side of the
screen. Click on the tile to select it and the Tile Properties Pane will fill with the properties for the selected tile.

Content
The Content tab for existing reports allows the report in the tile to be changed. Select the report from the list, and then click Apply. Only
reports of the same type as the existing tile can be selected. For example, a tile which shows an ExpressView can only be changed to
another ExpressView.

If an ExpressView is selected, the Suppress Tabular Detail Rows checkbox will be displayed at the bottom of the pane. Check this
checkbox to hide all of the data detail rows when the ExpressView is in tabular view mode.

ExpressView in tabular view mode, showing suppressed tabular detail on the left, and unsuppressed tabular detail on the
right

Style
ExpressView

The Style tab for ExpressViews only contains the Tile section. This is how this tile appears on the canvas is changed. The settings here
override the Canvas Format defaults.

Check Background to set a background color for the tile. Click Color to open the color selector and choose a background color.
Unchecking the Background checkbox makes the tile transparent.
Check Tile Header to set a background color for the tile's header. Click Color to open the color selector and choose a background
color. Unchecking the Tile Header checkbox makes the header background transparent.
Note

The Tile Header options are only shown if the Tile Header is visible on the canvas.

Check Shadow to show a slight shadow effect around the tile.
Check Border to apply a border to the tile.

Check Customize Border to set the properties of each of the four tile borders individually. Leave unchecked to have the
border properties applied equally to the four sides.
Click Color to open the color selector and choose a border color.
Width sets the border width in pixels.
Round sets the roundness of the corners.

Other Report Types

The Style tab is broken down into two areas for other kinds of reports: Fit and Tiler.

The Fit section determines how contents of the report are presented in the tile.

Responsive Report Height will change the height of rows based on the size of the tile so that when the tile is expanded, the rows
will fill the available space. 
Keep Original Report Cell Heights will not change the row height when the tile size is changed.
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The Tile section is where tile appearance can be changed. The settings here override the Canvas Format defaults.

Check Tile Header to set a background color for the tile's header. Click Color to open the color selector and choose a background
color. Unchecking the Tile Header checkbox makes the header background transparent.
Note

The Tile Header options are only shown if the Tile Header is visible on the canvas.

Check Shadow to show a slight shadow effect around the tile.
Check Border to apply a border to the tile.

Check Customize Border to set the properties of each of the four tile borders individually. Leave unchecked to have the
border properties applied equally.
Click Color to open the color selector and choose a border color.
Width sets the width in pixels of the border.
Round sets the roundness of the border corners.

Advanced
The Advanced Tab for Existing Reports is further broken down into two areas: Refresh and Navigation.

Refresh contains two settings:

Designer
Refresh report when changes are made: check the checkbox to reload the data on the report whenever changes are
made to the file in the Designer. The report will always refresh when the Dashboard Designer is opened and when the tile is

manually refreshed with the Tile Menu or the Refresh  icon on the toolbar. Not available if the tile contains an
ExpressView.

Viewer
Check the box to enable automatic refreshing of the data in the Dashboard Viewer. Check the box and then set the number
of seconds in between report refreshes. Uncheck the box to disable automatic report refreshing.

Navigation contains additional options for controls which will be displayed in the tile when the report is run.

Allow searching: check the checkbox to add a search box at the bottom of the tile that can search the report for data.
Allow scrolling: will only be shown if the tile contains an Advanced Report. Check the checkbox to add scrollbars to the tile if
the report contents extend beyond the bounds of the tile.
Table/chart toggle button: will only be shown if the tile contains an ExpressView. Check the checkbox to include toggle buttons
that allow switching between the visualization display mode and the tabular display mode. When unchecked, the toggle buttons are
hidden.

Dashboard Designer: Visualizations (v2019.2+)
A visualization is a graphical representation of data that can be designed directly on the Dashboard canvas without first creating a report.
The figures below are a small sampling of the visualizations that can be built directly on the Dashboard.

Tabular visualization
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Pie chart visualization

Spline chart visualization

Bar chart visualization

To add a new Visualization Tile to a Dashboard, review the Dashboard Designer article. Add tiles with the  New Tile menu.

Creating Visualizations
1. Add a new visualization tile to the canvas.
2. Select the Chart Type from the Content tab of the Tile Properties Pane on the right side of the screen. When a new visualization

tile is added to the canvas, Bar will be selected by default. The documentation section on Visualizations includes detailed
information about the different chart types and how to build them.

3. Next, add data to the visualization by dragging-and-dropping a Data Object from the Data Field Pane on the left side of the
screen to the tile. Once at least one Data Object is on the tile, the Data section of the Tile Properties Pane's Content tab will
also allow Data Object selection.

Drag the Data Objects either to the Values section on the left side of the tile, or to the Groups section on the right side of the tile.
Groups represent the labels of the chart, whereas the Values represent the quantities that will be charted. For example, to create a
bar chart that shows total Revenue for each Employee, the Data Object OrderDetails.Revenue would be added as a Value and
Employee.LastName would be added as a Group.
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   or 
Some visualization types (Tabular, Bar, Column and Line) allow multiple Groups to be added. When a chart has multiple Groups, it
can categorize the displayed Values. Additional groups can be added by dragging the Data Object to the tile, or clicking on the 
Add button in the Content tab. For example, to see the total Revenue for each Employee by Category,
Category.CategoryName could be added as a second group.

The figure below shows a single group bar chart on the left and a multi-group bar chart on the right. Every color change in each bar
in the chart on the right represents a different category's contribution to that employee's total revenue.

 

Multiple Groups can be re-ordered which changes how the values are categorized. Drag the Groups in the Content tab and move
them up or down to reorder them. Using the same example above, but changing the order of the Groups, the chart changes to show
each Employee's contribution to the Total Revenue for each Category:

Some visualization types (Tabular, Bar, Column, Line, KPI) allow multiple Values to be added to the chart. This adds another
quantity to the display. For example, a bar chart showing the number of units in stock and the number of units on order side-by-side
can be made by having both Products.UnitsInStock and Products.UnitsOnOrder as Values. Additional values can be
added by dragging the Data Object to the tile, or clicking on the  Add button in the Content tab of the Tile Properties Pane.

Multiple Values can be re-ordered which changes how the values are ordered. Drag the Values in the Content tab and move them
up or down to reorder them.

Tip

When adding multiple values to a KPI visualization, choose values which have the same number formatting as only one format can
be chosen for the whole visualization tile. For example, include only currency or date values in the same tile.

Dashboard Designer: Visualizations (v2019.2+) User Guide

114 of 152



4. Then, in the Data section of the Content tab of the Tile Properties Pane, further customization of the input data can be applied.
Formulas can be applied to both the Groups and the Values, including aggregate functions (for Values only) by clicking the

Formula Editor  icon.
Values can be given a friendly name in Series Name field. This name is displayed prominently in KPI visualizations, chart
legends and tabular visualization column labels.
An Aggregate Function can be chosen from the dropdown (Sum, Average, Count, Distinct Count, Min, Max or None) which
will aggregate the Values. For example, to get the total Revenue for each Employee, choose Sum. Functions not included in
the list can be added with the Formula Editor.
Tabular Visualizations have two additional properties that can be changed:

Groups and Values can be sorted in either ascending or descending order by clicking the Add Sort  icon. Each
click will change the sort from Ascending  to Descending  order.
Checking the Hide Detail checkbox shows only the aggregated category summary and hides the individual rows from
the table.

5. Formatting such as color themes, chart titles, X- and Y-axis labels, legends and number formatting can be customized in the Style
tab of the Tile Properties Pane.

6. Advanced features such as automatic data reloading, sorting, changing the axes values, and applying Filters can be customized in
the Advanced tab of the Tile Properties Pane.

Tile Properties Pane
Controls for building and interacting with the Visualization tile are contained in the Tile Properties Pane on the right side of the
Dashboard Designer.

Content
The Content tab for Visualizations is further broken down into two areas: Chart Type and Inputs.

Chart Type sets the type of visualization displayed. The documentation on Visualizations includes detailed information about the different
chart types and how to build them. Choose from the different categories:

Tabular

Bar and Column Type

Bar

Stack Bar

Stack Bar 100

Pareto

Column

Stack Column

Stack Column 100

Pie and Other Types

 Pie

Donut

Pyramid

Funnel

Line
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Line

Spline

Line Area

Spline Area

Zoom Line

Scatter

Scatter

Zoom Scatter

Key Performance Indicator (KPI)

The Data section is where the Groups and Values for the visualization are configured. To add Groupsor Values, click the corresponding 

Add button, or drag-and-drop a Data Object from the Data Field Pane on the left side of the screen to the tile.

Input section of the Content tab for a newly created bar visualization tile

Groups represent the categorization of data on the report. Values represent the quantites of each of those categories. For example, a
column chart showing the total revenue per employee could use Employees.LastName as the Dimensions and a formula which calculates
the sum of OrderDetails.Revenue for the Bars.

Formulas may be entered for either the Groups or Values by clicking on the corresponding Formula Editor  icon. The Formula Editor
article contains more information about how to use Formulas.

Groups and Values may be re-ordered by clicking on the reordering handle icon and dragging-and-dropping them. Re-ordering Groups
changes how the values are categorized. Reordering Values changes the order multiple values appear in the visualization.

Re-ordering Groups in the Content tab

For a Tabular Report, checking the Hide Detail checkbox will remove the tabular data from the report and show only the aggregate
summary. For example, the tile on the left below shows the detail rows, and they are hidden in the tile on the right.
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Style
The Style tab for Visualizations is further broken down into additional areas depending on the type of visualization in the tile. They are:
Color, Labels, Number Format, Tabular Text and Tile.

The Color section applies to all visualization types and is where the general appearance of the visualization is set.

Color section of the Style tab

A theme can be chosen from the list,
A linear range of colors can be specified (available for all types except Tabular visualizations), or
A custom arrangement of colors may be chosen.
Checking the 3D checkbox will apply a three-dimensional effect to the visualization.

The Tabular Text section applies only to Tabular visualizations and is where the font type and color are set.

The Labels section applies to all of the chart types except Tabular. Labels on the visualization such as a title, axis labels, data points and
a legend are configured here. These label choices will vary depending on the type of visualization.
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Labels section

Title: when checked, will add a title to the visualization and allow formatting of the font, size color and position of it
Subtitle: when checked, will add a subtitle under the main title and allow formatting of the font, color and alignment of it
X and Y-Axis: when checked, will add labels to the horizontal (X) and vertical (Y) axes and allow formatting of the font, color and
position of them. Only available for column, bar, spline, line and scatter visualizations. For visualization types other than bar and
tabular, an additional dropdown box will appear to set the orientation of the data labels. This tells the application what to do if there
is not enough space in the tile to display the whole label. Choose from:

Auto: allow the application to select the best orientation for you based on available space in the tile

Slant: rotate the labels 45-degrees along the axis

Wrap: texts wraps to a new line

Stagger: values are staggered along two lines so they don't overlap

Rotate: rotate the labels 90-degrees along the axis

None: do not apply any change to labels, they may overlap
Points: when checked, will add data points to the visual elements. Not available for Tabular or KPI visualizations. Different types
will have different choices available:

Choice Visualization Category Description
None All Does not display data points on the chart.

Series Values Bar, Line, Pie Displays the value of the Values

Percent of Series Values Pie Displays the percentage of the whole represented by this value.

Data Labels Pie Displays the names of the Groups represented each segment of
the chart.

Data Labels with Data Values Pie Combines the behavior of both Data Labels and Series Values
modes to place both pieces of information in the label.

Legend: when checked, will add a legend to the visualization located on the tile according to the choice made in the dropdown box,
either Right or Bottom.

The Number Format section sets the way that numbers are displayed in the visualization. It works very similar to the other number
formatting options throughout the application.
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Number Format section

Decimal: when checked, will force a specified number of decimal places to be displayed. The symbol inserted between the whole
and fractional part of the number can be specified, as well as the number places after the symbol.
1000 Separator: when checked, will separate thousands places with the specified symbol
Currency: when checked, will display the specified currency symbol in front of the value
Percentage: when checked, will display a percent sign (%) after the value
KPI Value Format applies only to KPI visualizations to set how the value is presented in the tile. Choose from:

English Short Scale

Scientific Notation

Expanded

The Tile section is where tile appearance can be changed. The settings here override the Canvas Format defaults.

Check Background to set a background color for the tile. Click Color to open the color selector and choose a background color.
Unchecking the Background checkbox makes the tile transparent.
Check Tile Header to set a background color for the tile's header. Click Color to open the color selector and choose a background
color. Unchecking the Tile Header checkbox makes the header background transparent.
Note

The Tile Header options are only shown if the Tile Header is visible on the canvas.

Check Shadow to show a slight shadow effect around the tile.
Check Border to apply a border to the tile.

Check Customize Border to set the properties of each of the four tile borders individually. Leave unchecked to have the
border properties applied equally to the four sides.
Click Color to open the color selector and choose a border color.
Width sets the border width in pixels.
Round sets the roundness of the corners.

Advanced
The Advanced Tab for Visualizations is further broken down into two areas: Refresh and Navigation (Tabular only) or Data Display
(Other Chart Types).

Refresh contains one checkbox, to enable automatic refreshing of the data in the Dashboard Viewer. Check the box and then set the
number of seconds in between report refreshes. Uncheck the box to disable automatic report refreshing.

Navigation applies only to Tabular charts and contains one additional control Allow searching that will add a search box at the bottom
of the tile.

The Data Display section applies to the other chart types and has additional controls for how the chart is formatted:
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Use the Sort By dropdown to apply a secondary sort to the chart that will affect the order Values are added to the visualization.
Choose from Ascending or Descending order by selecting from the dropdown.

None adds the Values in the order they are returned from the data source.
Data Labels sorts the data based on the Groups in the visualization
Data Values sorts the data on the Values in the visualization

Check the Limit Values checkbox to set a Min and Max value for the axes labels. If the Values in the chart exceed these
settings, the settings are ignored.

Bar visualization with no Limit Values set

The same bar visualization with Min set to 200 and Max set to 210,000. Note the change in bar size and the labels
along the X-axis.

Check the Exclude Values checkbox to exclude Values Less Than or Greater Than these settings from appearing in the chart.
Click the Advanced Filters button to open the Visualization Advanced Filters Wizard. Similar to the Report Designer's Filter
Wizard, this wizard allows Filters to be applied to this visualization tile. Advanced Filters created here do not show up in the
Dashboard Designer's Filters menu, nor do they appear in the Dashboard Viewer's Filters pane. Advanced Filters created here
are applied before the Dashboard Designer or Dashboard Viewer is launched and can be used to limit the amount of data returned
from the data source, which can be useful when working with very large amounts of data to improve Dashboard performance.

Dashboard Designer: Image (v2019.2+)
An image file can be added to the Dashboard in an Image tile. Most image files supported by a modern web browser (e.g. JPG, PNG,
GIF, SVG, ICO, BMP, WEBP, etc...) can be displayed in an Image tile.

To add an Image tile to a Dashboard, review the Dashboard Designer article. Tiles can be added from the  New Tile menu.

Controls for interacting with the Image tile are contained in the Tile Properties Pane on the right side of the screen. Click on the tile to
select it and the Tile Properties Pane will fill with the properties for the selected tile.

Once the tile is created on the canvas, an image file can be:

dragged-and-dropped onto the Image tile
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the browse your files link in the tile can be clicked to open a standard file browser

Tile Properties Pane

Content
The Content tab for Image tiles allows the image file to be changed. Either drag-and-drop the image file to the pane, or click the browse
your files link to open a standard file browser to choose an image.

The Attached Image field displays the file name of the image contained within the tile.

Style
The Style tab for Image tiles is further broken down into two areas: Fit and Tile.

Fit sets how the image fits inside the tile. There are three options to select from.

Fit will change the dimensions of the image so that the entire image can be seen in the tile, maintaining the image's aspect ratio.
This is the default Tile Fit mode for new Image tiles.

Stretch will stretch the image to completely fill the tile dimensions, ignoring the aspect ratio of the image file

Keep original size will not change the dimensions of the image at all. The image appears with its original dimensions.

The Tile section is where tile appearance can be changed. The settings here override the Canvas Format defaults.

Check Background to set a background color for the tile. Click Color to open the color selector and choose a background color.
Unchecking the Background checkbox makes the tile transparent.
Check Tile Header to set a background color for the tile's header. Click Color to open the color selector and choose a background
color. Unchecking the Tile Header checkbox makes the header background transparent.
Note: The Tile Header options are only shown if the Tile Header is visible on the canvas.

Check Shadow to show a slight shadow effect around the tile.
Check Border to apply a border to the tile.

Check Customize Border to set the properties of each of the four tile borders individually. Leave unchecked to have the
border properties applied equally to the four sides.
Click Color to open the color selector and choose a border color.
Width sets the border width in pixels.
Round sets the roundness of the corners.
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Advanced
The Advanced tab is not available for Image tiles.

Dashboard Designer: Text (v2019.2+)
A textbox can be added to the Dashboard as a Text tile. Text tiles can be used for displaying static text, such as a header or section
label. Creative use of the tile border properties can yield tile groups.

A Dashboard with four Text tiles, two of which are used as headers for groups of visualizations

To add a Text tile to a Dashboard, review the Dashboard Designer article. Tiles can be added from the  New Tile menu.

Controls for building and interacting with a Text tile are contained in the Tile Properties Pane on the right side of the screen. Click on the
tile to select it and the Tile Properties Pane will fill with the properties for the selected tile.

Once added to the canvas, text is entered directly into the Text tile by clicking on it and typing into it.

Entering text directly into the Text tile

Tile Properties Pane

Content
The Content tab is not available for Text Tiles.

Style
The Style tab for Text tiles is further broken down into Tile Fit, Text Attributes and Background and Border sections.

Fit contains two choices to change how the text fits the tile.

Scale will cause the font size to change to fit the available height of the tile
Keep Original will use the font size specified in the Text section. Scrollbars will appear if necessary.

Text contains the standard text formatting controls to change font type, size, alignment, styling and color of the text contained in the Text
tile. Checking the Wrap Text checkbox will cause text to wrap to a new line if it is longer than the available width. If unchecked, the text
will appear on one line.

The Tile section is where tile appearance can be changed. The settings here override the Canvas Format defaults.

Check Background to set a background color for the tile. Click Color to open the color selector and choose a background color.
Unchecking the Background checkbox makes the tile transparent.
Check Tile Header to set a background color for the tile's header. Click Color to open the color selector and choose a background
color. Unchecking the Tile Header checkbox makes the header background transparent.
Note

The Tile Header options are only shown if the Tile Header is visible on the canvas.

Check Shadow to show a slight shadow effect around the tile.
Check Border to apply a border to the tile.

Check Customize Border to set the properties of each of the four tile borders individually. Leave unchecked to have the
border properties applied equally to the four sides.
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Click Color to open the color selector and choose a border color.
Width sets the border width in pixels.
Round sets the roundness of the corners.

Advanced
The Advanced Tab is not available for Text tiles.

Dashboard Designer: URL (v2019.2+)
Web pages can be added to the Dashboard and interacted with in a URL tile.

Note

Some web site authors may choose to block their sites from being embedded into a URL tile. Therefore, not all web pages can be
displayed on the canvas.

To add a URL tile to a Dashboard, review the Dashboard Designer article. Tiles can be added from the  New Tile menu.

Controls for building and interacting with the URL tile are contained in the Tile Properties Pane on the right side of the screen. Click on
the URL tile to select it and the Tile Properties Pane will fill with the properties for the selected tile.

Tile Properties Pane

Content
The Content tab for URL tiles allows the URL in the tile to be changed. Enter the fully qualified web address (e.g.
"http://www.mycompany.com") and then click Apply to update the tile.

Parameters can be used in the web address for a URL tile.

Content tab of the Tile Properties Pane

Style
The Style tab for URL tiles contains the Tile section. The Background and Border section is where tile appearance can be changed.
The settings here override the Canvas Format defaults.

Check Background to set a background color for the tile. Click Color to open the color selector and choose a background color.
Unchecking the Background checkbox makes the tile transparent.
Check Tile Header to set a background color for the tile's header. Click Color to open the color selector and choose a background
color. Unchecking the Tile Header checkbox makes the header background transparent.
Note

The Tile Header options are only shown if the Tile Header is visible on the canvas.

Check Shadow to show a slight shadow effect around the tile.
Check Border to apply a border to the tile.

Check Customize Border to set the properties of each of the four tile borders individually. Leave unchecked to have the
border properties applied equally to the four sides.
Click Color to open the color selector and choose a border color.
Width sets the border width in pixels.
Round sets the roundness of the corners.

Advanced
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The Advanced Tab is not available for URL tiles.

Dashboard Designer: Filters (v2019.2+)
The Filters menu in the toolbar is where filters can be created, modified or removed, and imported prompting report filters can be
modified.

Click on the Filters  icon in the toolbar to open the Filters menu. The menu is broken into two sections: Interactive and Imported. 

Suggested Reading

A detailed description of how to create filters and how to use them can be found in our Report Designer Filters article.

Interactive Filters
Interactive filters are added in the Dashboard Designer and can be applied to one or more tiles on the canvas. Interactive filters can be
displayed on the canvas in tiles where they can be interacted with directly, otherwise they are docked in the Filters Pane of the
Dashboard Viewer.

Interactive Filters that do not appear on the canvas have a grab handle  which can be dragged to the canvas to create a tile from

the  Filters menu. Conversely, filter tiles on the canvas can be dragged into the menu to dock them, or click Dock Filter to

Toolbar in the tile's Tile Menu .

Interactive Filter that is not contained in a canvas tile as it appears in the  Filters menu, showing filter field
(CategoryName), operator (Is One Of), value (Beverages, Condiments, Confections) and grab handle.

Filters on the canvas only have a basic outline in the menu and don't show their filter field, operator or value.

Interactive Filter that is contained in a canvas tile as it appears in the Filters menu, showing basic outline

All interactive filters can be docked in the Filters pane. Only filters with the Equal To, Is One Of or Is Between operator can appear on the
canvas in a tile.

Add an Interactive Filter

To add a filter to the Dashboard, on the  Filters menu, click on the  Add Filter button. A New Filter item will appear in the
menu. Click on the new filter item to modify it.

New Filter Item as it appears in the Filters menu

Modify an Interactive Filter
Docked Filters (Not In a Canvas Tile)

An Interactive Filter not contained in a tile is called a Docked Filter. To modify a docked filter, click on the corresponding filter item in
the menu and the Filter Item Detail options will appear.
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Filter Item Detail options

The Interactive Filter can be given a title by clicking on and entering it into the text field at the top of the menu.

Changing title of a docked Interactive Filter from Categories.CategoryName to Category Name

The Filter Field, Operator and Value fields determine what Data Field to filter on, what comparison to make and what value to compare.

Consider an example where only orders whose Order ID number is larger than 1000 should be included in the tile. The Field is set to
Orders.OrderID, the Operator is set to Greater Than or Equal To and the Value is set to 1000.

Click the corresponding tile names in the Affected Tiles section to apply the filter to the desired tiles. Only those reports containing the
Filter Field or a direct relationship to it can be selected even though all of the reports on the Dashboard are available in the list.

Additional Reports\Pareto Chart does not have a direct data relationship with the Filter Field and is therefore not available

On the Canvas

Interactive Filters that appear in tiles are modified by clicking on the filter tile and then interacting with the Tile Properties Pane on the
right side of the screen.

Content

Filter Field sets the Data Field to filter on. The dropdown list will be populated with fields from the Categories included on the

Dashboard as well as those with a direct relationship to those fields. Clicking on the Formula Editor  icon opens the Formula Editor
so that a formula can be applied to the Filter Field.

Suggested Reading

The Formulas Section contains an extensive explanation of how to use formulas and what functions are available.

Check the corresponding tile names in the Affected Tiles section to apply the filter to the desired tiles. Only those reports containing the
Filter Field or a direct relationship to it can be selected.

Additional Reports\Pareto Chart does not have a direct data relationship with the Filter Field and is therefore not available

The Sort dropdown determines in which order the filter values appear in the tile, either in Ascending or Descending order. For example, if
the Filter Field is Employees.LastName, setting this to Ascending will order the last names from A to Z, Descending will order them
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from Z to A.

Note

The Sort dropdown does not affect the sorting of the data on the reports this filter affects. It only affects the order the filter values are
listed in the tile.

An interactive filter in a tile contains a control to interactively change the filter values. Choose the Input Type. The four available control
choices are:

Dropdown: allows one value to be selected at a time

Checkboxes: allows zero or more discrete values to be selected simultaneously

Single Slider: allows one value along a range of values to be selected

Range Slider: allows all values inside of a range of values to be selected

Orientation changes the orientation of the filter tile's control. Choose from Horizontal or Vertical.

Horizontal and Vertical orientation, respectively, of the same Range Slider control

The Default Value will be used to filter the data when the Dashboard is first run, before the user has interacted with the tile. When the
Dashboard is exported, the Default Value is applied to the tiles.

Style

The Style tab for Filter tiles is further broken down into three areas: Text, Selector Format and Tile.

Text contains typical controls for changing the font type, size, color, styling and alignment for the filter control's values.

Selector Format section contains controls to set the color, horizontal and vertical alignment of the filter's control. The Select Format
Type dropdown specifies what type of data the filter controls. It works similar to the Number tab of the Cell Formatting window in the
Report Designer.

The Tile section is where tile appearance can be changed. The settings here override the Canvas Format defaults.

Check Background to set a background color for the tile. Click Color to open the color selector and choose a background color.
Unchecking the Background checkbox makes the tile transparent.
Check Tile Header to set a background color for the tile's header. Click Color to open the color selector and choose a background
color. Unchecking the Tile Header checkbox makes the header background transparent.
Note

The Tile Header options are only shown if the Tile Header is visible on the canvas.

Check Shadow to show a slight shadow effect around the tile.
Check Border to apply a border to the tile.

Check Customize Border to set the properties of each of the four tile borders individually. Leave unchecked to have the
border properties applied equally to the four sides.
Click Color to open the color selector and choose a border color.
Width sets the border width in pixels.
Round sets the roundness of the corners.

Advanced

The Advanced tab is not available for Filter tiles.

Delete an Interactive Filter
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Docked Filters (Not In a Canvas Tile)

To delete an Interactive Filter from the Dashboard:

1. Click on the Filters  icon in the toolbar to open the Filters menu.
2. Click on the desired filter item in the menu.
3. Click the Delete button at the bottom of the Filter Item Detail.

On the Canvas

Click the Interactive Filter tile on the canvas, then click Delete Tile from the Tile Menu .

Exports
Interactive filter tiles will not appear in the resulting Chained Report when a Dashboard is exported. Though the tiles themselves will not
display, the default values set for the filters will apply to their affected tiles in the exported file. Refer to the Exporting Dashboards article for
more information.

Imported Filters
When an existing report is added to the Dashboard and it contains prompting filters, those filters are imported into the Dashboard.

When more than one report is added with a prompting filter on the same Data Field, the filters will be automatically combined into a single
consolidated filter.

Add an Imported Filter
A report added to the Dashboard that contains prompting filters will import those filters automatically.

Modify an Imported Filter

To modify an Imported Filter click on the corresponding filter item in the  Filters menu. The Filter Item Detail will appear.

Filter Item Detail

The Imported Filter can be given a title by clicking on and typing it into the text field at the top of the menu.

Changing title of an Imported Filter from Categories.CategoryName to Category Name

The Operator and Value fields determine what comparison to make and what value to compare.

Note
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To edit the filter field of an Imported Filter, edit the corresponding report in the Report Designer.

The Affected Tiles section lists the tiles which are affected by this filter. If more than one report is filtered by the same Filter Field, it is
grouped together into a Consolidated Filter. This consolidation happens automatically. There can only be one consolidation for a single
data field on a Dashboard.

Filter Details of a Consolidated Filter

When imported filters are consolidated, changing the Operator or Value will change it for all of the Affected Tiles simultaneously. To
break the consolidation so that tiles may have their operators and values set individually, click the corresponding Ungroup button.

The On Run options work as follows for both consolidated and unconsolidated filters:

Prompt for Value when checked will prompt the user to specify a filter value when the Dashboard Viewer is launched
Show on Output when checked will show the filter in the Dashboard Viewer's Filter Pane. If unchecked, the filter will be hidden
from the Filter Pane but will still affect the reports.

Delete an Imported Filter
To remove an Imported Filter from a Dashboard, it must be set to not prompt for a value or be removed from the report where it was
imported from.

Dashboard Designer: Parameters (v2019.2+)
When a report is added to the Dashboard and it contains one or more parameters, those parameters are imported to the Dashboard in

the  Parameters menu.

Click on the Parameters  icon in the toolbar to open the Parameters popover menu.

Suggested Reading: A detailed description of how to use parameters in reports can be found in the Internal Parameters and Use
Parameters as Filter Values articles.

Each imported parameter is shown as an item in the menu. For example, the Parameters menu below contains two parameters, one
named MyParameter with a value Teleportation, and one named EmployeeID with the value Johnson.
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Parameters menu with two parameters imported from reports on the canvas

If more than one report references the same parameter, it is grouped together into a Consolidated Parameter. This consolidation
happens automatically. Clicking on any of the parameter items in the menu will open the Parameter Item Detail menu.

Parameter Item Detail for a single report

Parameter Item Detail for a consolidated parameter

The Parameter can be given a title by clicking on and entering it into the text field at the top of the menu. This title is used in the
Parameters Pane of the Dashboard Viewer to more clearly identify it.
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Providing a title for a Parameter in the Dashboard Designer (top) shows the title in the Dashboard Viewer Parameters Pane
(bottom)

The name of the report or reports that imported this parameter are displayed under the title.

The parameter's Name and Value are displayed, and the Value can be changed.

The corresponding tile names in the Affected Tiles section show which tiles are affected by the parameter. If two or more reports on the
canvas have a parameter with the same name, those parameters are consolidated into a consolidated parameter. Click the Group All
button to consolidate all of the reports with the common parameter

In the example below, the EmployeeID parameter appears on two reports, param-test1 and param-test2. In the Parameter Item Detail on
the left, a Group All button allows consolidating all of the reports with the EmployeeID parameter. The resulting consolidated parameter is
on the right.

Consolidated Parameters allow the Value to be changed for all of the reports simultaneously.

To break the consolidation, click the corresponding ungroup button.

becomes 

The On Execute options work as follows:

Prompt for value when checked will prompt the user to specify a value when the Dashboard is run. Otherwise the value in the
menu is used when the Dashboard is run.
Show on Output when checked will show the parameter in the Dashboard Viewer's Parameters Pane. If unchecked, the filter
will be hidden from the Parameters Pane but will still affect the reports.
Set Default Value when checked, will apply the Value specified in the Dashboard Designer to the parameter when the Dashboard
is run. If unchecked, the parameter will use it's own default value, if any, when the parameter is run.

Adding/Deleting Parameters
To add a parameter to a Dashboard, it must be included in one of the Dashboard's component reports.

To remove a parameter from a Dashboard, remove it from the reports on the Dashboard.

Exporting Dashboards (v2019.2+)
Dashboards can be exported as Chained Reports, each tile appearing on a separate page in the output file. Dashboards can be exported
to any of the available export types (Excel, PDF, RTF, CSV) and can be e-mailed or scheduled.

Note

Each Dashboard tile will display in a separate worksheet tab in Excel exports.

Exported Dashboards consist of only report and visualization tiles. Filter tiles are excluded from the Chained Report output but the default
filter values apply to their affected tiles.

Note

The default values of the filters are reflected in the exported Dashboard even if the filter tiles have been adjusted before exporting.
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Export Options

Export options for Dashboards are found in both the Report Tree and the  Dashboard Designer.

Export a Dashboard from the Report Tree by right-clicking the Dashboard name or by first selecting the report in the tree, then
clicking the Menu  icon, hovering over  Export As and then choose the preferred export type from the list.

Export a Dashboard from the Dashboard Designer by clicking the Export  icon in the top toolbar and selecting an export type. See
the Dashboard Designer article for more information.

If some export types shown here are not available, they may be restricted by the system administrator, or one or more of the component
reports may restrict them in their respective General Report Options.

Scheduling or E-Mailing Dashboards
Depending on system configuration Dashboards may also be scheduled or e-mailed.

Scheduled Dashboards are stored as chained reports with the same name as the Dashboard. For example, a Dashboard titled

Revenue by Date Dashboard will display as the same in the  Schedule Manager window.

Email a Dashboard from the  Report Tree by right-clicking the Dashboard name or by first selecting the report in the tree, then
clicking the Menu  icon, hover over  Email Report, enter the destination e-mail address and select a file format. Clicking on
the file format will send the e-mail.

Emailing a Dashboard from the menu in the Report Tree
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Charts
Charts are a way of illustrating data in order to make it easy to spot trends and patterns. Most types of charts are simply a collection of
points on a grid, with interstitial designs and labels that make them easier to read.

By default, charts are generated dynamically, based on data points that come from Data Objects. Each data field can be thought of as a
"series" of data, which have a common association and are connected in some way. When we put one data field on a chart, we have a
single-series chart, which is useful for comparing values to each other. When we put multiple data fields on a chart, we have a multi-
series chart, which is useful for comparing trends.

Before creating a chart, make sure that your data exists in cells on the report. These cells don't have to be visible, so you can suppress
them if desired. Charts are interactive in the Report Viewer, but will appear as static images in PDF, RTF, and Excel formats (CSV is
incompatible).

To insert a chart into a report, select a Group Footer or Report Footer cell and press the  Chart Wizard button. The Chart Wizard dialog
will open.

The Chart Wizard has four tabs: Type, Data, Appearance, and Size and Preview. You can navigate between the tabs by clicking on the
tab, or using the  Previous and  Next buttons.

Chart Types
The Type Tab lays out all the available types of charts you can create. There are 20 types, sorted into five general categories. Click on a
category header to see more information about that type.

Click on a chart for more information about each type. 

Line

     
 

Bar and Column

        

Pie and Other Single-Series Scatter and Bubble

      
 

Zoom Charts 

 
   

 

Combination Charts (v2016.3+)

 
 

Line
Line charts display series of data points on a grid, connected by straight lines. They are often used to display a trend over time.

Each series on a line chart is represented as a colored line. Line charts can have up to three Y-axes.

Variations:

Spline chart - Data points are connected by interpolated curves instead of straight lines.
Area chart - The area under each line is filled in by a color. Overlapping areas have mixed colors.
Spline-Area chart - A combination of a spline chart and an area chart.
Spark Line chart - Has no grid or axes. Use point labels and benchmark lines for reference.

Bar and Column
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Bar charts use rectangular bars which extend horizontally left to right to show comparisons between categories. Column charts use
vertical bars which extend upward. The length of a bar represents the quantity of the data value.

Each series on a bar or column chart is represented by a colored set of bars.

Variations:                

Stacked bar/column chart - Series are stacked on top of each other, additively.
100% Stacked bar/column chart - Series are converted to a % of the max, then stacked on top of each other, additively to 100%.
Spark column chart - Has no grid or axes. Use point labels and benchmark lines for reference.
Pareto chart - Combines a descending column chart, where each column is the next highest data value, and an overlapping line
chart, where each point is the cumulative sum to that point. Often used to highlight the most important field in a series. Single-
series only.

Pie and Other Single-Series
Pie charts are used to show the relationship of data values in a series as portions of the total. The area of each slice is proportional to the
quantity.

Each data value on a pie chart is represented by a colored "slice". Pie charts are single-series only.

Variations:

Doughnut chart - Pie charts with a hole in the center.
Pyramid chart - Used to show data hierarchy in addition to value. Data values are represented by vertically stacked slices, the
height (not width) proportional to the quantity. The vertical order of the slices is determined by the sort order.
Funnel chart - Inverted pyramid chart. Often used to show retention amount, or stages in a process. Shape is inverted, not data
order. To change the order, swap the sort direction.

Scatter and Bubble
Scatter charts use pairs of data fields with a common relation to generate coordinates as points on a grid. They are often used to find
relationships between two variables in a set of data. Unlike most other report types, scatter charts often map data from detail rows, instead
of group rows.

Each series on a scatter chart is represented by a different shape and color combination.

Variations:

Bubble chart - The points become circular "bubbles", with a third coordinate field as the radius of the bubble.

Zoom Charts
Zoom charts provide the ability to view data at various levels of granularity, especially when the data set under observation is large and can
be organized into layers for easier interpretation. The ability to zoom-in and zoom-out makes it easy to view data at various macroscopic
and microscopic levels.

Variations:

Zoom Line chart - A variation of a standard Line chart with zooming as an added capability.
Zoom Scatter chart - A variation of a standard Scatter chart with zooming as an added capability.

Combination Charts

(v2016.3+)
Combination charts are several different charts layered on top of one another. They comprise of a combination of Column, Line, Area,
and/or Stacked Column charts. (C​olumn and Stacked Column charts are not compatible with each other). Combination charts can have up
to two Y-axes.

 

Data
The Data Tab is used to specify which cells to use as chart data. You can change how data is translated into points by changing the data
layout. You can also choose a sort order, as well as upper and lower boundaries for the data and axes.
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Add series to the chart by selecting a Data Field containing numeric values from the Series Values dropdown menu. Some charts may
require you to select a data field to label the X-Axis. Some charts may ask for two or three data fields per series. The data axis is drawn
automatically.

Note

Data is on the Y-Axis; this may not always be the vertical axis. Labels are on the X-Axis; this may not always be the horizontal axis.
Scatter charts have no labels axis, but have X- and Y- data axes.

Add additional series by pressing the  Add Series button (disabled for single-series charts). Give a Name to each series. Press  to
remove a series.

Change the data layout by pressing the  Data Layout... button. This will open the Data Layout dialog. If you change the data layout, this
section will change for you to add either individual points, or groups of series, instead of adding individual series. See Data Layout for
details.

Use the Sort data by dropdown to determine how series data should be ordered:

Report Order – Use the sort order specified by the report.
Data Labels – Sort by the label axis value, alphabetically or numerically.
Data Values – Sort by the value of the data.

You can sort data in Ascending (A- Z, 0-9) or Descending (Z-A, 9-0) order.

Use the Exclude values fields to ignore values that are too large and/or too small.

(Grid charts) Use the Data Axis Value fields to set upper and/or lower bounds for the data axis.

(Grid charts) Check Align Data Labels Across Series if you have multiple series with data points at common intervals.

(Pie charts) Use the Other Category Percent field to group data fields with small quantities into an "Other" category.

 

Data Layout

Your data may not fit neatly into series. This dialog accommodates different data layouts by allowing you to select from a couple of
different ways to build a chart.

Column Based Chart is the default. This layout builds charts by taking data fields, and mapping selected values as Y-coordinates on the
data axis. Determine which values are selected by specifying a data field with a common relation as the X-axis. This layout is useful if you
want to plot one or more unrelated series in a group (e.g. Budget and Sales and Expenditures per Store).

Use Column Based Chart if... Your report contains a group with one or more elements. For example:

Row Based Chart is a little more complex. This layout still uses fields as series, but all your series are a group, nested within another
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group which determines the X-axis values. Data values are mapped per series per group. This layout is useful if you want to plot two or
more related series in a group (e.g. Sales per Employee per Store).

Use Row Based Chart if...  Your report contains a group within a group. For example:

If you select this layout, the data selector will change to allow you to add all your series as a group, nested within an outer group for the
data labels:

Cell Based Chart is the simplest option. This layout builds charts by taking pairs of static report values, and using them as (X,Y) or (label,
value) coordinate pairs.

In order for the chart wizard to recognize report cells, they must be in Formula form, with a preceding = sign, text surrounded by quotes,
and data fields surrounded by braces { }. Examples:

Number: =42
Text: ="February 24th"
Data field: ={Employees.EmployeeName}
Formula: =Month{Orders.OrderDate}
Math: ={Orders.UnitPrice} * 2.43

Use Cell Based Chart if... You want to build a chart point by point, and only have one data series. For example:

If you select this layout, the data selector will change to allow you to add points. This layout only supports one series of data (duplicating
data labels will create duplicate axis labels):

Appearance
The Appearance Tab contains options for customizing how the chart will look.

Colors

Use the Colors dropdown to select a color theme to apply to the chart. Specify a custom range of colors by selecting the Linear Range
option.
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Check Use 3D Style to give your chart a three-dimensional look.

Labels

Chart Title – Enter the text you want to appear in at the top of the chart.

(Grid charts) X-Axis Title – Enter the text you want to appear on the X-Axis (horizontal axis).

(Grid charts) Y-Axis Title – Enter the text you want to appear on the Y-Axis (vertical axis).

Use the Point Labels dropdown to label the points on the chart:

Series Values
Percent of Series Values
Data Labels
Data Labels with Data Values

Use the Legend Position dropdown to choose where to display the legend relative to the chart.

Use the Label Font dropdown to specify the font for the labels.

Use the  Number Format... dialog to specify how data and axis labels should be formatted:

(Line & combo charts) (v2016.3) Use the  Chart Axes button to add and format axes:
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Press  Add Y Axis to add an additional axis. Give it a title, and use the formatting options to format the axis labels and data
labels for associated series. Press  to remove an axis.
Y-Axis Assignment – Use the dropdown menu for each series to associate the series with an axis. Each series will have the same
format as the axis, and hiding an axis will hide associated series.
Press  OK when done.

Use the  Benchmark Lines... dialog to add horizontal lines at specific sections of the chart:

Press  New to add a benchmark line:
Label – Enter the text you want to label the line.
Value – Set the value for where the line will display.
Color –Specify the color of the line.
Line Style – Solid or Dashed.

Press  to remove a benchmark line. Press  OK when done.

Other Features

This section allows you to customize a variety of attributes. The following attributes are supported:

Font color
Font size
Background opacity
Background color
Title alignment
Title font size
Title on top
Legend title
Title font size
Show border
Show tooltip
Subtitle
Subtitle font size

To add a customization, select an attribute from the dropdown menu and press  Add Attribute. Then enter a custom property into the
attribute field or select from the attribute dropdown menu.

Press  to remove a customization.

 

Size and Preview
The Size and Preview Tab allows you to change the size of the chart and preview any customizations.

Note

Chart previews in the Wizard and on the Design Grid use placeholder data.
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You can change the size of the chart in one of three ways:

Drag-and-drop the handle  at the bottom-right corner.
Check Fit to Cell and resize the chart cell on the Design Grid.
Check Set specific size and enter a custom Height and Width (in px).

Chart Data Layout Types
Charts illustrate our data to us so that we can spot patterns and trends easily, but it's important to remember that a chart is simply a
collection of points on a grid. Each point has its label (typically along the x axis) and its value (typically along the y axis). 

There are several ways to represent this collection of points on a report, and the application must be able to transform them into a chart
regardless of the design you've chosen. For this reason, the Chart Wizard comes with three Data Layout Types. Understanding the way
you've designed your report and data will help you select the right Layout Type, which will in turn tell the application how to transform your
data into a chart.

Note: Chart Data Layout Types were introduced in v2016.1 and are named Layout One, Layout Two, and Layout Three until v2016.3,
when they are renamed Cell-Based Chart, Column-Based Chart, and Row-Based Chart, respectively. 

Layout One: Cell-Based Chart
Layout One is for building a specific type of single-series chart using a collection of static points on your report. This layout type is cell-
based because each point's labels and values come from a specific cell in the report output.

 

How do I know this is the right Layout for me?
Take a look at your report design and determine whether the points you're interested in charting are static or dynamic. In the application, a
dynamic data point is one that comes from a field. Fields are denoted by a little triangle in the upper left-hand corner of the cell.

​

 

In the example above, any data points coming from this cell will be dynamic because the cell contains a dynamic field (see the triangle in
the blue box). The Employees.FullName field is a placeholder for all the employee names that will appear on the report. These names will
be added to the report dynamically after you're done designing it and have clicked the "run" button.

 

Static data points, by contrast, are defined explicitly in the report design and do not contain dynamic fields.
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In the above example, every cell contains a static value. The first, third, and fifth cells each contain a string formula that will return the text
inside the quote marks. No matter what section these formulas are in, they will only ever return their respective strings of text. The second,
fourth, and sixth cells contain calculation formulas returning a static value, in this case the minimum, average, and maximum number of
days it takes to ship an order, respectively. When we chart this data, we'll need to use Layout One in order to pinpoint each of these cells
and define them as either data labels or data values. In this case, the string formulas will serve as the labels, and the calculations will be
the values. Together, they make up three sets of coordinates on the chart.

 

How would that look in the Chart Wizard?

 

What would the final report design look like?

 

How would the output look?
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Layout Two: Column-Based Chart
Both Layout Two and Layout Three are for creating single and multi-series charts, but there are some important differences in the report
designs they work with. Layout Two is great if you want to show two or more unrelated values for a single label. Values may be considered
"unrelated" if they come from separate fields or columns. This layout is column-based because each column will add a new series of data
to the chart.

 

How do I know this is the right Layout for me?
First, make sure you're working with dynamic data points. Second, make sure you're interested in calculations for just one group. If you
have two columns representing values you'd like to plot against a column representing your labels, you're in the right place!

In the example above, each column becomes a new series charted against the label column. Since all the labels come from a single
column, we know to use Data Layout 2. Another indication that Layout Two is correct to use in this case is that the series labels are static
values rather than dynamic values that are part of the data fields. 

How would that look in the Chart Wizard?
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The Chart Wizard makes it easy to see the how this Layout is all about adding values to a given label.

It helps a lot if your calculations are also in the same numeric range. For example, charting tree height (0 - 50 feet) on the same y axis as
tree species population in a forest (0 - 50,000 trees) will make it hard to read smaller values. If your values aren't in the same numeric
range, you can add one or more y axes in different numeric ranges on the appearance tab. Note: this feature is only available as of
v2016.3; see Charts for more information.

What would the final report design look like?

 

In this example, the label field is in cell A3, and the three value fields are in cells B3, C3, and D3, respectively.

How would the output look?
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Layout Three: Row-Based Chart
Layout Three is also for building single and multi-series charts, but when used to create a multi-series chart, it requires a bit more prep on
the design end because it compares two or more related values for a given label. Values can be considered "related" when they come from
the selfsame column or field. This layout is row-based because all series are coming from the rows of one column of data.

​

 

In the above example, the series labels all come from the same column and are dynamic values coming from a data field. Each unique
value coming from that field, in this case Year, will become a new series.

 

How do I know this is the right Layout for me?
First, make sure you're working with dynamic data points. Second, make sure you have one group nested inside another. (See
Understanding Sorting and Grouping for more information.) If you want to create a multi-series chart and you want to show a
calculation per a group per another group, Layout Three is the setting you want. 
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Still unsure? Here's a simple verbal test to show whether you're looking for Layout Two or Layout Three when you build your multi-series
chart. Which group of statements sounds truest to your case? 

 

Group A

I want to show income per employee per year.
I want to show number of ad sales per sales rep per publication.
I want to show amount donated per donor per month.

Group B

I want to show the number of staff and students for each school.
I want to show the sales and expenditures and remaining budget for each store.
I want to show the average number of sales and the average number of calls for each sales rep.

 

If your case is more like Group A, you're looking at Layout Three. If your case is more like Group B, you'll want to go with Layout Two.

How would that look in the Chart Wizard?

 

What would the final report design look like?
In this example, I want the report to show revenue per category per year. I've made this possible by nesting a Year group inside a Category
group. (CategoryName is the primary sort, and Year is the secondary sort.)
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How would the output look?

​

 

GeoCharts
Important

For licensing and installation information, please refer to the Installing Optional Features guide.

A GeoChart can be displayed in a report to give a visual representation of geographic data. To insert a GeoChart, select a cell and click
the GeoChart Wizard  icon. The GeoChart Wizard has three tabs: Type, Locations, and Data.

GeoCharts should only be placed into a Group Header, Group Footer, Report Header or Report Footer section.

Type
In the Type Tab, select the initial view, size, colors, and where to display the legend.
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Use the Initial View dropdown to select the location that initially displays on the map. Select the world, a continent, or a country.
There are three ways to set the size of the map.

Enter the height and width in the dimension boxes.
Resize the chart by dragging the lower right corner in the preview.
Check the box ‘Fit to Cell’.

In the Color dropdown, either select a color theme or specify a linear range of colors.
Check the Show Legend box to display the legend.

 

Locations
In the Locations tab, specify which geographic locations should display on the map.

Use the Location Values dropdowns to select the cells that contain the geographic information for the Map. To utilize Region
information, such as states/provinces, Country information must be provided. Similarly, City information requires Region and
Country information.
The Show last Location type as dropdown specifies how to display the lowest level of information. Select circular markers (see
image in Data tab) or shaded geographic regions (see image below).

 

Data
In the Data tab, specify which data determines the color of each country/region/city and the size of each marker.

For each Data Value:

Use the Data Values dropdown to specify which cells on the report should be used to determine the color and the size of each
marker. Setting a cell for the size of marker is optional.
Enter a label in the Data Labels column. Labels will appear in the hover effects of Dynamic Maps.
Use the Aggregation dropdown to select a method to perform on the data.

Sum: Totals the Data Value for each location.
Count: Counts all instances of the Data Value for each location.
Distinct Count: Counts all unique instances of the Data Value for each location.
Average: Takes the arithmetic mean of the Data Value for each location.
Minimum: Displays the lowest value in the Data Value for each location.
Maximum: Displays the highest value in the Data Value for each location.

Use the Display Format dropdown to specify how to display the data.
Default: Displays the values without any formatting.
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Currency: Prepends the currency symbol on the values.
Percent: Multiplies the Data Value by 100 and appends a percent symbol (%) to the values.
Scientific Notation: Displays the values in scientific notation.

Example: If Decimal Places are set to 2 then 123.45 would appear as 1.23 E2.
For each Data Decimal Places: the number of decimal places to display.

 

Example
Take the following report as an example.

 

The subsequent steps show how to create a GeoChart in this report. The map will be colored based on the number of customers in each
location and the markers will be sized based on how many orders have been placed in each location:

1. Add a Report Footer section to the report, select all the cells in the Report Footer and click the merge cells button.
2. Select the merged cell and click the GeoChart Wizard  icon.
3. In the Type tab Set the initial view, size, and color.

4. In the Locations tab, set the field Customers.Country for Country information, Customers.State for Region, and Customers.City
for City information. Set the Show last location type as dropdown to Markers.

 

5. In the Data Tab:
1. Set the field Customers.CompanyName for Color of Locations. Provide a label such as "Num. of Customers" and set the

Aggregate Type to Distinct Count.
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2. Set the field Orders.OrderId for Size of Markers. Provide a label such as "Num. of Orders" and set the Aggregate Type to
Count.

6. Click Finish and run the report.

Report Designer

Note: In the report designer, the GeoChart is always represented by the same image regardless of the size, color, or world view of the
map that will be generated on the report.

Report Viewer
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Gauges
A Gauge can be displayed in a report to give a visual representation of the scale of a value. To insert a Gauge, select a cell and click the
Insert Gauge button ( ). The Gauge Wizard will appear. The Gauge Wizard has two tabs: Appearance and Data.

NOTE. Gauges can be placed in any section of the report.

 

Appearance
In the Appearance Tab, select the Type and Dimension of the Gauge.

Type – Select the icon representing the type of gauge. Available types include: Angular, Linear, Bulb, and Thermometer.

There are three ways to set the size of the Gauge.

Enter the height and width in the dimension boxes.
Resize the gauge by dragging the lower right corner in the preview.
Check the box ‘Fit to Cell’.

Note: Angular gauges have a minimum width of 120px.
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Data
In the Data Tab, select the Data Values and Color Ranges for the Gauge.

Use the Data Values dropdown to select the cell that contains the numeric value for the Gauge.
Use the ‘Provide range as’ buttons to specify if the Min and Max values for the Gauge should be static numbers or come from cells
on the report.
In Color Ranges, use the ‘Color By’ buttons to specify if color ranges should be percentages of the Max value, static numbers, or
come from cells on the report.

NOTE. Percent Color Ranges must be in ascending numeric order.

Use the Add ( ) and Remove ( ) buttons to create additional colors.

NOTE. Thermometer Gauges can only have one color.

To change a color either use the drop-down ( ) or enter a Hex value.
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User Preferences and Context Sensitive Help
If given permission by your administrator the User Preferences button will appear in the top right corner. Click the User Preferences button 

 to open the User Preferences menu.

Startup Reports
In the User Preferences menu set your preferences such as which reports should run at startup and/or what User Reports should be
applied.

To execute a report on startup either drag and drop it to the ‘Report Name’ panel, use the ‘Add’ button or double-click it.
To disable a user report click the delete button ( ).
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Context Sensitive Help
Context sensitive help is available at any point in the application. Click the help button  and documentation will appear in a new tab. The
guide will automatically open to the section discussing the feature you are using.

Tutorials
Disable or enable ExpressView Tutorials and Hints in the User Preferences menu (2018.2+).

The tutorial guides you through the creation process for ExpressViews through a series of popup windows. You are given the option
to skip the tutorial when it begins, as well as the option to disable the tutorial in the future when it is complete.
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When hints are enabled, a hint will display after you take certain actions. Once you have seen a hint it will not display again unless
hints are reset. 
Reset All Hints within the User Preferences menu to view all hints again.

 

 

User Preferences and Context Sensitive Help User Guide

152 of 152


	Table of Contents
	Navigating the Application
	Report Types
	Building Your First Report
	Grouping Basics
	Formula Basics
	Adding Visualizations to a Report
	Scheduling Reports
	ExpressView
	ExpressView: Managing Data
	ExpressView: Formula Columns
	ExpressView: Customizing Appearance
	ExpressView: Visualizations
	ExpressView: Grouping and summarizing data
	ExpressView: Data Categories and Fields
	ExpressView: Exporting
	Report Viewer
	Report Viewer: Interacting with Reports
	Report Viewer: Customizing report output
	Report Wizard
	Report Wizard: Name
	Report Wizard: Categories
	Report Wizard: Sorts
	Report Wizard: Options
	Advanced Reports: Report Designer
	Advanced Reports: Categories
	Advanced Reports: Sorts
	Filters
	Group Min/Max Filters
	Top/Bottom Filters
	Advanced Reports: Report Options
	Advanced Reports: Templates
	Advanced Reports: Joins
	Advanced Reports: Cell Formatting
	Advanced Reports: Sections
	Advanced Reports: Using the Toolbar
	Advanced Reports: Design Grid
	Advanced Reports: Drilldowns
	Dashboard Viewer (v2019.2+)
	Dashboard Designer (v2019.2+)
	Dashboard Designer: Existing Reports (v2019.2+)
	Dashboard Designer: Visualizations (v2019.2+)
	Dashboard Designer: Image (v2019.2+)
	Dashboard Designer: Text (v2019.2+)
	Dashboard Designer: URL (v2019.2+)
	Dashboard Designer: Filters (v2019.2+)
	Dashboard Designer: Parameters (v2019.2+)
	Exporting Dashboards (v2019.2+)
	Charts
	Chart Data Layout Types
	GeoCharts
	Gauges
	User Preferences and Context Sensitive Help

